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Disclaimer

MS Govern has taken due care in preparing this manual. However, nothing 
contained herein modifies or alters in any way the standard terms and 
conditions of the purchase, lease, or license agreement by which the product 
was acquired, nor increases in any way the liability of MS Govern to the 
customer.
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System Requirements

This section lists the minimum hardware and software requirements for Govern’s 
eGovernment solutions and Microsoft .NET applications.

Prerequisites

Third Party Applications

The following Microsoft and Third Party Software are required for the 
eGovernment solutions:

• Internet Information Server (IIS) with Secure Sockets Layer (SSL) 
certificates, installed

• Microsoft .NET Framework 4.0
• SAP Crystal Reports Runtime Engine 13 for .NET Framework 4 (32-bit)

Govern Applications

Govern .NET Applications

• The Govern System Configuration & Administration (SCA) Release 5.0 
application contains the tools required for database maintenance, 
configuration editors, and Website creation and maintenance tools.

• The Business Entity Designer (BED) Release 4.7.3 is required to generate 
Business Entities (BE’s) and Business Models (BM’s). Refer to the MS 
Govern.NET guide for detailed explanations about Business Entities and 
Business Models.

Govern for Windows
• Govern for Windows™ 10.7 or greater
• Property Control Module

ePortal

The ePortal requires:

Overview
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• Govern System Config & Admin (SCA), for Web page setup
• Property Control Module

ePermit, eComplaint, eRenewal, eGrievance and eRe-
quest for Services

The eComponents require the following Govern for Windows™ Release 10.7 
or greater subsystems:

• Property Control Module
• Land Management Module

eProfile

The eProfile requires:

• Miscellaneous Billing, for setting up subscription plan billing
• Accounts Receivable (A/R) Module

eRemittance

The eComponents require the following Govern for Windows™ Release 10.7 
or greater subsystems:

• Property Control and Name & Address Module
• Self-Reported Tax Module

ePayments

The ePayment solution requires:

• Credit Card / Debit Card / eCheck software1, installed and configured with 
a valid merchant account 

• Automated Clearing House (ACH) agreement, in force with a bank if you 
are providing Electronic Funds Transfer (EFT) services. Refer to the SCA 
release 5.0 guide for a list of EFT interfaces / providers supported by 
Govern.

• Govern for Windows™ Release 10.7 or greater sub-systems:
• Property Control and Name and Address Module
Page xii © 2012 MS Govern
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• Accounts Receivable (A/R) Module, with links to the sub-systems for 
which you are setting up payment collection

• All sub-systems required for ePayment collection

1) Supported ePayment applications are as follows: Pay Connexion, Moneris, Nelnet, Paymentus, 
Pay Pal, Point and Pay, US Moneris, and Your Pay.
© 2012 MS Govern Page xiii
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Server, Client, and Network Requirements

Note: It is recommended, but not mandatory, to set up three physical 
servers; the first for the Database, the second for the Application and 
the third for the We. If, however, you decide to use one physical server 
for both the Application and Web, you will need to revise the minimum 
recommended configuration.

SERVER HARDWARE / SOFTWARE

Hardware Type Minimum Specifications

DATABASE SERVER

Platform Windows & Unix1

Database Package Oracle2 or Microsoft® SQL Server3 2008 R2

CPU
2 GHz / 1 MB cache, 800 MHz FSB (2.4 GHz Quad-core 1.066 GHz FSB  - 
Recommended)

RAM 1 GB DDR24 (4 GB DDR2 - Recommended)

Disk Space
Dependent upon the size of data to be managed; RAID V with a minimum of 
500 GB of hard disk space is a recommended configuration

Operating System Microsoft® Windows® 2008 or greater

Network 100 Mbit NIC (1 Gbps - Recommended)

Peripherals DVD / CD ROM Drive

Other Redundant Power Supply and Fans

WEB SERVER

Platform Microsoft® Windows® 2008 with IIS 7.0 OR 2008 R2 with IIS 7.5

CPU
3 GHz / 1 MB cache, 800 MHz FSB (2.4 GHz Quad-core 1.066 GHz FSB  - 
Recommended)

RAM 4 GB DDR2

Disk Space 250 GB
Page xiv © 2012 MS Govern
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Operating System Microsoft® Windows® Server 2008 or greater

Network 100 Mbit Network Interface Card (NIC) (1 GBit Recommended)

WEB SERVER

Peripherals DVD / CD ROM Drive

Other Redundant power supply and fans

CLIENT HARDWARE / SOFTWARE

Hardware Type Minimum Specifications

CLIENT WORKSTATIONS

Platform Microsoft® Windows®

CPU 1.5 GHz (Pentium 3.4 GHz - Recommended)

RAM 4 GB5 

Disk Space 40 GB of hard disk space 6 

Network 100 Mbit Network Interface Card (NIC)7 (1 Gbps - Recommended)

Operating System Microsoft® Windows® XP SP3, Vista, or Windows 7 (32-bit)

Other 17” Display8 WPF Direct 3D Graphics Card

MOBILE HARDWARE (Laptops / Tablets)

Platform Microsoft® Windows®

CPU 1.5 GHz

RAM 512 GB DDR2

SERVER HARDWARE / SOFTWARE

Hardware Type Minimum Specifications
© 2012 MS Govern Page xv
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1) The version of Unix is dependent upon manufacturers recommended version of Oracle.
2) Oracle 11g, and 11g R2 and greater are supported.

3) Microsoft® SQL Server 2005, SQL Server 2008, or SQL Server 2008 R2 are supported.
4) CPU and RAM requirement may vary depending upon the amount of users and the 

number of parcels managed by the application.
5) Minimum - 4 GB.

Disk Space 40 GB of hard disk space

Operating System Microsoft® Windows® XP SP3, Windows XP Tablet Edition (32-Bit), Vista (32-
Bit), or Windows 7 (32-Bit)

Network 100 Mbit Network Interface Card (NIC) 7

MOBILE HARDWARE (Laptops / Tablets)

Peripherals Extra Battery, Docking Station in vehicle, plug in keyboard

Other 12.1” (WXGA, 1280 x 800) Display 8 

Platform Microsoft® Windows®

CPU Intel® Core™ i3 Processor 1.33 GHz

RAM 2 GB MB Internal RAM

Disk Space 160 GB of hard disk space

Operating System Microsoft® Windows® XP SP3, Windows XP Tablet Edition (32-Bit), Vista (32-
Bit), or Windows 7 (32-Bit)

Integrated
Communications

Optional Integrated Mobile Broadband

WiFi® 802.11 a/b/g/n

10/100/1000 Ethernet

THIN CLIENT PC / SERVER

Operating System Microsoft® Windows® 2008 Terminal Server OR Citrix Metaframe

CLIENT HARDWARE / SOFTWARE

Hardware Type Minimum Specifications
Page xvi © 2012 MS Govern



System Requirements

FI
N

AL
 D

R
AF

T

6) Govern.NET requires a minimum of 40 GB of temporary storage to be used while running 
the application.

7) Govern.NET’s performance is dependent upon network bandwidth because files, reports, icons, 
images, and data are downloaded from servers.

8) The minimum required resolution for Govern.NET Release 4 or greater is 1024 x 768.
9) Internet Explorer must support HTML 3.0 or higher.
10)Performance of applications can be dependent upon network bandwidth when database results 

are downloaded from servers.

Supported Web Browsers

 

Note: Internet browsers are continuously developed and upgraded, as a 
result compatibility issues may arise. The following list is by no means 
an exhaustive one, and cannot completely take into account the 
incompatibilities that can occur between browser versions and 
versions of operating systems.

Web Browsers

The MS Govern eComponents are compatible with the following versions of these 
popular Web browsers.
It can be assumed that Web browsers that do not appear on this list are not 
supported.

Browser Compatible Version

Microsoft Internet Explorer 7.0 and above

Mozilla Firefox 3.0 and above

Google Chrome 2.0 and above

Apple Safari 3.1 and above
© 2012 MS Govern Page xvii
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Introduction

OpenForms™ and Govern.NET

MS Govern has provided automated land management to government 
organizations, for more than 25 years, beginning on Wang and UNIX systems; 
then, moving to the WindowsTM platform in 1997. With their .NET solutions, 
MS Govern extends its services to the citizen and local business professional, 
further automating land management by providing online real-time Web 
access for submitting permit, license, grievance, complaint and request for 
services applications.

What’s New

This section lists new features, or new ways of performing an old function in 
the Govern eGovern – Public Self Service Portal release 5.0. These new 
features are indicated by the NEW! symbol.

ePortal & eProfile

New Flow for Account Creation Online

In the Account Creation process, a new workflow has been initiated that 
reduces the number of steps involved in the type of account that will be 
created; e.g. user accounts with profiles in the system, or an account where 
the user may have a Property ID (P_ID), etc. See First Time Users Creating 
Accounts on page 143.

Set the Default Identification for Account Creation

The How can we identify you? parameter of the Account Creation web page 
can be preset with a default selection during the account creation process. 
See Setting the Default Identification on page 75.

Overview
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Display Version Number

Through the Web.config editor there is an option to display the version number 
of the application that is running the site. This feature is useful for debugging 
and technical support purposes. See NEW! Display Build Version on 
page 100.

Option to Display Path to Help File Content

Users that are developing Help content for their eGovern sites should note 
that there is an option to display the location of the content in the Govern 
Resource file. See Option to Display Path to Help File Content on page 103.

Crystal Report Viewer Size (Width & Height)

In the Web.config file you can specify the width and height of an embedded 
Crystal Report. See Adjusting Crystal Report Embedded Viewer Size on 
page 133.

Specify a General or Menu item Connection Key for Reports

There are new parameters available that allow the specifying of a general 
connection key, or individual connection keys to specific reports. See Specify 
a General or Menu item Connection Key for eGovern Reports on page 69.

Formulas to Retrieve Late Charge Information in Crystal Reports

There are new formulas available for retrieving late charge information. When 
each formula is used, it will populate the AR_SUMMARY table. See Formulas 
for Retrieving Late Charge Information on page 265.

Customize a Report with Help Content

For developers of reports, you can customize the report with relevant Help 
content. When the report is generated, the appropriate help entry will be 
accessible through the help icon beside the report. See Customize a Report 
with Help Content on page 268.

eRemittance

Disable the Zero Filer option

A Zero Filer is a type of eRemittance declaration that indicates that the filer 
has nothing to declare for the required period. In some situations, 
municipalities might have a policy wherein, in a zero filer is entered, a meeting 
with an auditor may also be in order. As a result of this requirement, by default, 
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the option to allow a zero filer entry is disabled. See NEW! Enable Zero 
Filer on page 93

Show Only Pre-Generated Unified Reports

When there are municipalities that display pre-generated forms for all required 
period, there may be a preference to display only un-filed periods. By default, 
after generating the forms, all periods will be listed and accessible to the user 
for completion. This option is used to hide the periods that have already been 
filed. See NEW! Show only un-filed Generated Periods on page 92.

Period Number also Displayed with Date

On the eRemittance form, now the Date, Due Date, and the corresponding 
Period covered are displayed in the form. Previously, only the Date and Due 
Date were displayed. See Period Number Displayed with Date on page 229

eRemittance Workflow 

With the modification to the eRemittance workflow, during the payment phase, 
now online users are presented with the option to pay immediately, i.e. Pay 
Now, or Pay at a later period, i.e Pay Later. This option is enabled through the 
Govern System Configuration Administrator (SCA). See eRemittance 
Workflow - Payment option on page 229.

Indication of Origin of SRT Filing

This is an SRT notification that the filer was completed on the Web; previous 
versions did not differentiate between SRT filings that were entered through 
the application, or on the Web through the eGovern Public Self Service portal. 
The feature is automatically enabled internally by the system. This feature 
applies for both Govern for Windows and Govern for .NET

ePayment

Credit Card Processors for ePayment

The following are newly supported Electronic Fund Transfer (EFT) providers/
interfaces:

• HPG (Harris Payment Gateway) - Credit Card and Electronic Check
• UniPay - Credit Card and Electronic Check
© 2012 MS Govern Page 3
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Refer to the Appendix section of the Govern System Configuration & 
Administrator (SCA) release 5.0, for a list of supported providers and 
interfaces.
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Chapter 1:eGovern – Public Self Service 
Portal Installation

Pre-installation activities...

Prior to the installation steps for the eGovern – Public Self Service Portal, 
there are a series of pre-installation tasks that need to be performed.

Due to the number of steps that are involved with the installation of the 
eGovern – Public Self Service Portal, it is recommended that administrators 
performing the installation refer to the eGovern – Public Self Service Portal 
Installation and Configuration Checklist as an assurance that required steps 
are completed.

Server Configuration

Step 1 - Installation of IIS and Framework 4.0

Users that are installing to a server should ensure that Internet Information 
Services (IIS) is installed. Alternatively, ensure that Microsoft .NET Framework 

Overview

Note: Although efforts have been made to ensure that IIS will run correctly,  
due to the diversity of versions, additional steps, and changes in the 
sequence of steps may be required to ensure correct functioning.
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V4.0 is installed; note that ASP.NET 4.0 and ADO.NET 4.0 are automatically 
installed when you install .NET Framework 4.0..

Windows Server 2008 users, ensure that Microsoft .NET Framework V4.0 is 
installed.

Windows Server 2003 users can refer to the Installing and Configuring 
eGovern - Public Self Service Portal sections of the Govern System 
Configuration Administrator (SCA) release 5.0 guide for details. Otherwise, 
visit Microsoft's Website for available update information and follow the 
installation procedure for your operating system.

Step 2 - Installation of AJAX Extensions

Ensure that Microsoft ASP.NET 2.0 AJAX Extensions 1.0 is installed on IIS. 
From Start, click Control Panel > Programs and Features and verify that this 
Page 6 © 2012 MS Govern
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application is installed. It will be listed as Microsoft ASP.NET 2.0 AJAX 
Extensions 1.0. 

When AJAX Extensions are not installed, browser errors may occur when 
trying to access the Web site. 

To obtain and install the extensions, copy the following URL into your browser, 
download and follow the installation instructions:

http://www.microsoft.com/downloads/details.aspx?displaylang=en&Fami-
lyID=ca9d90fa-e8c9-42e3-aa19-08e2c027f5d6 

Note: Windows 7 users should follow from the Start button, Start > Control 
Panel > Programs and Features.
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Step 3 - Installation of Crystal Report Runtime

Verify that SAP Crystal Reports for Visual Studio 2010 Runtime engine for 
.NET Framework 4 (32-bit) is installed on your IIS Server. If not installed, 
obtain the Crystal Reports Installer, and run the setup on your IIS server. This 
is required for running Crystal Reports with .NET applications, using .NET 
Framework version 4.0.

Step 4 - Installation of Oracle Client (Optional)

This is an optional step that is intended for users that will be connecting to an 
Oracle database. Before successfully connecting to an Oracle database, it will 
be necessary to install the Oracle Client. Refer to the Notes for Oracle 
Database Users section of the Govern DeployEZ release 4.7.4 user guide for 
details.

Step 5 - Verify that GovWin 10.7, or greater is installed

Ensure that Govern for Windows™ Release 10.7, or higher, is installed and 
running on your system. For installation instructions, refer to the Getting 
Started Release 10.7 guide.

Note: The eGovern – Public Self Service Portal is only compatible with 
Crystal Reports 13. In order to obtain the Crystal Reports 13 installer, 
contact MS Govern Technical Support. During the installation of the 
Crystal Report Runtime, you will be prompted with a request for a  
Product ID. Leave the field blank and press OK.
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Step 6 - Database Preparation

Database preparation involves the use of the Updata.exe utility in Govern for 
Windows. Refer to the Govern for Windows Getting Started Release 10.7 
guide for details on running Updata.exe.

Step 7 - Install DeployEZ 4.7.4

Download the ClickOnce .ZIP archive file from the MS Govern FTP site;  
install the DeployEZ release 4.7.4 on your server. Refer to the DeployEZ 
release 4.7.4 guide for details.

OR

Step 8 - Install SCA 5.0, Database Preparation, and 
Resource files

Create a deployment with DeployEZ 4.7.4; obtain the latest versions of the 
Resource Files. Deploy Govern SCA release 5.0 to a folder of your choice 
<msgovern_install_folder>. Refer to the DeployEZ release 4.7.4 guide for 
details on creating a Deployment.

Step 9 - Verify Presence of Key Folders

Verify the presence of the following folders/files in the DeployEZ install folder... 
<msgovern_install_folder> : 

• GovernDABConfig.xml (File in Root)
• ResourceFiles (Folder in Root)
• GovernNetConfig.xml (Root\Deployments\Deployment_Name)
© 2012 MS Govern Page 9
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These files are generated by DeployEZ, contact MS Govern Technical Support 
to obtain them..

Step 10 - Launch GNA

Locate your deployment shortcut and launch the Govern NetAdmin (GNA).

Step 11 - Perform Complete Database Reset

Select Utilities > Database Utilities > Complete Database Reset... to run the 
Database utilities that rebuild the sections that are required for the eGovern – 
Public Self Service Portal.

Step 12 - Creation of Required Directories

Create a folder c:\eGov where c:\eGov can be a Web install folder  
<web_install_folder>. The folders MUST BE created on the server running IIS.

Create the following folders:

c:\eGov\WebUserInterface or 

<web_install_folder>\WebUserInterface directory.

c:\inetpub\wwwroot\eGov.

WARNING: 
Set the security for the Deployments folder, and the sub-folders for each of 
the deployments. Folders requiring access are as follows:

MS Govern install folder - location of the GovernDABConfig.xml, 
ResourceFiles folder

Deployments folder and the subfolder for the deployments - location of 
GovernNetConfig.xml

This is to ensure that the IIS User will have access to the required folders 
and files. Set the security to ensure that IIS has Read / Write / Modify / 
Delete privileges. If access is not given to IIS errors in the functioning may 
occur.

Use of a dedicated Microsoft Active Directory (MSAD) user may be required 
in a multiple server environment.
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c:\eGov\Reports or <web_install_folder>\Reports directory. All Crystal Reports 
used by the Web site should be placed in this folder.

c:\eGov\logs. This is a directory for  error logs.

c:\eGov\images or <web_install_folder>\images directory that will hold images 
used for the Web site.

c:\eGov\css or <web_install_folder>\css, Cascading Style Sheets (CSS) 
directory that can hold the style sheets that are used for the Web site.

c:\eGov\js or <web_install_folder>\js, javascript directory for scripts used on 
the Web pages.

Create a c:\eGov\uploads or <web_install_folder>\uploads directory directory 
that will be used for storing Multimedia attachments and upload files. Files that 
users upload to this directory are stored temporarily at this location. These 
files will be deleted after being processed by the system.

For directories that are located on a server that is external to the IIS server, 
refer to Viewing Multimedia Documents not stored in the Database on 
page 20.

Step 13 - Obtain and Extract Web User Interface File

Unzip the WebUserInterface.zip file into the c:\eGov\WebUserInterface or 
<web_install_folder>\WebUserInterface folder.

Note: Ensure that the security for the log folder is set to Read/Write/
Execute/Modify.

Note: Securities for the above folders, by default, should be set to Read/
Execute.

Note:  Ensure that the security for the uploads folders is set to allow Read/
Write/Modify/Delete. In addition ensure that there is sufficient storage 
space to accomodate files that will be uploaded.

Note: Contact MS Govern Technical Support to obtain the required 
WebUserInterface.zip file; ensure that the version is compatible with 
your release of the eGovern – Public Self Service Portals.
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Step 14 - Create Application Pools

Open the IIS Management Console; click Start > Control Panel > 
Administrative Tools > Internet Information Services (IIS) Manager.

Right-click on Application Pools in the left 
hand pane and select the Add Application 
Pool option; other versions of IIS may require 
selecting New > Application Pool. Name the 
new application pool MSGOVERN; select 
.NET Framework 4.0 and click OK.

Windows Vista, Windows 7, and Windows 
Server 2008 users, select .NET Framework 
4.0.

Note: If you have an older version of IIS, or an improperly installed .NET 
Framework 4.0, the version number will not be displayed.
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Step 15 - Create Web site 
(Optional)

By default IIS creates a Web site. 
You may use this or create your 
own. Note the Port Number that is 
used and ensure that you do not 
create a site with the same 
number.

Right-click on Sites in the left hand 
pane and select Add Web Site; on 
older versions of IIS version, right 
click on Web Sites and select New 
> Web Site… Name the web site 
eGov. 

In the Physical path: parameter, click “...” Select the MSGovern application 
pool. Click to select <web_install_folder> folder as the physical path.  Click OK 
to save.

Step 16 - Convert eGov Folder to Application

1. Click to expand the newly created eGov Website icon.

Note: Under older versions of IIS a wizard will be used to create the new web 
site; use the same entries as above.
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2. Locate the eGov folder under sites. Right-click on the folder and select 
the Convert to Application option. 

3. Click OK to save.

Step 17 - Create a Virtual Directory (Optional for Crystal 
Report Viewer)

Right-click on WebUserInterface and select the Add Application option; 
users of older versions of IIS, right-click on WebUserInterface and select New 
> Virtual Directory…  Enter the parameters as follows:

BEST PRACTICES: 
When creating Web services, it is a good practice to create separate 
application pools for each of the sites.This ensures that the processes 
within one pool are run independently of the other. For example, when 
maintaining a Test site and a Live site, should a process fail in the Test site, 
it will not impact the Application Pool of the Live site.
Page 14 © 2012 MS Govern



FI
N

AL
 D

R
AF

T

Under Alias:, enter aspnet_client

Physical path: enter, C:\inetpub\wwwroot\asp_client

When completed, click OK and exit from the IIS Management Console.

Step 18 - Create a Directory for Multimedia Documents 
(Optional Virtual Directory)

When Multimedia Documents are stored in the database, there are no issues. 
Issues can arise when documents are stored under an external path. 
Realistically storage locations that are external to the database will need to be 
used particularly when dealing with large files, e.g. videos, high resolution 
images, etc. In such instances additional configuration will be required to be 
able to access these files. Refer toViewing Multimedia Documents not stored 
in the Database on page 20 for details.
© 2012 MS Govern Page 15



eGovern – Public Self 
Service Portal

FI
N

AL
 D

R
AF

T

Step 19 - Set ASP.NET Version to 4 (for IIS 6.1 or earlier)

For IIS versions older than 6.1, you will need to right-click on WebUserInter-
face; select Properties. In the WebUserInterface Properties screen, select the 
ASP.NET tab. Ensure that the ASP.NET version: is set to 4.0.

.

Web site Configuration

Step 1 - Create a Webskin

Create a WebSkin with the WebSkin Manager; in Govern NetAdmin (GNA) 
select Setup > Web Configuration > Manage Web Skin... For details, seeWeb 
Skin Manager on page 106 for details.

Note: Users of IIS 7 will note that the above settings were made when 
configuring the Application Pool at Step 14 - Create Application 
Pools on page 12
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Step 2 - Configure your Dynamic Web Search

Configure Web Search; select Setup > Dynamic Search Configuration > Any 
of the following (Dynamic Search Objects..., (Dynamic Search Styles..., 
(Dynamic Search Groups...) to set up Objects, Styles, and Groups. Refer to 
Search Configuration section of the Govern System Configuration 
Administrator (SCA) release 5.0 user guide for details.

Step 3 - Configure your Web site

Configure your Web site with the Web Site Manager; select Setup > Web 
Configuration > Manage Web Sites... ; take a note of the Website ID number, 
it will be used at a later step. For details, refer to the Web Site Manager 
section in the GovernNetAdmin Application guide.

Step 4 - Use Web Config Editor

In GNA select Setup > Web Configuration > Web Config File Editor...  In the 
Web Config File Editor, select the Web.config file from your web site folder 
(c:\eGov\WebUserInterface or <web_install_folder>\ WebUserInterface).

On the Page 1 tab, define the following parameters:

• Location of the GovernNetConfig.xml file:
<msgovern install folder>\GovernNetConfig.xml"\>

• Upload Document(s) group: Location of the uploads directory, and the 
maximum filesize for an upload file.

• Web Site group: Web Site ID (a numerical value) and the configuration that 
your site will begin with, Web portal (for general inquiries) or Web profile 
(for more actions, i.e. permitting, remittance, etc.)

See the Web Configuration File Editor on page 96 for details.

On the Page 2 tab, define the following parameters:

If you want to enable error logs, specify the notification recipients and the 
location of the .log file.

Note: The above are suggestions for an example Web site and are in no way 
an indication of limitations of the eGov.
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In the Auto Login group, if used, i.e. for “Kiosk mode” enter the Login and the 
Password.

• In the Crystal Report group, specify the Print Mode: as ActiveX
• Locate or enter the location of the Crystal Reports in the directory: 

parameter.

Step 5 - Set up Web eProfile Parameters

Set up Web eProfile Parameters by selecting Setup > Web Configuration > 
Manage Web Sites... Select your Web site and click the eProfile tab. Refer to 
Web Site Manager - ePayment tab Parameters on page 78 for details.

Step 6 - Design and Create your Menus

Create Website menus; select Setup > Web Configuration > Manage Web 
Sites... Select your web site and click Menu Setup. See Configuring Website 
Menus on page 49 for details.

Step 7 - Set up Private Names & Addresses (As 
Required)

In Govern for Windows Admin, if your name and address records are to be 
kept private, define a department. For details, refer to the Govern for Windows 
Super User Release 10.7, guides.

Step 8 - Configure ePayment Parameters (As Required)

Set up the Web ePayment Parameters by selecting Setup > Web 
Configuration > Manage Web Sites... Select your Website and click the 
ePayment tab. Refer to Web Site Manager - ePayment tab on page 77 for 
details.

Step 9 - Configure ePermits (As Required)

In Govern for Windows Admin, select Parameters > Land Mangement > 
Parameters... In the Land Management Parameters form, Select a 
Department and click Maintain > Definition of Type > Permits. In the Permit 
Type Maintenance form click the eComponents tab and set up ePermit 
parameters.
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Next, select Maintain > Definition of Type > Workflow, in the Workflow Type 
Maintenance form and set up the parameters for the eComplaints, eRequest 
for Services, and eGrievances. Refer to the eGovern – Public Self Service 
Portal release 4.7.4 guide for details.

Step 10 - Configure Fields that are viewable on Web (As 
Required)

In Govern for Windows, use the Field Setup Mode to configure the fields you 
will be displaying on the Web with the following functions:

• Permit Types
• Complaint and Anonymous Complaint
• Request for Services
• Grievance Types

Refer to the eGovern – Public Self Service Portal release 4.7.4 guide for 
details on Name and Address functions, Permits, Complaints, Request for 
Services, and Grievance types.

Step 11 - Configure eRenewal Activity Steps (As 
Required)

Setup the Activity steps for the eRenewal in GovAdmin.

• Select Parameters > Land Management Parameters
• Select a Department , click Maintain > Definition of Activities > Permits

Choose the activity step with renewal that eRenewal will be permitted for; click 
the Page 2 tab and specify an expiration date. Click the Page 4 tab and select 
Allow eRenewal. Select a Response from the drop down menu. 

Step 12 - Configure eRemittance Web Layout (As 
Required)

In Govern NetAdmin (GNA) configure the layout of the Self Reported Tax 
(SRT) eRemittance form by selecting Setup > OpenForms Configuration > 
Self Reported Tax Editor.
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Additional Configuration
The following are additional configuration steps that may be needed based 
upon user requirements.

Viewing Multimedia Documents not stored in the 
Database

When multimedia files are not stored in the database, i.e. store on external 
servers, user will find that they are not accessible.

Multimedia files that are not stored in the database, i.e. files stored under an 
external path are not accessible to users.

Solution: In order to view Multimedia documents that are not stored in the 
database, it will be necessary to perform a workaround with IIS.

Step 1 - Note the Multimedia Document Path

In Govern for Windows Admin...

1. Select Parameters > Edit the System Registry...

Note the path of the Multimedia document; look at the path entered in the 
Level I/II/III Multimedia Document Path parameters. For our example, the 
common path is: 

\\FServer\ntwin\    ... this is our common root; close the form.

2. Select Parameters > Property Control > Parameters...

3. In the Property Control Parameters form, select a department and click 
Maintain > Multimedia Codes
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It is here that we see the different multimedia files that we would like to view. 
These types of files are saved in the various Multimedia Archive Levels. 

4. On your IIS server, start the IIS Manager; Start > Control Panel > 
Administrative Tools > Internet Information Services (IIS) Manager.

5. In the WebUserInterface node, look for the Multimedia node.
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6. Right click and select Add Virtual Directory.

7. Enter the name of the Alias folder, for our example NTWIN. Also enter a 
UNC format path of the physical directory.

Note: For our example, all directories exist on the same server. If there were 
multiple servers, a virtual directory would have to be created for each.
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8. Click OK.

Auto Login for Multiple eGov Sites

The eGov system is designed to request login credentials when a user wants 
to access a Website requiring a Profile. Situations may arise where it is 
necessary to access multiple eGov setups. For example an administrator may 
have to access Websites for the following, the Accessors office, one for Utility 
Billing, Inspections, and one for the Permitting office. In such instances, i.e. 
two or more Websites,  multiple individual logins can become tedious and time 
consuming.

There is a configuration option that allows users to be able to switch between 
multiple Websites with only one initial login. With this process, the sessionID is 
passed to the next site along with the serialized state, this ensures that the 
initial session is recreated on the next site, i.e. the SessionID is replicated.

To perform this setup, the following steps will need to be followed:

Creating a Link Element

You need to create a Link Element; add in the link the Domain Name Server 
(DNS) of the other eGov site.

Next you will need to add the following string:

/webprofile/controls/autologin/
web_wp_autologin.aspx?webportalsession 

This will redirect the session to the auto login of the eGov site that you would 
like to access.

Note: If the IIS server is outside of your “DMZ”, access may still be blocked 
by your firewall. Additional configuration will be required, e.g. opening 
specific ports to gain access. This additional configuration is outside 
the scope of this document and should be referred to Microsoft 
Technical support.

Note: The above procedure must be repeated for each Website that is to be 
accessed. 
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To enter the URL...

1. In the Govern NetAdmin (GNA), select Application Configuration > Web 
Configuration... > Manage Websites...

2. Click to select the Website that will be accessed from the Available Web 
Sites list.

3. Click Menu Setup.

4. If not created, create a menu selection for the site; in the Item group select 
an Item Kind of URL..

5. In the Path / URL parameter, enter a URL in the following format:

http://www.site1.metropolis.com/webuserinterface/
webprofile/controls/autologin/
web_wp_autologin.aspx?webportalsession

Ensure that the URL corresponds with the address of the site. If you want the 
link to open in a new browser window, select the Open link in a new window 
option. Repeat the above steps for each required website.

Note: When there are multiple sites, and this method of access is to be 
given, create a menu with each site as a menu item. Ensure that the 
menu Security is set to Intranet Admin, or Internet with Profile. 
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Chapter 2:eGovern – Public Self Service 
Portal Admin

Configuration of the eGovern – Public Self Service Portal is carried out with 
Govern’s System Configuration Administrator (SCA) Release 5.0 and Govern 
Admin 10.7 in Govern for Windows.. 

The Web site tab of the Web site editor in SCA release 5.0 is used for 
configuration. Under the Web site tab are the tabs used to configure the 
various eComponents. The grouping of the tabs are as follows:

General: Select the General tab to configure the Simple Mail Transport 
Protocol (SMTP) email parameters (Mail group), the default department that 
the Web site will be linked to. See Web sites Editor - General tab  on page 27.

eProfile: Select the eProfile tab to define default user permissions for the 
eProfile and the eComponents. The default permissions can be modified on a 
user-by-user basis through the Administration pages of the eProfile. In 
addition, Subscription and Password settings are maintained here. See 
eProfile tab Parameters  on page 31.

ePayment: Under the ePayment tab are the configuration parameters for 
configuring online payment options, Credit/Debit cards and Automated 
Clearing House (ACH). See ePayment - Setting the Web Parameters  on 
page 206.

eInspection: The eInspection tab is used to configure options for the online 
inspection module. See Web Site Manager - eInspection tab  on page 93.

Report: Select the Report tab to define the database connection parameters 
for Crystal Reports. See Web Site Manager - Report Tab  on page 95.

Overview

Note: The following parameters are to be used for configuring release 4.0 
and greater of the eGovern – Public Self Service Portal. Components 
that are prior to release 4.0 can be configured, with appropriate 
licensing, by the Govern for Windows Govern Admin release 10.6/10.7 
application.
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Others: Miscellaneous Billing payments are configured under the Others tab. 
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Configuring the eGovern – Public Self 
Service Portal

Defaults and Connection Parameters

When users arrive at the home page and accesses the ePortal, or performs a 
log-in to access the eProfile, a default starting point is used from the setup. 
This default refers to a department. The default settings, and others are part of 
a series of steps that result in the eComponent site. The principal steps are as 
follows:

Creating the Web Skin

To create your web skin, refer to the Web Skin Manager section of the Govern 
System Configuration Administrator (SCA) Release 5.0 guide.

Web sites Editor - General tab

 eComponent configuration parameters are located in the Websites Manager 
in the Govern System Configuration Administrator (SCA) Release 5.0. See 
Web Site Manager  on page 64 for a description of the parameters. Follow the 
steps below to access the editor and configure the required parameters.

To access the editor...

1. Click Application Configurations > Web Configuration... > Manage Web 
sites...
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2. Click New  to create a new Web site, or select an existing site from the 
the list on the left hand pane..

3. Enter a name for the Web site.

4. Specify a Webskin from the list; refer to the SCA release 5.0 guide for 
instructions on creating a Webskin.

Setup Web site Default Parameters

To specify a default department...

5. Select the default department for the Web site from the Web Site Linked 
to Department drop down menu.

6. Specify a default Country from the Default Country list.

Note: When you click on New, the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.
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7. Enter a numerical value for the maximum number of rows that are 
displayed in a grid; try to keep the number low to avoid excessive scrolling 
on the users side, as in the image below.

Email Communications - SMTP Setup

The Mail group is used to configure email services for the eGovern – Public 
Self Service Portal. This can be an address that website errors would be 
directed to.

1. In the Administrator Mail parameter enter the e-mail address of the admin-
istrator that has been designated to receive error messages.

2. The System Mail parameter is the address that will be used for the from 
field in the email message. These are system messages that will not 
require replies, e.g. confirmation of user payments.

3. Enter the host name of your SMTP server in the SMTP Host parameter. 
Example: mailhost.domain_name.com, or smtp.sparta.com.

4. Specify the SMTP Port; the typical port is 25.

5. In the SMTP User field enter the username used to access the SMTP 
account.
© 2012 MS Govern Page 29



eGovern – Public Self 
Service Portal

FI
N

AL
 D

R
AF

T

6. In the SMTP Password field enter the password used to access the 
account. Text entered into this field will appear “cloaked”, i.e. typed letters 
will appear as asterisks “ ****** ” to hide the typed letters.

The Web site Footer information

Web site footer information can be specified in the Web site Footer group. As 
a footer, this information will be displayed on each eComponent page. This 
section can contain additional branding information, copyrights, last update 
information, etc. (A) You can specify a URL for a page that will be used to 
populate the frame. Additional text for the frame can be entered in the Frame 
Text field.

Display Footer: Select this option to enable the Web site Footer option

Frame URL: When an image is to be added to the footer, the URL to the can 
be entered in this field. This image is displayed to the left of the message.

Frame Text: Enter the text that will appear in the frame. Text that is entered 
in the parameter can include HTML tags, which will be parsed by Govern.

To specify Website Footer information...

1. Under the General tab of the Web sites editor, look for the Web site 
Footer group.
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2. Click to select the Display Footer option.

3. If you have a specific page location for the footer, enter the URL.

4. Enter any additional text that is to be included in the Frame Text field.

eProfile tab Parameters

Allow Name / Address / Password / eMail Modification: Select one 
or more of these parameters to allow users to modify their Name, Address, 
Password, or eMail address. If these options are selected, the Edit button is 
displayed beside the applicable information on the Update Your Profile Web 
page, otherwise, it is not visible.

Allow Add / Remove Parcel: Select this option to grant Web users the 
right to add and remove parcels to and from their eProfiles. This may be 
required by professional users, such as contractors, who need to view data 
and make payments on other properties in order to obtain permits.

If this option is selected the Add and Remove Properties buttons are displayed 
on the Manage Your Properties Web page. Otherwise, they are not visible.

Allow Add / Remove UB Account: Select this option to grant Web users 
the right to add and remove other Utility Billing (UB) accounts to and from their 
eProfiles. If this option is selected the Add and Remove UB Accounts buttons 
are displayed on the Manage Your UB Accounts Web page. Otherwise, they 
are not visible.

Note: Text can be formatted with HTML tags to enhance presentation of the 
text, i.e. size and font.
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Disable Activity Step: This option will allow the user to disable the display 
of the outline of the steps followed for completing the activity. 

Combine eComplaint, eGrievance, eRequest: 

Select this option when you would like the eGrievance, 
and eRequest to be combined with the eComplaint.

Bypass ePayment on Permit Application: By default, it may be 
required to pay a fee that is associated with a permit application before the 
application can be submitted over the Web. Select this option to enable the 
bypass for the ePermit. 

Note: If you are combining the three items, you can 
link it to any one of the components, on the 
eProfile Menu Setup form. Also, if the three 
components are combined, you need to add a 
search. See Defining the Web site Menus  on 
page 35, for full details on setting up the 
eProfile menus.

For example, by default, a fee associated with a permit application needs to 
be paid before the application can be submitted over the Web. Select this 
option to enable the bypass so that users can submit the application without 
making it mandatory to pay the fee online.
When selected, 

Note: When selected this option to enable the bypass for the ePermit will 
also affect the eRenewal, eRequest, and eComplaint.applications.
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Allow ePayment/eComplaint/eGrievance/ePermit/eRequest: 

These parameters are used 
to set the default setting for 
each of these eComponents. 
Note that any settings for an 
individual eProfile will 
override these defaults. 
Select one of the following 
options from the drop down 
menu (A):

• Not Available - Select 
this option if the 
eComponent is by 
default is not available on 
the Web.

• Restricted to Account - When selected this option will provide restricted 
access to the eComponent, by default. Users can submit applications on 
the properties defined in their eProfile, only.

• Unrestricted - Select this option to provide full access to the eComponent. 
Users can then submit an application on any property within the 
municipality or organization. For example, contractors may need to apply 
for permits on several properties that they otherwise do not want to include 
in their eProfile accounts.

ePermit Display Column: This parameter controls the number of columns 
that will be displayed in the user added fields. The default setting for 
displaying ePermit columns is two (2); if more columns are required, enter the 
value.

Profile group

Allow Profile Creation: When selected, this option grants users the right to 
create an eProfile account, from the Web. Deselect this option if the eProfile 
accounts are to be set up by the organization. If this option is selected, the 
account creation link appears on the eProfile Login page, otherwise the link 
will not be presented. See Creating User Accounts  on page 43 for details 
about generating accounts for users that are present in the database.

Note: You cannot select the Restricted to Account option for the eComplaint 
component.
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Maximum Property in Account: Enter the maximum number of parcels 
that users can add to their eProfile. If this field is left blank, users can add an 
unlimited number of parcels

Maximum UB Account: Enter the maximum number of Utility Billing 
accounts that users can add to their eProfile. If this field is left blank, users can 
add an unlimited number of accounts.

Subscription group

Allow Subscriber Creation: Select this option to grant users the right to 
create an eSubscriber account, from the Web.

Default Subscriber Type: This option is active when the Allow Subscriber 
Creation option is selected. The subscriber type that is selected will be the 
default subscriber type.

Misc. Billing Year: Enter the default year that will be used for Misc. Billing.

Misc Billing A/R Class: Select the A/R class from the drop-down menu 
that will be used for collecting the subscription fee. The combination of this 
with the Misc. Billing Year will be used for invoicing purposes.

Note: In order to use this option, the Allow Add / Remove UB Account option, 
under the eProfile tab, must be selected.

Note: When the Allow Subscriber Creation option is selected, the Default 
Subscriber Type will become active.
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Password group

Security Level: Select a security level for the eProfile passwords:

• Low Security requires alphanumeric characters only.
• Medium Security requires at least one numeric character with alphabetic 

characters.
• High Security requires at least one numeric character and one special 

character with alphabetic characters.

Minimum Password Size: Enter the minimum number of characters for 
the eProfile password.

Special Character Allowed: Enter the special characters that will be 
accepted in the password. Examples of special characters are @ # $ % & etc.

Defining the Web site Menus

The eProfile Web Menu Setup form is used to customize the eProfile and 
eComponents menu options. As menu selections are created, they are 
associated with a Web page, a report, or with a Search Style created through 
one of the Dynamic Search editors.

To access the Web site Menu form...

1. In the Govern NetAdmin (GNA) main screen, select Setup > Web Configu-
ration... > Manage Web sites...

2. Click to select a Web site from the available Web sites column (left hand 
side of the Web sites form). 

Note: The security level selected will determine the complexity of the 
password generated by a batch process. See Rules for Batch 
Generated Usernames and Passwords  on page 44 for options that 
affect the rules for generating passwords.

Tip: Before you begin, plan your menu setup. Create all your top level menus 
first. You will need to refer to them when you create your second level 
items, then the third, fourth and perhaps fifth level items, if applicable.
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3. Click Menu Setup in the upper right hand side of the form.

4. In the Web site Menu editor, you can create your menu structure, or if 
already created, view the menu that is associated with the selected Web 
site.

Web Site Menu Command Buttons

Along the bottom of the Web site Menu form are the command buttons for 
creating, saving, and deleting menu items. The menus will be created with the 
Web site selected in the preceding form.

New: To create a new menu item, click New. 

Save: Click Save to save the record to the USR_WEB_PROF_MENU table. 
The Menu Name, Short Description and Long Description are saved to 
VT_USR_WMNUNAME.

Delete: Select the menuitem from the list and click Delete to remove it from 
the form and the database. A confirmation message is displayed.

Default Page: Click Default Page to display the Default Menu Setup form. 
This form is used to setup the default page that will be displayed to a user 
based upon their Access Level setting. In the Default Menu Setup form you 
can click on the drop down menu to select a page that is available for the 
security level.

Exit: Click Exit to close the form and return to the Web Sites form.

Web site Menu Parameters

See Defining the Web site Menus  on page 35 for a description of the Web site 
Menu parameters.  

Creating a Web site menu

Creation of eComponent menus is found in Defining the Web site Menus  on 
page 35. Refer to eComponent Item Kinds  on page 260 for a description of 
the eComponents.

Prior to setting up menus, it is key to have an understanding of the Security 
structure, and what the requirements of each menu setting will be. The 
security levels are as follows:
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• Internet Subscriber - When selected, the security level is set to that of a 
subscriber.

• Internet with Profile - This menu selection will be accessible by internet 
users with a saved profile, i.e. only internet users with a profile will be able 
to see this menu.

• Internet without Profile - This menu selection will be accessible by 
internet users with no saved profile, i.e. all internet users will be able to 
see this menu.

• Intranet Admin - Set this security level to make this menu accessible to 
Administrators within the organization.

• Intranet User - This is the Security level for a user within the organization.

The following menu structure is one example of a layout for a Web site that is 
to be accessed by users with an internet profile, and users without an internet 
profile. Those without a profile would be casual users, i.e. citizens that come 
into the municipal office to search for property information, pay bills. No log in 
is required for users without a profile.

The design of the menu structure is as follows:

• Home
• Property Based Information
• Online Services

• Property Information
• Payment Online
• Misc Payment
• Apply for a Permit
• eRenewal
• eRemittance
• Request for Information
• File a Complaint
• Anonymous Complaint

• Your Profile
• Manage Your Properties
• Manage Your UB Accounts

Note: Menus will be filtered based upon security settings. This feature allows 
you to customize a specific menu for each of the above user access 
levels. For example, when a set of menu’s are created with security 
set for Internet Subscribers, those menus will only be displayed to 
internet subscribers.
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• Upadate Your Profile
• MS Govern
• Sign Out

Menu Design Grid

With a layout of the menu structure decided upon, the next step would be to 
create a grid that would assist in the assigning of the required security 
settings. An example would be the following:

The “+” is an indication that the menu will be visible for the required user 
setting. For example, the Online Services menu will be visible for Internet with 
Profile, Internet without Profile, Intranet Admin, and Intranet Users. Whereas 
the Online Services and the Payment Online menu will be made available to 
all security levels.
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Anonymous eComplaints
The advantage of the eComplaints (Anonymous) is that the user that is 
lodging a complaint is able to do so without an eProfile. Without a profile there 
is no indication of user identity. When the user is logged in with an eProfile, the 
NA_ID is not attached to the eComplaint, thereby again allowing the user to 
lodge the complaint anonymously.

Configuring the Anonymous eComplaint Menu

To create the Anonymous eComplaint menu...

1. In the Web sites Menu form, click New (1) at the bottom of the form.

2. Enter Anonymous Complaint (2) for the name of the Menu.

3. In the item group, specify the Item Kind as eComponent (3). Refer to 
eComponent Item Kinds  on page 260 for a description of the 
eComponents.

4. For Item Name select eComplaint Anonymous (4).
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5. No entry is required for the Path / URL field (5).

6. In the Dynamic Search group, the required key is the Parcel ID; click to 
select Parcel ID (6) from the Requested Key parameter.

7. For this example, under the Security group (7), the security requirement 
for this menu is as follows: Internet Subscriber, Internet with Profile, 
Internet without Profile, and Intranet Admin.

8. Save the menu; click Save (8).

Limitations of the eComplaints (Anonymous)

Note: Security settings are based upon user requirements

Note: There are limitations to the eComplaint Anonymous; although the 
process of charging fees to lodge a complaint is not common, for the 
eComplaint Anonymous,  there should be no fees generated for the 
process as there is no profile to charge the fee to. 
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Configuring a Menu for the eRemittance

The eRemittance component is a customized Self Reported Tax (SRT) report 
submission form. A customized Crystal Report will be required if the user is to 
be provided with a printable summary of their entry. 

To create the menu that will be used to access the eRemittance form...

1. In the Web site Menu form, click New (1) at the bottom of the form.

2. Enter eRemittance (2) for the name of the Menu.

3. In the item group, specify the Item Kind as eComponent (3). Refer to 
eComponent Item Kinds  on page 260 for a description of the 
eComponents.

4. For Item Name select eRemittance (4).

5. In the Path / URL field enter the path to the Self Reported Tax (SRT) 
Crystal Report that will be used to display the summary information; this is 
an optional field.
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6. As the information that is being entered is for the holder of the profile; i.e. 
the system will locate any accounts that are linked to the profile, no 
parameters are required for the Dynamic Search group (6).

7. For this example menu, under the Security group (7), security 
requirements are as follows: Internet Subscriber, Internet with Profile, 
Intranet Admin, and Intranet user.

8. Unless a specific parameter like a YearID is needed for the report, i.e. to 
filter the report according to a year, no entry is required.

9. Click Save to save the menu.

When the menu is configured as above, a user selection will display the 
designed web form for completion. See eRemittance  on page 227 for details 
about creating a form with the Self Reported Tax Editor in the Govern 
NetAdmin (GNA).
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Creating User Accounts
With required permissions, users can create their own eProfile account IDs 
and passwords, as described in First Time Users Creating Accounts  on 
page 143.

Alternatively, you can generate an account ID and password for all individuals 
and companies in your database through the Generate Internet Accounts 
batch process.

To access this process from GovBatch...

1. Select Tools > eComponents > Generate Internet Accounts.

This process generates an account ID and password for all the individuals and 
companies listed in NA_NAMES.

Note: The first time you run the process, it takes a long time to complete, as 
information is generated for every record in the table.
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The password is stored in the INTERNET_PWD_U field. This password is not 
encrypted. It is used only the first time the user logs in to the eProfile.

The organization can generate a report with the newly created account IDs 
and passwords.

Rules for Batch Generated Usernames and 
Passwords

When the Batch process is used to generate usernames and password, there 
are rules that are adhered to in the generation process.

Username Generation Rules

Rules to generate the username for Stephen Jones...

1. In the NA_NAMES table, the first character of the FIRST_NAME, and all 
characters of the LAST_NAME are used to obtain a string: e.g. SKING.

2. Any spaces, leading, trailing and in between are removed; for our example 
there are none.

3. If there are any special characters from the following list of hardcoded 
characters, they are removed:

Special Characters: ~ ! # $ % ^ & * ( ) _ + [ ] { } | \ ' ; : " " < > / ? . ,

Note: The user needs access to the Change Password page. Ensure that 
the Allow Password Modification option is selected undet the 
eProfile tab of the Web sites form in the Govern NetAdmin (GNA). See  
eProfile tab Parameters  on page 31, for details.

Character Name

~ Tilde

 ! Exclamation mark

 # Pound sign (Number sign)

$ Dollar sign
Page 44 © 2012 MS Govern



Creating User Accounts
FI

N
AL

 D
R

AF
T

% Percent sign

^ Caret

& Ampersand

* Asterisk

( Open bracket

) Close bracket

_ Underscore

+ Plus

[ Left square bracket

] Right square bracket

{ Left brace bracket (Left curly bracket)

} Right brace bracket (Right curly bracket)

 | Vertical line

 \ Backward slash

 ' Apostrophe

 ; Semicolon

: Colon

" Left double quote

" Right double quote

< Less than sign

> Greater than sign

/ Forward slash ()

? Question mark

. Period

Character Name
© 2012 MS Govern Page 45



eGovern – Public Self 
Service Portal

FI
N

AL
 D

R
AF

T

4. After Step 1 to 3, the first 10 characters of the resulting string are used. If 
the resulting string is less than 10 characters, the last character of the 
string is repeated to pad the string up to 10 characters. For example if the 
name resulting after the above 3 steps is SJONES, the S character will be 
repeated to give the following: SJONESSSSS.

5. In instances, there may be more than one user with the same generated 
string after Step 4. In such an instance, the first duplicate will be appended 
with three (3) digits starting with 001, e.g. SJONESSSSS001, 
SJONESSSSS002, SJONESSSSS003, etc.

6. When the final username string has been determined, a randomly 
generated password is generated. 

The password generated will follow the rules set by the Security Level that in 
Govern NetAdmin (GNA). See Password group  on page 35 for details.

, Comma

Character Name
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Govern Web Configuration Tools

The Web Configuration tool allows you to modify the look and feel of the 
eProfile and eComponent Web sites.

A feature of the Govern NetAdmin (GNA) is its ability to manage multiple web 
sites within the same database, i.e. you are able to manage multiple sites and 
their respective files within the same database. For example, a municipality 
may require two (2) web sites, one for the city, the other for the county. 

Accessing Govern .NET Web Configuration Tools

To access the Web Configuration tool in GNA:

1. Click Setup > Web Configuration > “Any of the Web Configuration tools 
below”.

Web Site Manager (Manage Web Sites...)

After you set up your WebSkins, you can use the Web Site Manager, to assign 
WebSkins to the eProfile and the eComponents associated with the Web site. 
Each application can be assigned a different skin to provide a different look 
and feel or you can assign the same skin to all components. See  Web Site 
Manager on page 64 for details.

WebSkin Manager (Manage Web Skin...)

The WebSkin Manager can create customized WebSkins to define the look 
and feel of the eProfile and eComponents. This has tools for defining general 
layout, title, and sections of a Web page like the head, left and right margins, 
and the body. These sections are defined as a skin, assigned a name and ID, 
and applied to the eProfile or eComponent with the Web Site Manager. With 
the WebSkin Manager, since all your styles and formatting are centrally 
located, it is easy to preview your site and make modifications. See Creating a 
Web site on page 123 for details.

Overview

Note: Versions 3.2 and earlier of the .NET Toolkit were only able to manage 
one web site per database; the site would have to be used for both the 
city and the county. 
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Web Config File Editor (Manage Web Configuration...)

Web Configuration editor is used to define and manage configuration 
parameters of Govern’s eComponents.. See Web Configuration File Editor on 
page 96 for details.
Page 48 © 2012 MS Govern



Configuring Website Menus
FI

N
AL

 D
R

AF
T

Configuring Website Menus

The Web Sites and Web Skins forms are used to create the “shell” that will be 
your Web site; after defining the look and feel, you can then configure the 
menus. Menu options can be associated with a Web page, a report or with a 
Search Style. See Accessing Dynamic Search Configuration Tools  on 
page 255. The Web Site Menu form is used to create and configure your 
menus. 

Overview

Tip: Before beginning, plan your menu setup. Create all your top level menus 
first. You need to refer to them when you create your second level items, 
then the third, fourth and fifth level items, if applicable. In addition 
indicate the Item Types that will be assigned to each menu item. See  
Item Kind  on page 51 for details about Item Kinds.
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Web Site Menu Command Buttons

New: To create a new menu item, click New. 

Save: Click Save to save the record containing the menuitems. The Menu 
Name, Short Description and Long Description are saved.

Delete: Select the menuitem from the list and click Delete to remove it from 
the form and from the database.

Default Page: Click Default Page to display the Default Menu Setup form. 
This form is used to setup the default page that will be displayed to a user 
based upon their Access Level setting. In the Default Menu Setup form you 
can click on the drop down menu to select a page that is available for the 
security level.

Exit: Click Exit to close the form and return to the Web Sites form.

Web Site Menu Parameters

Menu [Order By Sequence] 
column

This column (A) will display a list of new 
and existing menuitems; each menuitem is 
preceeded by its sequence number. Sub- 
menu items are displayed in a hierarchical 
manner, when available they can be 
accessed with a click on the “+” to expand, 
or the “-” to collapse them (B).
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Menu group

Menu ID: This is a system generated number; this number cannot be 
changed by the user.

Menu Sequence: Select the top level menu, or any submenu items. Enter a 
number for the order that you want the item listed on the menu. Enter 1 if you 
want the item to appear at the top of the menu. Enter 2 if you want it to appear 
second from the top, and so on.

Description: Enter the name for the menu item; this is the name that is 
displayed on the menustrip.

Item group

Item Kind: Here you specify the kind of link that the menu item is; the options 
are as follows:

• eComponent: to call an eComponent item, from the menu option. You 
need to select the eComponent item, from the Item Name drop-down list.

Note: If a description is not entered in the parameter, the MenuID number 
will be used.
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eComponent Item Kinds

When the option for eComponent is selected in the Item Kind parameter, 
various options are available for selection under Item Name:

Refer to eComponent Item Kinds  on page 260 in the Appendix for details 
about the eComponents.

• External Component: to call an external component; If you select 
External Component, you need to enter the full path in the URL parameter.

• Menu: The Menu item kind is used for menu selections that will contain 
sub menus. For example, if we wanted an online menu item called Online 
to have several menu items underneath it, it would be of Item Kind Menu. 

• Report: to generate a report, from the menu item. If you select Report, you 
need to enter the full path to the report in the Path / URL parameter. For 
example, if we want to offer a menu selection that will provide Property 
Information, we could use a Crystal report that will query the database and 
display property information.

• URL: The Universal Resource Locator or (URL) is used to open a Web 
site in the current window or in a new window.

Item Name: The Item Name dropdown list appears only when the 
eComponent option is selected in the Item Kind parameter. Select the Web 
page that will be called from the menu item. For example, you can create a 
menu option called User Access Rights that will call the Modify User page.

Path / URL: When a selected Item Kind requires a URL to be provided, enter 
the path in the Path/URL parameter. Entries are made using standard HTML 
syntax. Only the Menu Item Kind  disables this parameter; all others will  leave 
it active.

Open Link in a New Window: When this option is selected, the page that 
the link leads to will appear in a new instance of the browser window. When 
this option is not selected, all links will be presented in the current window of 
the Web browser.

Note: When the Item Kind is set to Menu, the New command button is 
accessible indicating that sub items can be created. 

Note: When the eComponent option is selected in Item Kind, this drop down 
menu is activated.
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NEW! Report Connection Key: When a report is linked to a menu item, if 
the report is located on a server that is different from the specified in the Web 
Site form under the General tab, select the key. See Specify a General or 
Menu item Connection Key for eGovern Reports  on page 69

Dynamic Search group

The Dynamic Search group is used to specify the parameters that will be 
required for web searches. These include, the search key, the style, and the 
group. 

Requested Key: Select the key to be retrieved by the item, options are as 
follows:

• Account Receivable ID
• Name ID
• Parcel ID
• Permit ID
• Utility Billing ID

If the menu item is used in a search, select either the Search Style, from the 
Style drop-down list or the Group, from the Group drop-down list.

Note: If no Connection key is specified in this field, the system will default to 
the key specified at the Web Site form level under the General tab. For 
details about defining connection keys, refer to the Govern New 
Administrator (GNA) user guide.

Note: This parameter is for configuring reports that are specific to the 
eGovern, as opposed to OpenForm Standard reports.

Note: You have the option of assigning either a Search Style, or Search 
Group to a menu item, not both.

Note: If you are associating the menu item with a search, in the next step, 
select the same Reference ID that you selected for the Key to Retrieve 
field on the Search Style Management form. Otherwise, if different IDs 
are selected, the one entered on the Search Style Management form 
overrides the one selected in this field.
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Style: The items that appear in the dropdown menu are filtered by the 
selection that is made under the Requested Key parameter

Group: Items that appear in the drop down menu are determined by the 
option selected in the Requested Key  parameter.

Security group

This feature allows you to specify the level of security that will be applied to 
the menu.

• Internet Subscriber - When selected, the security level is set to that of a 
subscriber.

• Internet with Profile - This menu selection will be accessible by internet 
users with a saved profile, i.e. only internet users with a profile will be able 
to see this menu.

• Internet without Profile - This menu selection will be accessible by 
internet users with no saved profile, i.e. all internet users will be able to 
see this menu.

• Intranet Admin - Set this security level to make this menu accessible to 
Administrators within the organization.

• Intranet User - This is the Security level for a user within the organization.

Parameter group

When the Item Kind option of 
eComponent or Report is selected, 
the Parameter group (A) is 
activated. This parameter is used for 
passing on additional parameters 
that cannot, or should not be 
specified by the user of the web 
portal.

For example, you can specify a menu option to print a report displaying values 
for the last three (3) fiscal years. Since the online user cannot specify the 

Note: Menus will be filtered based upon security settings. This feature allows 
you to customize a specific menu for each of the above user access 
levels. For example, when a set of menu’s are created with security 
set for Internet Subscribers, those menus will only be displayed to 
internet subscribers.
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years for the report, they can be passed to the report through the parameters 
group when the report is requested. Click “+” and “-” to add or remove 
parameters (1).

Creating Menu’s

The Menu item is the top level of your menu hierarchy, it represents your 
menu. All items that appear underneath it are represented as they appear on 
the Web site.

For example if we look at the following menu structure as it is set up in the 
Web site menu editor. We see a menu that will display as follows:

• Menu
• Home
• Information
• Property Information
• Online Services
• Make Payment
• Apply for Permit
• Admin
• Contact Us
• Greetings from our Mayor
• Log Out

Sub menu items are clearly indented 
indicating the structure that they will take 
when they are presented on the site as seen 
below. You will note that some of the menu items do not appear, this is due to 
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the security settings that are set for the menu. See Security group  on page 54 

for details about security settings.

Adding Menu Levels

Click the menu (1) or submenu (2) item that you want the new menu item to 
appear under:

For example, in the above menu structure, to create a new submenu item that 
will appear under Payment History...
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1. Click to select Payment History (1); click New at the bottom of the form. 

2. Enter a name in the Description parameter.

3. Complete the parameters; click Save.

The new submenu will appear under Payment History.

Parent: Select the menu item used to access the current item or report.

Note: For example, in the following screen shot Web Portal is a Top Level 
menu item (1), Tax Information is a submenu item (2) and Payment 
History (Tax) is a submenu (3) item of Tax Informations:

Note: For example, in the following screen shot, the ePermit solution, Apply 
for a Permit is accessed from the Online Services menu option.
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Modifying Menu Levels

Menu levels are modified using a drag and drop action. A single menu or 
menu with full submenu structure can be moved or copied.

To modify a menu or submenu level...

1. Click and drag a menu that you want to reposition.

2. Note the insertion line (A) indicating the possible positions that the menu 
item can be placed.

The interface for creating menu items will only allow you to create the 
permitted subitems. For example, only a menu item of Item Kind Menu will 
allow the creation, or repositioning of items underneath it.

Note: If you see a circle with a diagonal slash through it (B), this is an 
indication that the menu item cannot be placed at this level.

Tip: When creating your menus, ensure that the security options in the 
Security group are set. Initially you can select all options, until you 
review the Web site and determine who will have access. 
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Copying Menu Levels

A menu with submenus can be copied using the same drag and drop action 
that is used for modifying the level, except hold down the Ctrl key during the 
action (A). Only release the Ctrl key after you have released your mouse. 

3. Note the insertion line (B) indicating the possible positions that the menu 
item can be placed.

Deleting Menu Levels

To delete a menu or submenu item...

1. Select the menu or submenu item from the treeview area.

2. Click Delete

Note: When a menu is being copied, a plus “+” symbol appears with the 
cursor until the Ctrl key is released.. Always take note of the insertion 
line indicating where the menu will be inserted.
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3. At the confirmation screen, click Yes, to confirm, or No, to cancel. If your 
menu contains sub menuitems, you may see the following screen.

Crystal Reports in the eComponents

As Administrators, you have the ability to customize the Crystal Reports 
supplied with the eComponents. You are able to take a standard report and 
with a fully licensed version of Crystal Reports, customize it. The links that 
appear within the report can be modified. Refer to Crystal Reports in the 
eComponents  on page 129 for details about set up and associating with 
menu items ..

Note: The system will not allow you to delete a menu that has submenu 
items. Submenu items must be deleted before you can delete the root 
menu.

WARNING: Care should be taken when deleting menus; there is No Undo 
for this action.
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Strategy for setting up menus

As indicated earlier, to create logical and relevant menus it is best to plan 
ahead. Take a few moments to decide on which menus will be required for 
your Web site.

Step 1 - Plan Your Menus

For a typical site, you can use the following “general” menu options. A grid like 
the one below can be useful for planning.

When the menus that are required are carefully laid out, it is easy to see which 
menus and submenus are needed. From the above grid, it is easy to 
determine that six (6) top level menus are required. Submenus will also be 
required; four (4) for Online Services and two (2) for Administration.

Step 2 - Create the Menus

When Web site and Webskins have been created, use the Web Site Menu 
form to create the menus, and link the pages and modules.

TOP 
LEVEL

Home Online 
Services

Admin External 
Application

Contact 
Us

Log 
Out

Second 
Level

Make 
Payment

Subscriber 
Setup

Third 
Level

Apply for 
Permit

Subscriber 
Plan

Fourth 
Level

Register a 
Complaint

Fifth 
Level 

Property 
Information
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To create menus...

1. Select Setup > Web Configuration... > Manage Web Sites... (A)

2.  In the Web Sites form, click to select your Web site from the Web Sites 
column (1).

3. Click Menu Setup, to display the Web Site Menu form (2).

4. In the Web Site Menu form, click New to create a menu.

5. When created, the new menu item appears in the Menu [Order By 
Sequence] column on the left hand side; note how it is listed with its Menu 
Sequence number.

6. Enter the Description for the menu, this is the name that will be displayed 
on the menu of the Web site.

Follow the process described in Adding Menu levels to complete your menu 
structure. See Item group  on page 51 for details.

eComponent Item Kinds

When the option for eComponent is selected in the Item Kind parameter, 
options are available for selection under Item Name. Refer to the eComponent 
Item Kinds  on page 260 in the Appendix for details about the eComponents 
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that are available.

Note: eComponents that are described as “<CUSTOM>” are components 
that have been customized for specific clients.
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Web Site Manager

With the Web Site Manager, you can create a look and feel for each of your 
Web sites by assigning WebSkins to the eProfile and the eComponents. Each 
application can be assigned a different skin to provide a different look and feel.

The Web Site Manager interface was changed in Release 4.0 of the Govern 
NetAdmin (GNA). The interface follows the standard of the other GNA editors.

Overview

Note: The parameters described in this section are to be used for configuring 
release 4.0 and greater of the eComponents. eComponent 
applications that are prior to release 4.0 can be configured, with 
appropriate licensing, by the Govern for Windows Govern Admin 
application, release 10.6/10.7.
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To access the Web Site Manager:

1. Select Setup > Web Configuration... > Manage Web Sites...

Web Sites Manager Command Buttons

Menu Setup: Click Menu Setup to open the Web Site Menu editor and 
create and edit your site menus. See Configuring Website Menus on page 127 
for details.

Web Skin Preview: Click WebSkin Preview to display a preview of your 
web skin in a window.

New: Click New  to create a new Web site.

Save: Click Save  to save your new Web site, or any changes that have 
been made to an existing site.

Delete: Select an existing Web site from the Web Sites list on the left hand 

side, click Delete  to delete the site.

Closing the Editor

To close the editor, click the Close Window button in the upper right hand 
corner of the form.

Note: When you click on New, the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.
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Web site Manager Parameters

Web site tab

Web Site ID: The Web Site ID contains a system generated number. This 
parameter is automatically incremented when a new web site is created.

Web Site Name: Enter a name for the Web site in this parameter.

Web Skin: Use this parameter to select a WebSkin from the drop-down list of 
saved WebSkins.

Note: Take note of the Web site ID number as it is required to be entered in 
the Web Config File Editor during the setup of the ePortal Application.
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Web Site Manager - General tab

The General tab (A) contains the first set of parameters used to configure your 
Web site.

Web Site Manager - General tab parameters

Web site Linked to Department: Select the name of the department 
responsible for the eProfile user accounts, from the drop-down menu.

Default Country: Enter the country to appear in the Default Country line on 
the eProfile Creation page. This selection is added to the NA_NAMES table. 
Users are free to change this default.

Maximum row to display in grid: Enter the maximum number of lines to 
appear in the grids of all the Results pages, following a search.

Note: The same name and address privacy permissions and restrictions, set 
for the department in Govern, apply to the Web. Refer to the Super 
User guide for full details on name and address restrictions.
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General tab

In the event of system errors with the Web site, messages will need to be sent 
to the system administrator. The Mail group is used to configure the 
parameters required to send the e-mail messages.

Administrator Mail: Enter the e-mail address of the administrator that has 
been designated to receive error messages.

General tab - Reports group

NEW! Report Connection Key: Specify the connection key that will be 
used by the eGovern site to access reports. See Specify a General or Menu 
item Connection Key for eGovern Reports on page 69 for details.

General tab - Mail group

In the event of system errors with the Web site, messages will need to be sent 
to the system administrator. The Mail group is used to configure the 
parameters required to send the e-mail messages.

Administrator Mail: Enter the e-mail address of the administrator that has 
been designated to receive error messages.

System Mail: This is the address that will receive system messages that will 
not require replies, e.g. confirmation of user payments.

SMTP Host: Enter the host name of your SMTP server. Example: mail-
host.domain_name.com, or smtp.sparta.com.

SMTP Port: Type in the designated port number; the default port is 25.

SMTP User: Specify the Username used to access the SMTP account.

SMTP Password: Enter the password used to access the account. Text 
entered into this field will appear “cloaked”, i.e. typed letters will appear as 
asterisks “ ****** ” to hide the typed letters.

Note: This parameter is for configuring reports that are specific to the 
eGovern, as opposed to OpenForm Standard reports.
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Specify a General or Menu item Connection Key for 
eGovern Reports

NEW! In release 4.7, in the Web Sites editor, the parameters that were used to 
specify Crystal Reports for the eComponents have been removed. The Web 
Site Manager - Report tab has been replaced with parameters in two (2) 
locations:

• In the Reports groups under the General tab (A).

• In the Item group of the Web Site Menu form.

With the ability to specify connection keys at these two locations, there is 
added flexibility for the eGovern application. Administrators can specify 
connection keys that have access to reports on Oracle databases, as well as 
SQL databases. In addition when a connection key is specified at the level of 
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the menu item, this key will override the selection made at the Website level. If 
required, each menu item created can use a different connection key, as long 
as it is available, to access a different report.

Error Conditions

Currently the system will 
generate an error 
message that is sent to 
the Administrator e-mail 
address when the Nelnet 
EFT providers system 
returns a incorrect format 
error. When this occurs 
the payment process will 
“fail” and trigger an 
exception. Since the 
payment is not complete, 
a rollback is executed 
and the detail of the 
transaction is saved in 
the following Govern 
table (Table: 
CC_PENDING_WEBTR
AN).

Above is an example of data details kept in the CC_PENDING_WEBTRAN 
table.

Note: If no Connection key is specified in the Item group of the Web Site 
Menu form level, the system will default to the key specified at the 
Web Site form level under the General tab. For details about defining 
connection keys, refer to the Govern New Administrator (GNA) user 
guide.

Note: These parameters are for configuring reports that are specific to the 
eGovern, as opposed to OpenForm Standard reports.

Note: The CC_PENDING_WEBTRAN table will contain all failed 
transactions.
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E-mail Format

The following is the format of the email message that will be sent: 

Subect: “Organization Name” Unsuccessful NelNet ePayment
Text: An error has occurred while using the NelNet 
ePayment.

Transaction_id Transation ID number

Credit Card Payment OR eCheck Payment

Amount: “Transaction Amount”

General tab - Website Footer group

Web page footer information for the eGov Website is specified in the Web site 
Footer group. As a footer this information is persistent, i.e. it will be displayed 
on each eComponent page. For additional information, please refer to the MS 
Govern eComponents Release 4.7user guide.

This section can be used for information like additional branding information, 
copyright notices, or last update date. You can specify a URL for a page that 
will be used to populate the frame. Additional text for the frame can be entered 
in the Frame Text field.

Display Footer: Select this option to enable the Web site Footer option

Frame URL: When a custom HTML page containing the footer information 
has been created, the address can be entered in this field.

Frame Text: Enter the text that will appear in the frame. Text that is entered 
in this parameter can include HTML tags which will be parsed by Govern.
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Web Site Manager - eProfile tab

Click the eProfile tab (A) to view the parameters used to set the default user 
access rights for the eProfile and the eComponents. 

Web Site Manager - eProfile tab Parameters

Allow Name / Address / Password / eMail Modification: Select one 
or more of these parameters to allow users to modify their Name, Address, 
Password, or eMail address. If these options are selected, the Edit button is 
displayed beside the applicable information on the Update Your Profile Web 
page, as in the following screen shot. Otherwise, it is not visible.

Allow Add / Remove Parcel: Select this option to grant Web users the 
right to add and remove parcels to and from their eProfiles. This may be 
required by professional users, such as contractors, who need to view data 
and make payments on other properties in order to obtain permits.
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If this option is selected the Add and Remove Properties buttons are displayed 
on the Manage Your Properties Web page. Otherwise, they are not visible.

Allow Add / Remove UB Account: Select this option to grant Web users 
the right to add and remove other Utility Billing (UB) accounts to and from their 
eProfiles. If this option is selected the Add and Remove UB Accounts buttons 
are displayed on the Manage Your UB Accounts Web page. Otherwise, they 
are not visible.

Disable Activity Step: This option will allow the user to disable the display 
of the outline of the steps followed for completing the activity. 

Combine eComplaint, eGrievance, eRequest: Select this option when 
you would like the eGrievance, and eRequest to be combined with the 
eComplaint.

Bypass ePayment on Permit Application: By default, it may be 
required to pay a fee that is associated with a permit application before the 
application can be submitted over the Web. Select this option to enable the 
bypass so that the user can submit the application without paying the fee 
online. 

Note: If you are combining the three items, you can link it to any one of the 
components, on the eProfile Menu Setup form. Also, if the three 
components are combined, you need to add a search. See eProfile 
Menu Setup on page 18, for full details on setting up the eProfile 
menus.

For example, by default, a fee associated with a permit application needs to 
be paid before the application can be submitted over the Web. Select this 
option to enable the bypass so that users can submit the application without 
making it mandatory to pay  the fee online.
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Bypass ePayment on eRemittance: When selected this option will skip 
the payment requirement step when posting an eRemittance.

Allow ePayment / eComplaint / eGrievance / ePermit / eRequest: 

Select one of these options to configure ePayment / eComplaint / eGrievance 
/ ePermit / eRequest user access. Options are:

These parameters are used 
to set the default setting for 
each of these eComponents. 
Note that any settings for an 
individual eProfile will 
override these defaults. 
Select one of the following 
options from the drop down 
menu (A):

• Not Available - Select 
this option if the 
eComponent is by default 
not available on the Web.

• Restricted to Account - 
Set this option to provide restricted access to the eComponent, by default. 
Users can submit applications on the properties defined in their eProfile, 
only.

• Unrestricted - This option is used to provide full access to the 
eComponent. Users are then able to submit an application on any property 
within the municipality or organization. For example, contractors may need 
to apply for permits on several properties that they otherwise do not want 
to include in their eProfile accounts.

ePermit Display Column: The default setting for displaying ePermit 
columns is two (2), if more are required, enter the number needed.

Group Permit Application: When this option is selected, users will be able 
to select multiple properties; for these multiple properties, only one (1) permit 
will be generated. The generated permit will be linked to all the properties.

Note: You cannot select the Restricted to Account option for the eComplaint 
component.
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Profile group

Allow Profile Creation: When selected, this option grants users the right to 
create an eProfile account, from the Web. Deselect this option if the eProfile 
accounts are to be set up by the organization. If this option is selected, the 
account creation link appears on the eProfile Login page, as in the following 
page. Otherwise, it is removed.

Maximum Property in Account: Enter the maximum number of parcels 
that users can add to their eProfile. If this field is left blank, users can add an 
unlimited number of parcels

Maximum UB Account: Enter the maximum number of Utility Billing 
accounts that users can add to their eProfile. If this field is left blank, users can 
add an unlimited number of accounts.

Setting the Default Identification

NEW! At the start of the account creation process, the How can we identify 
you? parameter can be preset with a default selection. Note that this selection 
can then be changed by the user if it is not correct.

To set the default...

1. Open Govern’s New Administrator (GNA) and select Application Configu-
rations > Web Configuration... > Manage Web Sites...

Note: In order to use this option, the Allow Add / Remove UB Account option, 
under the eProfile tab, must be selected.
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2. In the Web Sites editor, select the eProfile tab (A).

3. Under the eProfile tab, locate the Profile group (B) and select the Default 
Identification parameter. Your selection from the list will be the default for 
the Account Creation page of the Website.

On the Account Creation page the user will see your selection as the default. 
The user is free to make another selection.

Subscription group

Allow Subscriber Creation: Select this option to allow the creation of new 
subscribers.

Default Subscriber Type: This option is active when the Allow Subscriber 
Creation option is selected. The subscriber type that is selected will be the 
default subscriber type.

Misc. Billing Year: Enter the default year for Misc. Billing.
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Misc Billing A/R Class: Select an A/R class from the drop-down menu that 
will be used for Misc. Billing (MB).

Password group

Security Level: Select a security level for the eProfile passwords:

• Low Security requires alphanumeric characters only.
• Medium Security requires at least one numeric character with alphabetic 

characters.
• High Security requires at least one numeric character and one special 

character with alphabetic characters.

Minimum Password Size: Enter the minimum number of characters for 
the eProfile password.

Special Character Allowed: Enter the special characters that will be 
accepted in the password.

Web Site Manager - ePayment tab

The ePayment solution increases the efficiency of bill payment and collection. 
It provides the client, or taxpayer, with a secure, fast and convenient method 
of paying bills, while providing the organization with a fast and effective 
method of tracking payments and maintaining up-to-the-minute account 
information.
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The Web ePayment Parameters form is used for setting and maintaining the 
default parameters for the ePayment data. 

Web Site Manager - ePayment tab Parameters

Live Mode: The MS Govern ePayment (A) sub-system can be used in two 
modes: Live Mode, and Test Mode (default mode). Test Mode allows you to 
perform simulations on the system with credit card providers in “test mode”.  
When the Live Mode option is selected, the sites are to be live on the internet. 
Select this option to run the Web site in a live environment.

User Confirmation Required: Select this option to display a confirmation 
of transaction prompt when an online transaction is initiated by a user. When 
not selected, transactions will be completed without a confirmation.

Minimum Payment Amount: Enter the minimum amount that can be 
accepted for an ePayment, in dollars and cents. If the user enters an amount 
that is less than the minimum payment value specified in this field, an error 
message is displayed. The user will need to correct this amount in order to 
complete the ePayment transaction.
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Cashier ID: Enter a prefix for the cashier ID; this ID is comprised of this 
prefix followed by the effective date.

Display X Previous Payor: In this parameter “X” represents the number of 
previous payors that will be displayed in the list.

Receipt Prefix: Enter the sequence that will be used as a receipt prefix. It 
consists of a maximum of three characters and is used as a prefix for receipt 
numbers (Table: USR_KEY_ RECEIPT)

Business End Day: Enter the 
end of the business day, in hours 
and minutes. This parameter is used 
for calculating interest and penalty 
charges. Charges on payments 
accepted after this time will be 
calculated as of the next business 
day. For example, if you enter 4:00 
P.M., interest on payments received 
at 5:00 P.M. are calculated as of the next business day. Interest on a payment 
received Friday evening is calculated from Monday morning or the next 
business day if the Monday falls on a holiday. Otherwise, payments are 
processed and accounts are updated in real time.

Note: It is important that this parameter is set because this value, when 
applicable, can affect the result of interest calculations.
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Modifying the “Business End Day” Parameter

The Business End Day parameter (A) can be modified as follows:

1. Click in the parameter to highlight the current value.

The numbers must correspond to the hours, minutes, and time of day, i.e. AM 
or PM. The format is as follows: HH:MM AB

...where HH is the hour of the day, MM is the minutes, and AB is the time of 
day, i.e. AM or PM  

Default Installment: Select the A/R installment for which payment is 
currently due: first, second, third, fourth or total (Table: VT_ SY_INSTALL). By 
default, the installment due is selected on the Web page, as in the following 
screen shot.

Block RE Payment After: Specify the date after which all Real Estate (RE) 
payments will be blocked. This option might be used when you want to enforce 
the requirement that payments must be made by the end of a closing fiscal 
year.

Note: Leave this field blank if you do not want the default installment to be 
selected on the Web page.

This field is required for Real Property Tax payments only.
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Modifying the “Block RE payment After” Parameter

The Block RE payment After 
parameter (A) can be modified as 
follows:

1. Click in the parameter to 
highlight the date/month/year.

2. Type the DD/MM/YYYY 
required.

OR

1. Click the Calendar (A) button 
to display a calendar; select a 
date.

There are Left and Right Arrows on either side of the month that will allow you 
to scroll through the months of the year (1). To scroll through the years, place 
your cursor on the right side of the Month. Up and Down arrows will appear; 
click the arrows to increase or decrease the year (2).

Disable Dynamic Search Multiple Selection: Select this option to 
disable the multiple selection feature. 

Note: On the calendar, click Today to set the calendar to the current date.
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ACH tab

Automated Clearing House (ACH) is a secure payment transfer system that 
provides a centralized clearing facility for Electronic Fund Transfer (EFT) 
payments, occurring within the U.S. and Canada. You can use ACH for all 
your electronic payments; for example, to validate authorized debits from your 
clients’ accounts for recurring payments. Click the ACH tab (A), to set required 
parameters. 

ACH tab Parameters

Allow ACH: Select this option to enable ACH transactions.

ACH Batch Suffix: Enter a suffix for the deposit number for ACH payments. 
This is appended to the Effective Date of the ePayment.
Page 82 © 2012 MS Govern



Web Site Manager

FI
N

AL
 D

R
AF

T

Check Image Path: Enter the path to the directory where the example ACH 
check image is stored.

This is the default image displayed during the ePayment process when the 
user enters the Bank ID and Account Number. You can replace this default 
with another image.

Convenience Fee group (ACH tab)

A convenience fee is charged for each credit card transaction made through 
the ePayment component, to cover the associated costs, such as, the 2.5% 
charged by the credit card company. You need to set the following parameters.

Minimum: Specify a minimum convenience fee.

Maximum: Enter a maximum convenience fee.

Percentage: Enter the percentage of the payment to be charged for the 
Convenience Fee. A confirmation screen, showing the calculated amount as 
based on this percentage, is displayed to the payer before the transaction is 
completed.
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Credit Card / Debit Card / eCheck tab

This tab (A) contains the parameters that are required for configuring credit 
cards, debit cards, and eChecks.

Credit Card / Debit Card / eCheck tab Parameters

Govern is able to support a selection of Electronic Fund Transfer (EFT) 
providers / interfaces. Currently, the providers / interfaces available are the 
following:

• ICVerify
• Pay Connexion
• Moneris
• Nelnet (QuikPAY)
• PayPal
• Point and Pay
• US Moneris
• Your Pay

• Paymentus

Note: To configure your Electronic Fund Transfer (EFT) vendor account, see 
the Manage parameter below.

Note: Refer to Electronic Fund Transfer (EFT) on page 384 for additional 
details about supported providers.
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Vendor Account: Click on the parameter (A) to display the list of vendor 
accounts that are available. 

Manage: Click Manage (B) to display and manage the selected vendor 
accounts in the Vendor Account Management form. Depending on the vendor 
that is selected, the Account Management form (B) will display any required 
parameters.

Note: To configure your Electronic Fund Transfer (EFT) vendor account, you 
will need to contact the vendor and obtain the information that will be 
entered in the Vendor Account Management form (C).
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Electronic Funds Transfer Process

The Electronic Funds Transfer (EFT) process is similar for each of the 
providers / interfaces. For example, PayPal offers the Payflow Pro product for 
processing Credit Card and Debit Card payments. Payflow Pro is a secure 
online gateway for sending billing information to banks. Banks, authorize, 
process, and manage payments that come from online requests. These online 
requests containing billing information for orders, are transmitted through the 
certified, secure connection that is provided by the Payflow Pro payment 
gateway.

The Govern system supports PayPal's Payflow Pro and other EFT provider 
transactions by providing forms that contain parameters that are supplied to 
the user by the EFT provider.

Steps for Setting up an EFT Provider

User requirements for EFT provider transactions are as follows:

1. A credit card account from the city or organizations business bank to be 
supplied to the EFT provider.

2. An account created by the EFT provider.

3. If Governs’ eComponent is to be hosted on the city’s IIS server, a 
certificate from VeriSign, DigiCert, or any other Certificate Authority (CA) is 
required. If not, the city must be able to ‘sign’ the site for security and 
correctly use the HTTPS protocol.

Note: This account is not to be confused with a standard web account like a 
PayPal account that is typically created online.
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All Govern required configuration parameters should be requested from the 
EFT provider when an account is opened.

The configuration parameters provided by the EFT Provider, e.g. PayPal, are 
to be entered in the Account form (C).

When configuring the EFT interface, use the Credit Card/Debit Card/eCheck 
tab (B) under the ePayment tab (A) of the Website Manager.

Specify a Batch Suffix for Credit Card/Debit Card/eCheck

Usually there are multiple transactions that occur on a daily basis. When these 
transactions are processed it is often necessary to determine the origin of the 
transactions. This suffix is for the deposit number and is appended to the 
Effective Date of the ePayment. By specifying a Batch Suffix you are able to 
quickly determine, the Electronic Funds Transaction (EFT) transaction, and its 
origin. For instance a batch suffix can be used for quick identification of Web 
transactions. 

Note: No additional information is required, i.e. file layout information, header 
file specifications, etc.
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Batch Suffix Credit Card / Debit Card / eCheck: Enter a batch suffix for 
any of the required parameters, i.e. Credit Card, Debit Card, and / or eCheck.

Allow Credit Card: Select this option to allow credit card transactions.

Allow Debit Card: Click on this option to allow debit card type transactions.

Allow eCheck: Select this option to allow eCheck type transactions.

Convenience Fee

The convenience fee is used for specifying a supplementary charge for a 
transaction. This feature will allow you to specify a threshold amount, and or a 
percentage value of the full payment. In addition, if required, you are able to 
specify an alternate Automated Clearing House (ACH) account to divert the 
convenience fee charges to.

Convenience Fee group

Use Secondary Account Fee: Use the Use Secondary Account Fee 
option to specify a secondary ACH for handling convenience fee charges.

Minimum: Specify a minimum amount to charge for the convenience fee.

Maximum: Enter a maximum amount that will be charged for the 
convenience fee when entered this amount will override any percentage 
amount that exceeds the entered value.

Percentage: Enter the percentage value that will be applied to the payment 
amount for the convenience fee when the minimum value is exceeded.

Specifying a Flat Rate for the Convenience Fee

When a Percentage value is not specified, i.e. set to zero (0), and a value is 
entered in the Minimum parameter, a flat rate will be charged for the 
convenience fee.

Note: A value must be entered in this parameter; if the option is not required, 
then a value of zero (0) must be enterd in the parameter.
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To specify a flat rate for the Convenience Fee...

1. Enter the amount that is to be your flat rate in the Minimum parameter.

2. Set the Maximum and the Percentage parameters to zero (0). 

Disabling the Convenience Fee option

Complete the following steps to ensure that the convenience fee option has 
been disabled. 

To disable the Convenience Fee option...

1. In the Convenience Fee group, click to select the Use Secondary Account 
Fee drop-down menu (1) and select the blank option from the drop down 
menu.

2. Set all parameters to zero (0), i.e. Minimum, Maximum, and Percentage.

3. Click Save.
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Site Seal Script tab

The function of the Site Seal under the Site Seal script tab (A), is to inform 
visitors that your Web site is secure. In order for a site seal to work, you should 
have purchased a secure certificate from a provider like Verisign. A script (B) 
that is similar to the following may be provided:

The provided script should then be copied and pasted into the text parameter 
under the Site Seal Script tab. This script is included in the page when it is 
generated. 

 Example: 
<!-The Certificator Site[c] Smart Icon tag. Do not edit. -->

<script type="text/javascript" src="https://
sealserver.thecertificator.com/seal.js?style=normal"></script>

<!-end Certificator Smart Icon tag -->

Note: Depending on your certificate provider, you will need to contact them 
for full configuration instructions.
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Payment Option tab

Use the Payment Option tab (A) to enforce which subsystems (B) require that 
a full payment be made when users are using the Web.

Web Site Manager - Self Reported Tax tab

Select the Self Reported Tax tab (A) of the Web Sites form to configure the 
behavior of the Self Reported Tax form on the eGovern Web site.
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Web Site Manager - Self Reported tab Parameters

NEW! Show only un-filed Generated Periods: When there are 
municipalities with pre-generated forms for all required period, there may be a 
preference to display only un-filed periods. By default, after generating the 
forms, all periods will be listed and accessible to the user for completion. To 
streamline this process it may be advantageous to display only the periods 
that are required for filing. Select this option to hide the periods that have 
already been filed.

This option is associated with a Govern for Windows Batch process that is 
used to generate required parameters in the SRT form. This process serves 
as a means of directing user to complete only the current required form, and 
thereby minimizing the occurrence of any incorrect entries. For example when 
a pre-generated 

To run the Batch Process, in the Govern for Windows GovBatch application...

1. Select Self Reported Tax > Special Procedures.
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2. In the Special Procedures form, click to select the option for SRT - Create 
Missing Filer.

NEW! Enable Zero Filer: Auditors may find it preferable to contact 
organizations directly when they have no declarations for a required period, 
i.e. a Zero declaration file (Zero Filer). By default the option to allow a Zero 
filer entry on a Web site is disabled. Select this option to enable the Zero filer 
option, and allow on the Web site.

Bypass ePayment on eRemittance application: When selected this 
option will skip the payment requirement step when posting an eRemittance.

Web Site Manager - eInspection tab

Select the eInspection tab to configure options for the online inspection 
module.

Note: If the error, ClickOnce Batch Shortcut has not been defined, is seen, 
you will need to configure the path to the Deploy EZ application under 
the Connections tab of the System Registry Maintenance form of the 
Govern for Windows GovAdmin application. Refer to the Govern Batch 
Processing Interface section of the Govern for Windows Super User 
form.

Note: As of Release 5.0, the above option, Bypass ePayment on 
eRemittance application, has been moved from the eProfile tab.
© 2012 MS Govern Page 93



eGovern – Public Self 
Service Portal

FI
N

AL
 D

R
AF

T

Web Site Manager - eInspection tab Parameters

Allow Change Department: Select this option (1) to allow inspectors to be 
able to work outside of their department. When this option is not selected, 
inspectors can only work within their assigned departments.
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Web Site Manager - Report Tab

The parameters under the Report tab (A) are used to specify Crystal Reports 
that are used for the eComponents. 

Web Site Manager - Report tab Parameters

Crystal Reports group

Database Name: Specify the name of the Web Information database.

Server Name: Enter the name of the Web Information Database.

User ID: Enter the user ID that is used to access the database.

Password: This parameter should contain the password that is used to 
access the database.
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Web Configuration File Editor

The Govern Net Admin’s (GNA) Web Config File Editor is designed to manage 
Govern’s eComponents. With the Web Configuration File Editor, you are able 
to define configuration parameters, determine how errors and exceptions are 
managed by the system, and set auto login parameters.

To access the Web Config File Editor in GNA, select Setup > Web 
Configuration > Web Config File Editor... You will be presented with a 
window requesting that you select a .config file. This is your Web site 
configuration file.

To locate and select the web.config file:

1. Root Directory... \ InetPub \ wwwroot \ WebUserInterface directory. 
Select the file called Web.config; click Open.

Overview
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2. In the Web Config File Editor form, select the Page 1 tab (1) to define the 
configuration parameters.

3. Click Select a Web .config configuration file to edit to select the 
configuration file for the Web site you are defining or modifying.
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Web Configuration - Page 1 tab

Link to GovernNetConfig group

Directory: Click... to select the directory where the GovernNetConfig.xml file 
is located.
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Upload Document(s) group

Directory: Click... to select the directory you are using for uploading 
documents from the Web for the ePermit and eComplaint solutions.

Maximum File Size: Enter the maximum permissible file size, in megabytes 
(MB), for a file that can be uploaded.

Web Site group

ID: Specify a web ID for the site.

Default Page: Select the Default Page drop down menu to specify which 
page will be displayed as a default. Options are as follows:

• WEBPROFILE - This option is used when users have an existing account. 
Users will be required to enter a username and password.

• WEBPORTAL - Select this option in situations where you would like users 
to be able to perform actions that do not require an account, i.e. access 
credentials.

Note: A maximum file size setting of 2MB is usually adequate for most .JPG 
documents. 
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NEW!  Display Build Version: Click to select the option to display the build 
version of the site on the web page. Setting this option can assist during 
troubleshooting.

Web Configuration - Page 2 tab

Publishers group

Parameters in the Publishers group define how logged errors and exceptions 
are to be managed by the system.

Note: The difference between an exception and an error are, Exceptions 
can be caught and recovered whereas Errors are unrecoverable.
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Event Log: Select On to create an event log. This log that can be viewed 
through Windows Event Viewer. By default, the system setting for this option is 
On.

SMTP Mail Server: Enter the domain name of the SMTP Server; for 
example, mail.mycompany.com

Database: Select On to log errors and exceptions in the SY_EXCEPTION_ 
LIST table in your database. By default, the system setting for this option is 
On.

Mail Address: Enter an e-mail address for the errors to be sent to; for 
example astark@mycompany.com.

E-mail: Select On to send errors and exceptions to an e-mail contact; enter 
the address in the Mail Address parameter..

File: Select On to create a log file for any generated errors and exceptions.

File Name: Click ... to specify the location of a resource file.

Validate Event Publisher: After selecting your required publisher options, 
click Validate Event Publisher to perform a test of all settings that were 

Note: Do not turn on this option if an e-mail address has not been entered. 
By default, the system setting for this option is Off.

Note: Do not turn on this option if a filename for the log file has not been 
specified. By default, the system setting for this option is Off.
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enabled in the Publishers group. These are the settings that are set in the 
Setup > Web Configuration... > Manage Websites... form..

Auto Login group

When you enter your Login and Password information into the Auto Login 
parameters, you will gain access to the Web site without having to enter a 
login ID or password. This option can be used when continuous access is 
required, e.g. a public kiosk for citizens to access property information. This 
kiosk site would be configured as a separate Web site that is accessed with a 
customized eProfile. As a separate Web site it will also have its own 
web.config file.

Note: This test will validate that the connections that are based upon user 
access privileges are successful. This means that if directories are 
accessed, it will be completed based upon the rights that the user 
performing the test has. This will in no way be a reflection of the 
access rights that may be required by a Web server. Users should 
verify that server access has been verified.

Note: When using the Auto-Login option, ensure that the information being 
accessed is not of a sensitive nature.

Note: The Username and Password are encrypted within the web.config 
file and any attempt to modify the information within the file will result 
in an error.
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Crystal Report group

Print Mode: Select whether the user prints using ActiveX or PDF; if ActiveX 
is not supported, PDF will be the default.

Directory: Click... to select the path to the report files.

Option to Display Path to Help File Content

NEW! Although not available as a switch in 
the Web Configuration File editor, users 
that are developing Help content for their 
eGovern sites should note that there is an 
option to display Resource file keys. The 
Resource file key contains the text for the 
help file. Once the resource key is obtained, 
it can be used to locate the text, and edit it 
using the Resource File Editor in Govern’s 
New Administrator (GNA).

Note: Users of Crystal Reports will need to install the Crystal Reports 2008 
runtime on the server hosting the application, and on each client 
computer. Refer to the Crystal Report Runtime section of the 
DeployEZTM Installer Guide for details. 

Note: Users should refrain from manually editing the Web.config file as 
errors can be unintentionally introduced that may lead to the website 
being rendered inoperable. Only knowledgeable users should attempt 
a manual edit of the Web.config file.
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Displaying the Help Content Key

As indicated, displaying the Resource key that contains the Help text is done 
by enabling the GovernSoftware.ShowHelpPath key in the Web.config file.

To enable the key...

1. Using a text editor, open the Web.config file.

2. Locate the GovernSoftware.ShowHelpPath key and set the value to 
equal True.

3. Save the file and close the file.

When enabled the key switch is enabled, and the Help is invoked, at the 
bottom of the text will be the key that the text can be located in. 

Note: This feature is intended for developmental purposes only and should 
be returned to its default state of False so as not to be a distraction to 
users of the Website.
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Web Skin Manager

A “skin” is a term used to refer to the appearance of the user interface (UI). 
Consequently a “WebSkin” refers to the appearance of the UI in a web 
browser. A WebSkin will present a Web application with a different look and 
feel, but the behavior of the UI will not change.

With the WebSkin Manager, you are able to customize the look and feel of the 
eProfile and the eComponents. The WebSkin Manager contains tools for 
defining the parts of the layout, e.g. title, head, header, footer, left and right 
margins and body, of a Web site. These parts are defined as a “skin”, assigned 
a name and ID, and then selected for the eProfile or an eComponent through 
the Web Site Manager.

Typically the Webskin Manager can be used to replicate the pages of your 
Web site that will contain restricted access eProfiles and eComponents. For 
example, the pages that are duplicated can contain eComponents that allow 
citizens to access information for outstanding tax balances, make payments 
online, or apply for permits as contractors. 

Using JavaScript

Your non-eComponent pages, i.e your main Website, can contain JavaScript 
code that may be used for linking to other pages or as text fields that are used 
to enter search phrases. Embedded JavaScript code can be executed on a 
Web page; using them in pages with eComponents may result in 
unpredictable results.

Overview

WARNING: When duplicating your pages, avoid including any JavaScript 
code or components. JavaScript components can interact and 
impact negatively with the eComponents. This can lead to non-
functional or “broken” web pages.
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To access the WebSkin Manager:

1. Select Setup > Web Configuration... > Manage WebSkin... (A)

HTML and the WebSkin

Some of the tabbed sections of the WebSkin manager allow you to include 
custom HyperText Markup Language (HTML) code to your WebSkin. 
Customization also allows you to add JavaScript code and include or 
reference Cascading Style Sheets (CSS).

HTML Primer

In order to add HTML customization to WebSkins, it is good to have an 
understanding of basic HTML. For in-depth explanations, various text 
references are available from most stores that sell programming books. In 
addition, numerous “go to” resources can be found on the Internet.
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The structure of a basic HTML document is as follows:

There are four (4) primary “tags” used in HTML:

• <HTML>
• <HEAD>
• <TITLE>
• <BODY>

There are two (2) principal parts to the HTML document, they are the “HEAD”, 
and the “BODY.” An HTML document starts with the <HTML> tag and ends 
with the closing </HTML> tag, note the “/” that is used for the closing tag.

Applying HTML Tags

In the following example, we want to make text appear as bold. To do this we 
would surround the block of text with the following:

<B>This text block will appear Bold!</B>

If we want part of the sentence to appear Italicized we can “nest” the tags as 
follows:
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The opening tag “turns on” the bold option and the closing tag turns it off; if the 
closing tag is not present, all text after the tag will appear as bold until it 
encounters a closing tag. The Italic tag is “nested” within the bold tag.

This methodology of using opening and closing tags is the general rule for 
HTML. Exceptions exist where only an opening tag is used.

Paired HTML Tags

Tag Name Tag Used Comments

Bold <B></B> Bold

Italic <I></I> Italic

Paragraph <p></p> Plain

Font <font face=”Arial” color=”#FFFFFF” 
size=”5”>
- The font name must appear as it 
does in your fonts folder
- Colors are defined using Octal

Not 
recommended 
for use; use CSS 
instead. 
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Single Tags

See Appendix E: HTML Tags on page 278, for a list of common HTML tags.

Creating a WebSkin

To create a WebSkin:

1. Select Setup > Web Configuration... > Manage WebSkin...

2. Click New  (1) on the Webskin tab.

Tag Name Tag Used

Horizontal Rule <HR> 
OR
<HR WIDTH=”50%”> 
The rule is specified as 50% of the page size

Break <BR>

Non-breaking 
Space

&nbsp

Image and Source <IMG SRC=”URL”>
The path to the image must be specified. Ex. 
<IMG SRC=”C:\IMAGES\MyPic.gif”>
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3. A Webskin ID is generated in the WebSkin ID (1) field; this field cannot be 
changed.

4. Enter a name in the Web skin Name (2) field. This is descriptive and is for 
informational purposes only.

5. Define the WebSkin properties, as described in this section.

6. Display a preview of the WebSkin, by selecting the View Skin Preview 
button (3).

Navigating the Webskin Manager tabs

There are a total of eight (8) tabs in the Webskin Manager form. Depending on 
the size of the form, some tabs may become hidden. You can expand the 
width of the form by placing your cursor at the side, or any one of the corners 
of the form until a double headed arrow appears, click and drag to expand. 

To view hidden tabs...
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1. Click the left and reverse buttons (1), (2) that appear on the last tab (A). 
When there are no hidden tabs, this tab will not be visible.

Layout Type tab

The first step is to select a layout type for the Web site; two (2) layouts are 
available.

• Select Full width header and footer to extend the header and footer to 
the full width of the Web page with the left and right borders extending only 
between the top and bottom border.

• Select Full height left and right border to extend the left and right 
borders to the full height of the Web page with the header and footer 
extending only between the left and right border.

Web Page Section tab

Click the Web Page Section tab to define general properties for the WebSkin.
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Default Web Page Title: Enter the title for the Web page. This appears in 
the title bar of the browser. The title is included in the Head section as follows:

Sometimes, the title information is used, by some search engine robots, with 
the keywords, to create an index for the page. This index information is 
displayed when users query the search engine. 

<TITLE>Govern.WEB Demonstration Page</TITLE>
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Web Page Background Color: Extend the drop-down list (A) to define a 
background color (1) and do one of the following.

• Select a customized color, use a standard Web color, use a standard 
Windows color, or enter the Red, Green, Blue (RGB) or hexadecimal (hex) 
value.

OR

• Select the color sampler (Eye Dropper icon) (A), click, hold, and drag the 
eyedropper over any area on your desktop; this will use the sampled color  
as a background colour.
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Web Page Margins group

For Internet Explorer: For displaying the Web page in Microsoft® Internet 
Explorer (IE), enter a value for the Left, Right and Top Margins.

For Firefox: For displaying the Web page in Mozilla Firefox®, enter a value 
for the Margin Height and Margin Width.

Table Layout group

This section controls the Layout Table section of the Web page. This is the 
area between the header, footer and left / right borders; i.e., the Govern area.

• Width: Enter a value for the maximum width of the layout table.
• Back Color: Select a color or enter a value for the background color of the 

table, as described under Web Page Background Color on page 114.
• Border Width: Enter a value for the width of the borders.
• Border Color: Select a color or enter a value for the border.
• Alignment: Select the alignment for the elements in the table; options are 

Center, Left, or Right.
• Cell Spacing / Cell Padding: Enter values for the spacing and padding of 

the cells.

Head Section tab

Click Head Section to define the information for the Head section of the Web 
page. The Head Section (1) of a Web page contains keywords, meta tags, 
javascripts and references to CSS files. Meta Tags may be used by search 
engines, such as Google, Bing, and Yahoo, to categorize and rank your Web 
site in a search result.

Tip: Enter values for all parameters in order to support both of these popular 
browsers.

WARNING: When duplicating your pages, avoid including any JavaScript 
code or components. JavaScript components can interact 
negatively with eComponents, resulting in non-functional or 
“broken” web pages.
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You can add other information, such as links to Cascading Style Sheets 
(CSS). If there is nothing to be added, the Head Section may be left blank.

WebSkin Layout

The sections of the layout and the borders are illustrated in the following 
screen shot:

Note: The CSS file for the eProfile and eComponents is handled separately. 
However, you can include a link to an external CSS file for controlling 
other properties on the header, footer, left or right margins.
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Header, Left, Right and Footer Sections

Select these sections to define the properties for the borders of your Web 
pages.
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Cell Width / Cell Height: Enter a value for the cell width and the cell height.

Horizontal / Vertical Align: Use these options to specify positioning within 
the cell.

Background Color: Select a color or enter a value for the background color 
of the table, as described under Web Page Background Color on page 114.

Note: You can enter the value in pixels (px) or as a percentage.

If you are using a percentage, you need to specify this, otherwise the 
browser will interpret the entered value as pixels.

It is highly recommended to use the same type of value for all 
sections: i.e., the Head, Footer, Left and Right sections
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Background picture: Select this option if you are adding a background 
image to the selected area; i.e., the header, footer, left or right border. Then 
enter the file name and extension in the text box.

Custom HTML code to include: Enter any additional HTML code you 
want to add to the header, footer, left or right section.

MSGovern Section

Select the MS Govern Section to define the properties for the Govern section 
of your Web pages.

Cell Width: Enter a value for the cell width.

Note: Specify a URL for the image.
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Cell Height: Enter a value for the cell height.

Horizontal Align: Select center, right, left or none specified for the 
horizontal position of the Web site.

Vertical Align: Select top, middle, bottom, baseline or none specified for the 
position of the Web site.

Background Color: Select a color or enter a value for the background color 
of the table, as described under Web Page Background Color on page 114.

Click Save; then Exit to complete the WebSkin setup.

Editing a WebSkin

To edit an existing WebSkin:

1. Select an existing WebSkin on the Web Skin Manager (A).

Note: You can enter the value in pixels or as a percentage.

If you are using a percentage, you need to specify this, otherwise the 
browsers interpret the value in pixels.

It is highly recommended to use the same type of value for all 
sections: i.e., the Head, Footer, Left and Right sections.
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2. Modify any existing parameters under the WebSkin tab (B); refer to the 
setup for the creation of a new WebSkin for details. See “Creating a 
WebSkin” on page 110.

3. Display a preview of the WebSkin, by selecting the View Skin Preview 
button.

4. Click Save and Exit.

Deleting a WebSkin

To delete a WebSkin:

1. Select the WebSkin in the WebSkin Manager list box.

1. Click Delete  on the WebSkin tab.

2. Click Yes on the confirmation message box to delete the WebSkin.
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Creating a Web site
Following are the steps used to create a basic eComponent Web site:

Create a WebSkin

The WebSkin can be described as the theme or look of your Web site. 
Creation of the WebSkin is the recommended first step when building a Web 
site.

1. To create a new WebSkin, select Setup > Web Configuration... > Manage 
WebSkin...

2. In the Web Site Manager click New. (1)

3. In the WebSkin Manager form select the layout style of your Web site; 
complete all additional forms. See Creating a WebSkin on page 110 for 
details. 
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Create a New Web site

Once you have created any required WebSkins, create the Web site and 
attach the WebSkin to it.

1. Select Setup > Web Configuration... > Manage Web Sites... 

2. In the Web Sites form, click New (1); a number is automatically generated 
in the Web Site ID parameter (2).

3. Enter a name that will be used to identify the Web site in the Web Site 
Name parameter (3).

4. Select a WebSkin from the WebSkin drop-down menu (4).

Previewing a Web site

As you are building your Web site, it is recommended that you periodically  
preview how your Web site will look with the WebSkin.
Page 124 © 2012 MS Govern



Creating a Web site

FI
N

AL
 D

R
AF

T

1. Click WebSkin Preview (A) to display your Web Site with a selected 
WebSkin.

While previewing your Web site (B), you are also able to view the source code 
(C) for your page in the same window..

Adding Menu items

To add menus to your Web site...

2. Click Menu Setup to access the Web Site Menu setup form.

Note: When you click View Source in the WebSkin Preview window, the 
View Source button will change to View Preview when the source 
code is displayed in the preview window.
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3. Click New to create a new menu item; enter a description in the 
Description field.

4. Change the Menu Sequence by changing the number that appears in the 
Menu Sequence parameter.

Editing a Web site

To change the parameters of an existing Web site...

1. Select the Web site from the Web Sites (A) list on the left hand-side; when 
selected, the parameters for the site are displayed on the right hand side 
(1).

2. Make any required changes to the parameters.

3. If necessary, select different skins, from the drop-down lists as required.

Deleting a Web site

To delete a Web site:

1. Select the Web site from the Web Sites list (1) of the Web Sites manager.
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2. Click Delete (2).

3. Click Yes on the confirmation message box.

Website Menus

For an understanding of the steps involved in creating menus and related 
activities, refer to the steps below:

• Creating Menus - See Creating Menu’s on page 55
• Adding Menu Levels - See Adding Menu Levels on page 56
• Modifying Menu Levels - See Modifying Menu Levels on page 58
• Copying Menu Levels - See Copying Menu Levels on page 59
• Deleting Menu Levels - See Deleting Menu Levels on page 59

Configuring Website Menus

The Web Sites and Web Skins forms are used to create the “shell” that will be 
your Web site; after defining the look and feel, you can then configure the 
menus. Menu options can be associated with a Web page, a report or with a 
Search Style. See Accessing Dynamic Search Configuration Tools on 
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page 261. The Web Site Menu form is used to create and configure your 
menus. 

Web Site Menu Command Buttons and Parameters

For details about the Web Site menu Command Buttons and Parameters, 
refer to Web Site Menu Command Buttons on page 50 and Web Site Menu 
Parameters on page 50.

Strategy for setting up menus

For steps to successfully set up menus, refer to Strategy for setting up 
menus on page 61 for details.

Tip: Before beginning, plan your menu setup. Create all your top level menus 
first. You need to refer to them when you create your second level items, 
then the third, fourth and fifth level items, if applicable. In addition 
indicate the Item Types that will be assigned to each menu item. See  
Item Kind on page 51 for details about Item Kinds.
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Crystal Reports in the eComponents

A feature of the standard Crystal Reports supplied with the eComponents is 
the ability to customize them. Users are able to take a standard report and 
customize it with a fully licensed version of Crystal Reports. The links that 
appear within the report can be modified.

To fully understand this concept, let us first look at a a typical report and how 
to set it up as a menu on the Web site. In the following example, we will create 
a menu selection called Property Information. Property Information is a 
submenu of Information.

To setup the menu…
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1. In GNA, select Setup > Web Configuration… > Manage Web Sites

2. In the Web Sites form, click to select your Web site (A)

3. Click Menu Setup (1).

4. In the Web Site Menu form click Menu under the Menu [Order by 
Sequence] list.

5. Click New.

6. In the Description parameter, enter Information; this is the name of the 
menu.

7. In the Item group, select Menu for Item Kind; this menu item is going to 
have a sub menu.

8. Click Save.

Now that the menu has been created, we can now create the sub menu item 
that will link to our report.

To create the sub menu item...

9. Click to select the recently created Information menu item; click New.

10. Enter Property Information in the description field.

11. In the Item group, select an Item Kind of Report.

12. in the Path / URL parameter, you will need to enter the path to the report 
on the server. for this example the path is a follows:
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C:\Inetpub\wwwroot\Demo Reports\DEMO\WEB_MENUREPORT.rpt

The report used here is a generic report that will be used to retrieve property 
information. This report is also embedded with links to additional information. 
To obtain the property information required, a key will have to be supplied, e.g. 
AR_ID, NA_ID, P_ID, etc. For property information, we will use the Parcel ID. 

13. In the Dynamic Search group, select Parcel ID for the Requested Key.

14. For the Group parameter, select Search by Property.

15. In the Security group, because this menu will be accessed by all users, set 
all options; i.e. Internet subscriber, Internet with profile, Internet without 
profile, Intranet admin, and Intranet user.

This report requires the year that will be queried, i.e. the YEAR_ID. For this 
report it will be for the year 2009.

16. Click “+” (A) in the Parameter group; enter YEAR_ID under the Name 
column (1), and 2009 under the Value column (2).

17. Click Save.

The menu on the web site will not change immediately. In some instances, it 
may be necessary to perform a reset of Internet Information Services (IIS).
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Resetting Internet Information Services (IIS)

To perform a reset of IIS...

1. On the Windows desktop, select Start > Run...

2. In the Run window, enter iisreset.

This command may also be entered at a command prompt (A) in a console 
window. 
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Once saved, the menu will be available to all users accessing the Web site. 
Through this particular report, users may also link (A), (B) to other queries like 
Utility Billing information and or the Online Payment eComponent.

Adjusting Crystal Report Embedded Viewer Size

NEW! After customizing a Crystal Report, there are options available to 
control the display size of the report that is embedded within the Web page. 
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This can be necessary if the requested report has a large margin and more of 
the information on the reports needs to be displayed.

To specify the Width, Height, and Zoom factor of an embedded Crystal 
Report...

1. Use a text editor like notepad.exe to open the Web.config file that is used 
for the Website.

2. In the file, locate the following three (3) parameters:
• GovernSoftware.WebReportViewerWidth
• GovernSoftware.WebReportViewerHeight
• GovernSoftware.WebReportViewerZoomFactor

3. Enter the values that will correspond to the display area that is required 
beside the value= parameter.

4. Save the changes to the Web.config file.

For example, if the following values were entered, it would correspond to a 
display area of 875 pixels wide, 1200 pixels high, and a zoom factor that is set 
to 90%.

<add key="GovernSoftware.WebReportViewerWidth" value="875" />

<add key="GovernSoftware.WebReportViewerHeight" value="1200" />

<add key="GovernSoftware.WebReportViewerZoomFactor" value="90" />

Note: Setting these parameters will affect the presentation of all embedded 
reports. As a result they should be altered with the understanding that 
it will be the standard size for all reports presented within the Web site 
that is controlled by the Web.config file. 
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Web Interface

This section describes the eProfile Web interface, as viewed by the user over 
the Web. The eProfile provides access to Govern’s eGovern – Public Self 
Service Portal, ePayment, ePermit, eComplaint, eGrievance, eRequest for 
Services, eRemittance, eRenewal, and to the ePortal. The eProfile also 
includes an administrative menu. This menu is visible to Administrators and 
Super Users only. It is used for granting personalized rights and for adding and 
removing access to properties and utility billing accounts, on a user-by-user 
basis. See Administration  on page 139.

In order to access the eProfile or the eComponents all users, including 
Administrators and Super Users, need an active account, a valid ID, and a 
password. This can be provided by an administrator or created by the user 
online, depending on the organization’s setup. See Update Your Profile  on 
page 138. 

eProfile Menus — An Overview

Depending upon your organizations needs, the Govern’s eProfile menu bar 
can contain the following menus:

• Home
• Online Services
• Your Profile
• Administration
• Links
• Sign Out

• Help?
• Français

Overview

Note: In this section are examples of menu structures and site layouts. The 
examples are in no way indicative of any limitations of the eGovern – 
Public Self Service Portal.
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Home

The Home menu provides a link to the Home or Welcome page of the 
principal site. See

Online Services

The Online Services menu displays one of the following, depending on the 
setup of your organization:

• Default eComponents, as selected on the eProfile tab in Govern NetAdmin 
(GNA)

• Personalized eComponents, created for the logged-in user through the 
User Account Information Web page

For details, see Web sites Editor - General tab  on page 27 and Account 
Information  on page 139.

Making an Online Payment

The Payment Online option provides access to Govern’s ePayment solution. 
For complete details on making payments online, refer to the ePayment 
section of this guide.
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Applying for a Permit

The Apply for a Permit option provides access to Govern’s ePermit solution. 
For complete details on applying for a permit online, refer to the ePermit 
section of this guide.

Filing a Complaint or Grievance or Submitting a Request 
for Services

The eGrievance, eComplaint and eRequest for Services options can be 
combined and accessed from a single menu option or displayed separately, 
depending on your setup in Govern Admin. See eProfile tab Parameters  on 
page 31.

Your Profile

The Your Profile menu provides access to your eProfile account information, 
as well as to the properties and utility billing accounts associated with your 
eProfile:

Update Your Profile

The Update Your Profile option would display a summary of your eProfile 
account, including your payment options.

Manage Your Properties

The Manage Your Properties option displays the properties in your eProfile 
account by tax map number and address. You can add and remove properties 
to and from your eProfile, provided you have the required access rights.

Manage Your Utility Billing Accounts

The Manage Your Utility Billing Accounts option displays the utility billing 
Accounts in your eProfile. You can add and remove accounts, provided you 
have the required access rights.
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Administration

The Administration menu provides access to your users eProfile account 
information, properties, utility billing accounts and access permissions.

Manage Users

The Manage Users option displays a search screen to retrieve the user 
eProfile that you want to modify.

Account Information

Account Information displays the user’s name and address, and eProfile 
account information. You can update the address, the password and the 
additional name and address information, from this page.

Access Rights

Access Rights displays access rights to the eProfile and the eComponents 
for the selected user. You can modify these rights, as required.

Manage Properties

Manage Properties displays the properties in the eProfile account of the 
selected user. You can add or remove properties to and from this list.

Note: This menu is available only to users with administrative or Super User 
rights.

Note: You need to select a user in order to enable the other options on the 
Administration menu,
© 2012 MS Govern Page 139



eGovern – Public Self 
Service Portal

FI
N

AL
 D

R
AF

T

Manage Utility Billing Accounts

Manage Utility Billing Accounts displays the utility billing accounts in the 
eProfile account of the selected user. You can add or remove accounts to and 
from this list.

Subscriber Setup

Subscriber Setup will allow you manage the users that are enrolled in a 
subscription plan.

Subscription - Plan Setup

Subscription - Plan Setup is used to create subscription plans that 
administrators can apply to user accounts.

Links

The Links menu provides access to the city home page, access to the ePortal 
home page, or eProfile log in page.

Sign Out

The Sign Out menu returns you to the Login page.
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Help?

The Help? link will display Help information associated with the page in pop-
up windows.

A Note about WebHelp

The text that is used to populate the popup Web Help screens are stored in 
resource files. 

Filename: GovernNetHelp.en.resources, and 
GovernNetHelp.fr.resources

Users are free to modify these files with the Resource File Editor in GNA. 
Whenever these files are modified, they should be backed up and stored in a 
safe location. A new installation will overwrite these files; they can then be 
restored from a recent backup.
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Resource File Locking and IIS

Français

The Français menu displays the Web pages in French. This can be changed 
to Español or another language. Up to four languages can be supported by 
the eProfile. 

Note: Users of Govern’s eGov should note that when the Internet Information 
Services (IIS)  is running, resource files cannot be maintained by the 
Resource File Editor. IIS locks the files making it inaccessible. In order 
to access the resource file, you must stop the IIS service. This can be 
performed through the Control Panel; Control Panel > Administrative 
Tools > Services > Internet Information Services (IIS) Manager.

Alternatively, administrators can make a copy of the Resource file, 
perform any required edits on the copied file, then stop the IIS Service, 
replace the file with the edited copy and restart the Service.
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First Time Users Creating Accounts
In the Account Creation process, a workflow has been initiated that reduces 
the number of steps involved in each of the processes that are opted for. This 
is done by providing options at the beginning of the process that then 
simplifies subsequent steps. For example, at the start of the account creation 
process, the online user is given the option to select how the system will 
proceed with the account creation process. For example, users with 
preexisting profiles in the system, will have the option to add properties or 
accounts to their profile. Users that are not known to the system will simply go 
through the registration process; once their account is created, they can then 
add properties or UB accounts.

Creating an Account

First time users are presented with the log in screen. To create a new 
account...

1. At the log in screen, click the “First-time user? Register here” option.

2. In the Account Creation screen, enter an Account Name; this name, 
account ID must be between 6 and 30 characters long and can only 
contain numbers (0-9) and alphabetic characters (a-z).

3. Create a password that conforms to the requirements; between 6 and 16 
characters long containing letters. Numeric characters and special 
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characters are allowed but optional. Allowed special characters are ! @ # 
$ % ^ & * ( ) _+ { }.

4. Enter an e-mail address.

5. The system will need to know how to identify a new user; click the “How 
can we identify you?” drop down menu to display the options.

There are multiple options available for first time users that are creating an 
account. The following are explanations of the available options.

The “How can we identify you?” parameter can be set with a default 
selection in Govern’s New Administrator (GNA). See Setting the Default 
Identification  on page 75 for configuration details.
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Account Creation options

Property Owner without an Account

When the option “I am not a property owner and I don’t have an account” 
is selected, the user will be able to create a new name, with the understanding 
that they have no information in the system.

Use an Account Associated with an Existing Name

For the “Use an Account associated with my name” scenario, the user will 
be required to enter their account number (this is associated with the 
na_names.account_no field)

Create Account Using Users Parcel ID (P_ID) Number

The “Use my Property Identification Number” method will ask for

• A partial name (a minimum of three (3) characters is required)
• A Last name (this parameter also requires at least of 3 characters) OR
• The company name (this also requires a minimum of 3 characters), if  a 

business and tax map are involved.

The search will validate the name with the Tax Map, if the person is the owner 
or occupant, and if they are in the Mailing Index

Create an Account Using Property Location Address

When “Use my Property Location address” is selected, this method will ask 
for the following:

• A partial first name (a minimum of three (3) characters must be entered)
• Last name (it requires at least of 3 characters) or the company name (it 

requires at least of 3 characters), if is a business and the address.

The search will validate the name versus the address (in the tables for Owner, 
Occupant and Mailing Index).

Create an Account using Users ST Account

The ''Use my ST Account” option requires the user to enter the complete 
Account Number (this is associated with the ST_MASTER.ACCOUNT_NO 
field)
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Use my Utility Billing Account

When the “Use my Utility Billing Account” option is selected, the following 
will be requested:

• First name of the user (a minimum of three (3) characters is required)
• Last name (3 characters minimum required) OR... 
• Company Name (a minimum of three (3) characters required), in the case 

of a Business and Utility Account Number.

The search will validate the Name with the Utility Account Number.

Example

I am not a property owner and I don’t have an account

If you select the option for I am not a property owner and I don’t have an 
account, you are presented with the Name Creation form. Complete the form 
and click Next.
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At the Account Creation confirmation screen, click Create Profile.

When the Account Creation process is complete, you will be at the main 
landing page. The next time that you log in with your username and password, 
this is the page that will be displayed.

It is also from this point that you can manage your account by adding 
properties and Utility Billing (UB) accounts.
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ePermit Admin
Planning your ePermit Setup

As with the standard permit setup, several of the ePermit parameters can be 
defined at more than one level. This section describes how each of these 
settings is applied, according to the level at which it is set. See  ePermit - 
Planning Your Setup  on page 149. 

Land Management Parameters

This section describes the ePermit parameters set at the organizational level, 
for all departments, through the Land Management Parameters form. See 
ePermit - Defining Parameters for the Organization  on page 161.

Permit Parameters

This section describes the ePermit parameters set at the departmental level, 
through the Permit Parameters form. See ePermit - Defining Parameters for 
the Department  on page 164.

Permit Type Maintenance

This section describes the ePermit parameters set at the permit type level, 
through the Permit Type Maintenance form. See ePermit - Defining Permit 
Type Parameters  on page 166.

Permit Activity Setup

This section describes the Permit Activity Setup. The setup is the same as the 
setup for the standard permit. This section is included for informational 
purposes. It is important to review the activities initiated through the ePermit 
application, to ensure that the application can be submitted. See ePermit - 
Defining the Activity Setup  on page 186.
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ePermit - Planning Your Setup

eComponents

Within Govern, there are modules that lend themselves to online access and 
manipulation. Govern eComponents are the modules that are configured for 
online use. The following eComponents are set up and maintained through 
Govern for Windows GovAdmin application:

• ePermit
• eLicense
• eComplaint
• eComplaint (Anonymous)
• eGrievance
• eRequest for Services

Refer to eComponent Item Kinds  on page 260 for a description of the 
eComponents.

The same Land Management forms, used in the standard permit setup, are 
completed with additional ePermit parameters. This guide describes these 
additional parameters. Refer to the Permits & Inspections reference guide for 
details on the standard permit setup.

The ePermit parameters are defined at four levels, from general to specific:

• the System level through the System Registry Maintenance form. Refer to 
the eProfile section of this guide for the required setup.

• the Organizational level through the Land Management Parameters 
form. See ePermit - Defining Parameters for the Organization  on 
page 161.

• the Departmental level through the Permit Parameters form. See ePermit 
- Defining Parameters for the Department  on page 164.

• the Permit Type level through the Permit Type Maintenance form. See 
ePermit - Defining Permit Type Parameters  on page 166.

Overview
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As with the standard permit setups, there are three ePermit parameters that 
can be defined at more than one level. This section describes how each of 
these settings is applied, according to the level at which it is set.

The ePermit parameters that can be defined at multiple levels are as follows:

• User ID for Web-generated System Activities: See  User ID for Web-
Generated System Activities  on page 150.

• Accept Secondary Permit Types: See  Accept Secondary Permit 
Types  on page 152.

• Accept Building / Unit Links: See  Accept Building / Unit Links  on 
page 156.

The applicable forms, for setting these parameters, listed from most general to 
most specific are, as follows:

User ID for Web-Generated System Activities

This parameter can be defined at two levels: the organizational level, on the 
Land Management Parameters form (2) - Parameters > Land Management > 

Note: Ensure that these parameters are properly defined for your 
configuration.

Form Level Priority

Land Management Parameters Organization Most Specific

Permit Parameters Department

Permit Type Maintenance Permit type Most General

The most specific level, at which the option is selected or defined 
overrides the other settings.
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Parameters..., or the departmental level, on the Permit Parameters form (1) - 
Maintain > Department:

Define the User ID for Web-Generated System Activities parameter to 
create a sender for the e-mail and interdepartmental notification messages 
generated through the Activities associated with the ePermit applications. In 
addition you will need to identify how to Complete / Initiate the Activity.

Interdepartmental Messages and E-mail messages

Interdepartmental notification messages are sent from the user, associated 
with this user ID. E-mail messages are sent from the e-mail address defined 
for this user on the User Maintenance form in Govern Admin. Refer to the 
Super User reference guide for details on the User Maintenance form. 

Define the user as follows:

• Enter the user ID on the Land Management Parameters form, to use the 
same sender for all messages sent from all users, from all departments, 
within the organization, or as a default address to be used by departments 
that have not defined another sender. 

• Enter the User ID on the Permit Parameters form, for the applicable 
departments, to create a sender for the users within the selected 
department, only.
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The user ID defined at the most specific level is used; i.e, if this parameter is 
defined at both levels, the address entered for the department overrides the 
one entered for the organization.

See  Interdepartmental User Notification and External Client E-mail 
messages  on page 190 for details on sending messages from activities 
generated through the ePermit applications.

Accept Secondary Permit Types

The Accept Secondary Permit Types option can be set at three levels: the 
organizational level, on the Land Management Parameters form (1), the 
departmental level, on the Permits Parameters form (2) or at the permit type 
level on the Permit Type Maintenance form (3):

Note: This parameter must be set at either the organizational or 
departmental level for all departments maintaining ePermits. 
Otherwise, the messages defined for the activities and activity steps 
are not sent.
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When this option is selected, Secondary Permit Types are displayed on the 
ePermit Web pages, as in the following screen shot.
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The user can then select secondary permit types, as required, for the primary 
permit type.

See  ePermit - Primary and Secondary Permit Types  on page 158 for details 
on secondary permit types.

This is equivalent to selecting the primary and secondary permit types in the 
Permit Type list box under the General tab of any Permit function in 
Govern.NET. The following screen shot displays a building permit with a 
primary and secondary permit types, in the Permit Type list .

Refer to any permit function in the User section of the Permits & Inspections 
guide for more information.

Linking Secondary Permit Types to an ePermit

To make secondary permit types available for an ePermit application, select 
the Accept Secondary Permit Types option. This option can be selected on 
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the Land Management Parameters, Permit Parameters or Permit Type 
Maintenance form. 

Land Management Parameters: If the option is selected on the Land 
Management Parameters form, secondary permit types are available for all 
permit types, regardless of whether or not it is selected on the Permit 
Parameters and Permit Type Maintenance forms.

Permit Parameters: If the option is selected on the Permit Parameters form 
secondary permit types are available for the permit type, even if it is 
deselected on the Permit Type Maintenance form.

Permit Type Maintenance: If the Accept Secondary Permit Types option 
is selected on the Permit Type Maintenance form, secondary permit types are 
available for the permit type, regardless of whether or not the option is 
selected on the Permit Parameters and Land Management Parameters forms.

Setup Procedure

Set this option as follows, depending on how you want use secondary permit 
types: 

1. To use Primary Permit Types only, deselect this option on all forms.

2. To accept Secondary Permit Types for some departments but not all, 
maintain this option from the Permit Parameters form:
• Deselect this option on the Land Management Parameters form.
• Select this option for the applicable departments on the Permit 

Parameters form.
• Deselect this option for the other departments.
• Deselect this option for the permit types on the Permit Type 

Maintenance form.

3. To accept Secondary Permit Types for some permit types but not all, 
maintain this option from the Permit Type Maintenance form:
• Deselect this option on the Land Management Parameters form.
• Deselect this option on the Permit Parameters form.
• Select this option for the applicable permit types on the Permit Type 

Maintenance form.

The most specific level, at which the option is selected overrides the 
other settings.
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• Deselect this option for all other the permit types on the Permit Type 
Maintenance form.

4. To make Secondary Permit Types available for all permit types, maintain 
this option on the Land Management Parameters form:
• Select this option on the Land Management Parameters form.
• Deselect it on the other forms.

Accept Building / Unit Links

Like the Accept Secondary Permit Types option, this parameter can be 
defined at the organizational level, on the Land Management Parameters form 
(1), the departmental level, on the Permits Parameters form (2) or at the 
permit type level on the Permit Type Maintenance form (3):

Tip: If you want to accept Secondary Permit Types for some permit types but 
not all, maintain this setting from the Permit Type Maintenance form and 
leave the option deselected on the other forms.
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This option is used to link specific buildings or building units to a permit. It 
performs the same function as linking buildings or units from the Links tab on 
a Permit function in Govern.

Select this option if you want to grant the applicant the right to link buildings or 
units to a permit type on the ePermit Web page, as in the following screen 
shot:

.

Refer to any of the permit functions in the User section of the Permits & 
Inspections reference guide for further information.

Note: The same setup applies to the Building / Unit Links as to the 
Secondary Permit Types option.
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ePermit - Primary and Secondary Permit 
Types

Every permit must include a Primary Permit Type and may include one or 
several Secondary Permit Types. 

Secondary permit types are linked to the primary permit type, when both types 
apply to the same property and share other information and requirements. For 
example, a property owner applies for a permit to build a swimming pool with a 
storage shed and surrounding fence. You can create a single permit 
application, with the swimming pool defined as the Primary Permit Type and 
the fence and storage shed defined as Secondary Permit Types, rather than 
creating three separate applications.

The use of secondary permit types is not applicable to every project. For 
example, if both a swimming pool and stable are to be built, it is better to 
create two separate permits. Although the property and the property owner 
may be the same, the building requirements, inspections, licenses, and time to 
completion are completely different.

Linking Primary Permit Types to an ePermit

The Primary Permit Type is used as a reference for the permit. The following 
rules apply:

1. Activity Steps: Only the Activity Steps associated with the primary permit 
type are executed. See  ePermit - Defining the Activity Setup  on 
page 186.

2. Sequence Numbers: If sequence numbers are defined by permit type on 
the Permit Type Maintenance form, those that are defined for the primary 
permit type are used.

Alternatively, sequence numbers can be defined at the organizational or 
departmental levels, through the Land Management Parameters or Permit 
Parameters forms.

Overview
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Refer to the Permits & Inspections guide for details.

3. User-Added Columns: Added columns are included for both the primary 
and secondary permit types.

In Govern, if the same field is used for both, a drop-down list appears on 
the Forms tab of the Permit function. To view the value entered for each 
permit type, the user needs to select the type from the drop-down list:

On the Web, the values of the user-added fields are displayed separately 
on the Summary page of the ePermit application, under the headings 
Primary Type Information and Secondary Type Information. For details on 
creating user-added columns for the ePermits, see  User Added Columns 
for the ePermit Types  on page 182.
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4. Names: Name types are included for both the primary and secondary 
permit types. The Name Types are selected on the Permit Type 
Maintenance form. For details, see  Name Types  on page 174.

5. Fees: See  ePermit - Defining Fees for the Application  on page 192, for 
complete details.
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ePermit - Defining Parameters for the 
Organization

ePermit parameters for the organization are defined on the Land Management 
Parameters form.

To access the Land Management Parameters form, from Govern’s main 
screen, select Tools > System Administration (Govadm32.exe)

OR

Click Application in the Side Navigation Bar to display the application, click 
System Administration

In System Administration select Parameters > Land Management > 
Parameters. Then select the eGovernment tab to access the parameters for 
the ePermit pages.

Overview
© 2012 MS Govern Page 161



eGovern – Public Self 
Service Portal

FI
N

AL
 D

R
AF

T

Department to be used on the Web: This parameter is reserved for 
future use.

UserID for Web-generated System Activities: Make a selection from 
the drop down menu to indicate the User ID that will be used when Web based 
System Activities are initiated or completed. See User ID for Web-Generated 
System Activities  on page 150 for details.

Accept Secondary Permit Types: When this option is selected, 
Secondary Permit Types are displayed on the ePermit Web pages. See 
Accept Secondary Permit Types  on page 152 for additional details.

Accept Building / Unit Links: This option is used to link specific buildings 
or building units to a permit. It performs the same function as linking buildings 
or units from the Links tab on a Permit function in Govern. Select this option to 
grant the applicant the right to link buildings or units to a permit type on the 
ePermit Web page.

Display Department / Function: These options control how the permit 
types, both primary and secondary, are displayed on the Web.

• Select None to display the permit types, by name only, without the 
department or function, as in the following screen shot.

• Select Department to display the department, where the permit types are 
maintained with the name.

• Select Department / Function to display the department and function with 
the name of the permit type.
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.Click Save to save your ePermit settings. Refer to the 
Permits & Inspections guide for full details on the Land 
Management Parameters form.

Note: The function is equivalent to the Permit Kind; i.e., Building Permit, 
Electrical Permit, General Permit, Plumbing Permit, Permit to Name, 
Animal License, Business License, License to Name, Approval, Bond, 
Decision, Prosecution or Appeal (Table: VT_SY_ PMKIND1) and to 
the Workflow Kind; i.e., complaint, Grievance, Request for Services or 
Workflow (Table: VT_SY_ PMKIND2)

Note: The Display Department / Function is selected only at the 
organizational level, on the Land Management Parameters
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ePermit - Defining Parameters for the 
Department

ePermit parameters for the department are defined on the Permit Parameters 
form.

To access the Permit Parameters form, from Govern’s main screen, select 
Tools > System Administration (Govadm32.exe)

OR

Click Applications in the Side Navigation Bar to display the application, click 
System Administration

In System Administration...

1. Select Parameters > Land Management > Parameters. 

2. Click to select a department from the List of Departments column; select 
Maintain > Department.

3. Select the eGovernment tab to define the ePermit parameters.

Overview
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Provide Web Access to this Department: Select this option to provide 
Web access to the permit types, defined by the current department. Once 
selected, all other options are enabled.

User ID for Web-generated System Activities: For a definition of this 
option, see User ID for Web-Generated System Activities  on page 150.

Accept Secondary Permit Types: For a definition of this option, see 
Accept Secondary Permit Types  on page 152.

Accept Building / Unit Links: For a definition of this option, see Accept 
Building / Unit Links  on page 156.

Permit Parameters Command Buttons

Select Save to save your ePermit settings. Refer to the Permits & Inspections 
guide for full details on the Permit Parameters form.

Note: The current department is displayed in the Department text box at the 
top of the form.
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ePermit - Defining Permit Type 
Parameters

In addition to the standard permit type parameters, you need to define the 
following information, on the Permit Type Maintenance form, for each permit 
type that you are making available over the Web. This includes the secondary 
permit types, as well as the primary permit types:

• Name Types
• Property Types
• Multimedia Codes and Sub-codes
• User Added Columns

If the following options are not defined at the organizational or departmental 
level, they need to be defined for the permit type. This is in reference to the 
Govern hierarchy of Organization > Department > Permit, wherein at this level 
the options can be overridden at the Department, or Organization level.

See ePermit - Planning Your Setup  on page 149 for more information on 
these options.

• Accept Secondary Permit Types
• Accept Building / Unit Links

The Property Link option is defined by permit type only.

• Accept Property Links

To access the Permit Type Maintenance form:

1. In Govern Admin, select Parameters > Land Management > Parameters.

2. Highlight the applicable department in the Departments list box.

3. Select Maintain > Definition of Type > Permits.

4. Select the eComponents tab.

5. Navigate to the first permit type to which you are providing Web access.

Overview
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To create a new permit type, for the Web, follow the procedures described in 
the Permit Type Maintenance section of the Permits & Inspections guide. 
Then, define the ePermit parameters, as described in this guide.

There are four types of ePermit parameters that need to be defined on the 
eComponents tab.

• General eComponent Permit Type Parameters
• Property Types
• Name Types
• Contractor’s License Restrictions
• Multimedia Codes and Sub-codes
• eSearch
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In addition, you need to open the General tab and select the Permit Kinds. 
See Permit Kinds  on page 181.

You can add a full description to the VT_USR_PMTYP table, where the permit 
types are saved. Add the description through the Validation Table Header 
Setup form in Govern Admin. Refer to the Super User guide for details on 
creating validation tables and codes.

On the eComponent Web pages. The full description appears as a link beside 
the Primary Application Type. The user selects the link to display a description 
of the permit type.

Note: The parameters selected on the eComponents tab affect the ePermit 
types on the Web only. If the same permit types are used in the 
standard Govern applications, they are unaffected by the selections 
made on this tab.

Note: The Full Description link appears only if a full description exists for 
the permit type.
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General eComponent Permit Type Parameters

Add this Type to the eComponents Web Pages: Select this option to 
provide Web access to the current permit type and to enable the other ePermit 
parameters. The permit type will be added to both the Permit Type and 
Secondary Permit Type drop-down lists, on the General Information page of 
the ePermit application.

Accept Secondary Permit Types: For a definition of this option, see 
Accept Secondary Permit Types  on page 152.

Accept Building / Units Links: For a definition of this option, see Accept 
Building / Unit Links  on page 156.

Accept Property LInks: Select the Property Links option for the permit 
types that are applicable to more than one property; for example, a fence that 
is shared by two or more properties or a road that is shared by several 
properties. Otherwise, deselect this option.

Restrict Permit Types to Contractors and 
Homeowners

The convenience of applying for a license online is not without its drawbacks. 
There will be occasions when it will be necessary to ensure that individuals 
that are applying for permits are indeed qualified to request the permit type. 

There is an option that allows the eProfile name to be used to determine if the 
person applying for a permit is the owner, or a licensed contractor. Govern is 
able to do this because each eProfile name is linked to the NA_NAMES table, 
and therefore can determine if it is linked to a License to an Individual, Permit 
to an Individual, or the Owner of the property. If the name is linked to a License 
to an Individual, the system will check the type of individual license, and 
whether the license has expired. If the license type matches the permit type, 
and has not expired, then the user can proceed with the application process 
for the Permit. If the users license type does not match the permit, they would 
not be allowed to apply for the permit.

Note: The Accept Property Links option is available only by permit type, on 
the Permit Type Maintenance form.
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In certain circumstances, homeowners can also apply for the same type of 
permits as a contractor, e.g. Plumbing permit. An option also exists for these 
type of permits. The eProfile is checked to see if the user is also the 
homeowner, if that is the case, they are also allowed to apply.

Configuration options to restrict permit types to contractors and homeowners 
on the eComponents tab (A) of the Permit Type Maintenance screen in 
Govern Admin.

Use Contractor’s Restriction: When the Use Contractor's Restrictions (1) 
option is selected, selected permit types are restricted to contractors. 

Restriction Doesn’t Apply to Homeowners: When the Restriction 
doesn't apply to Homeowner option (2) is checked then certain selected permit 
types that are restricted to contractors will be available to homeowners. In 
addition, restrictions won’t apply if the current eProfile is the owner of the 
property. 
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Contractors License Restrictions

The Contractor’s License Restriction (A) drop down menu will become active 
only when the Use Contractor’s Restrictions option is selected. When active, 
the drop down menu will contain a list of all permit types having the type 
License to Name or Permit to Name.

To configure the option in Govern Admin...

1. Select Parameters > Land Management > Parameters...

2. Click to select a department from the Department List, e.g. Building 
Department.

3. Under the menu, select Maintain > Definition of Type > Permits...

4. In the Permit Type maintenance for, click to select the eComponents tab.

Note: The system does not filter by department because contractor licenses 
can be issued by different departments.
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5. Click Browse to select the permit type that an application can be made for; 
click to select the eComponents tab (A).

6. Enable the contractors restriction option by selecting the Use 
Contractor’s Restriction option (1).

7. In the Contractor’s License Restrictions group (B), click to select the 
licenses that are to be restricted to contractors; multiple selections (2) can 
be added to the list, or, select a license and click R (3) to remove it from 
the list.

Note: When a selection is added to the list, it will no longer be available in 
the drop down menu, until it has been removed.
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8. If a homeowner can also apply for this permit, select the Restriction 
doesn’t apply to homeowners option (4); this will allow a homeowner to 
also apply for the permit type.

9. Click Save to save the options.

Property Types

If the ePermit type is applicable to certain property types, only, select those 
property types, from the Restricted to the following property types drop-
down list. For example, the permit type may be applicable to commercial and 
industrial properties but not residential.

R: To remove a property type, highlight it in the list box and click R.

Property Types are used for classifying properties, according to use; for 
example, residential, commercial or mixed use. They can be used as a basis 
in creating models for property assessments and appraisals.

Govern provides the following property types in the validation user table, VT_ 
USR _PROPTYPE:

Note: If the ePermit type is applicable to all property types, you can leave 
this list box blank.

Code Description

0 Mixed Use

1 Residential

2 Open Space

3 Commercial

4 Industrial

9 Exempt
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The codes for these property types are reserved. You can add other property 
types using other codes but it is important not to change the codes provided 
by Govern, since they are used internally. 

Name Types

Names Types: Select all the name types that can be applied to the current 
permit type, from the Name Types drop-down list.

Required: If a name type is required for the permit type, highlight it in the list 
and click Required. In order for the ePermit application to be completed, all 
required name types must be entered. If the user does not enter a required 
name type, a message appears:

Other name types may be added but are not mandatory for the permit 
application.

R: To remove a name type from the ePermit permit type, highlight it in the list 
box and click R.

Name Types are used for classifying individuals and companies, according to 
their role in the permit process, for example, permit applicant or property 
inspector. 

Govern provides the following name types in the validation user table, VT_ 
USR _ PMNAME:

Tip: To create other codes of the same type, name the code with the same 
initial digit; for example, different Residential types can be assigned the 
codes 10, 11, 12, 13, 14, etc.; where in the case of 10, Residential is the 
principal type and Mixed Use, is the secondary type.

Note: For the ePermit permit types, you need to define both the optional and 
required name types.

Code Description

appl Applicant
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Like the property types, the codes for the name types are reserved. You can 
add other name types but it is important to keep the codes provided by 
Govern.

Defining Name Types

In Govern, when a user creates a standard permit, the following name types 
are automatically added if the corresponding options are selected on the 
Permit Parameters form, in Govern Admin.

• The property owner is automatically listed as an Owner if Automatically 
Assign Owner is selected.

• The property owner is also automatically listed as the Applicant if 
Automatically Assign Applicant is selected.

• The inspector is assigned, according to availability and Inspection Territory 
if Automatically Assign Inspector is selected (Tables: PC_AREA and 
PM_INSPECTORS)

On the Web, the applicant is automatically created from the user profile of the 
person completing the ePermit application. 

Select the Applicant name type so that the user can select a different applicant 
from the Web page, when completing the application. Otherwise, you do not 
need to select this option.

Multimedia Codes: Select the Multimedia Codes that apply to the permit 
type, from the drop-down list (Table: VT_USR_ DEPINF).

R: To remove a multimedia code, highlight it in the list box and click R.

Required: If a multimedia code is required for the permit type, highlight it in 
the list and click Required.

contact Primary Contact

insp Primary Inspector

owner Owner

However, for the ePermit application, these options are not applicable. 
The Name Types need to be defined for each ePermit permit type. 

Code Description
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Sub-code: Select the Multimedia Sub-codes that apply to the multimedia 
code (Table: VT_USR_<table name>, where table name is the name of the 
multimedia sub-code table, as entered on the Multimedia Code Maintenance 
form in Govern Admin). 

Search Styles and Groups

Select either a Search Style or Style Group from one of the drop-down lists:

Style: Select a Search Style from the drop-down list. The search styles are 
user-defined and are created through the Web Search Configuration Toolkit. A 
Search Style launches an SQL query. It is linked to all the Objects that appear 
on the Search page, including the search criteria and labels, of the ePermit 
application.

Group: Select a Group from the drop-down list. Like the search styles, the 
groups are user-defined and are created through the Web Search 
Configuration Toolkit. A group launches a series of search styles.

For details about Search Styles and groups, refer to the Dynamic Search Style 
Management section of the Govern System Configuration Administrator 
(SCA) release 5.0 guide.

Search Style Long Descriptions displayed on Web

In releases prior to 4.5.3 of the eGovern - Public Self Service Portal and 
release 4.5.3.1 of the Web User Interface, the Web site would only display the 
value entered in the Short Description field of the Dynamic Search Style 

Note: To select a multimedia sub-code, you need to highlight the applicable 
multimedia code. This enables the Sub-code drop-down list.

Note: It is necessary to specify Search Styles and or Groups.

Note: You can assign either a Search Style or Search Group to a menu item, 
not both.
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form. Users of release 4.7 and greater will note that the value entered in the 
English Long Description field is now used. 

Users of release 4.5.3 of the eGovern - Public Self Service Portal and 4.5.3.31 
of the Web User Interface can update their functionality to display the name 
entered in the English Long Description field by performing the following 
procedure...

To perform the update...

1. Download WebUserInterface 4.5.3.31from the MS Govern FTP site.

2. Replace the existing WebUserInterface folders and files with the new 
version.

3. From your backup location of your WebUserInterface folder, locate the 
web.config, and the styles.css files and copy them to the overwritten 
folder.

4. Open your web.config file using a text editor like Notepad or Notepad++.

Note: The following steps are intended for users with release 4.5.3 of the 
eGovern - Public Self Service Portal , and release 4.5.3.31 of the Web 
User Interface. Verify your installed release version before updating.

WARNING: Prior to performing the following, make a back up copy of your 
WebUserInterface folder, specifically the following two (2) files 
Web.config and Styles.css. These two files will be overwritten 
and will need to be replaced with your original copies.
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5. In <appsettings> section, paste the following line...
<add key="GovernSoftware.DescriptionType" value="Long"/>

6.  Save the change.

After the update, users will note that the name entered in the Long Description 
field of the Dynamic Search Styles form is now displayed on the Web site 
description. 

TIP: Modifying AppSetting section of Web.config file

When editing is required in the <appSettings> section of the Web.config file, 
features of the IIS Manager allow you to make modifications to the file with 
minimum interaction with other parameters. Insertion of new parameters and 
modifications to existing parameters can be made with relative ease. For 
example, to make the modification described in step 5 above:

Note: After performing the above modification, there is no need to perform 
an IIS reset. 
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1. In the Internet Information Services (IIS) Manager, locate the Website that 
is to be modified (A). 

2. Locate the Features View tab in the center pane and ensure that it is 
selected (1).

3. In the center pane, double click on the Application Settings icon (2).

4. Place your pointer in the middle of the pane and right click to display a 
floating menu; select Add...
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5. In the Add Application Setting form, enter the following into the Name: 
parameter, GovernSoftware.DescriptionType, and Long in the Value: 
parameter. 

6. Click OK to enter the new parameters.

Note: When entering parameter values, ensure that no additional spaces or 
characters are added. The new entries can be viewed by loading the 
Web.config file into a text editor.
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Dynamic Search Screen Interface

In the display, when a user is logged in under an eProfile, when a Dynamic 
Search is used to retrieve a Name ID (NA_ID), the eProfile Name ID (NA_ID) 
is displayed. Previously when a Dynamic Search is used to retrieve a Parcel 
ID (P_ID), the system would also show a list of parcels that are attached to the 
current eProfile account.

Permit Kinds

The Permit Kinds are defined by Govern and are used to classify permits, 
according to general purpose, such as building or electrical permit. The Permit 
Types are more specific categories and are user-defined. In Govern, they are 
selected for the permit kind. However, a permit type can be applicable to more 
than one permit kind. For example, a commercial additional can be applicable 
to a building permit, general permit, electrical or plumbing permit. Permit Kinds 
are not specific to the eGov. Refer to the Permits & Inspections guide for full 
details on the Permit Type Maintenance form.
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User Added Columns for the ePermit Types

Click Columns to add fields or columns to the eComponent 
Web pages. This is equivalent to adding columns to the 
Dimensions or Forms tab in Govern.

You need to define the display order and access right properties for the added 
columns, using field setup mode in Govern, as follows:

1. Launch Govern for Windows.

2. Open the applicable function for the permit type.

3. Select the permit type on the General tab.

4. Open the Dimensions or Forms tab.

5. Select Setup > Field Setup Mode.

6. Double-click in an added field.

Note: The added columns are applicable to the selected permit type only. 
They are the same for both the standard permit and the ePermit
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The Tab, Width, Minimum and Maximum fields apply to the Govern 
application only, the Validation table, applies to both Govern and the Web. 
Refer to the Permits and Inspections guide for full details.

The Column Name field displays the column corresponding to the 
selected column.

7. Enter the Display Order under eComponents. This is the order that the 
field is displayed on the Web page. This applies to the customized fields 
only. All the standard fields are displayed first, on the page.

Note: The Allow Modification, and Update Access Level parameters are 
for future use; there is no effect if these parameters are selected.
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8. Select the lowest access level, at which you want to display the field, from 
the Display Access Level list: Refer to Priority of Access Level below for 
details about priority.
• Intranet Admin
• Intranet User
• Internet Subscriber
• Internet with Profile
• Internet without Profile

9. Select the lowest access level at which users can update the selected 
column.

10. Click OK on the Field Setup form.

11. Repeat steps 6 to 10 for each added field.

12. Save the function in Govern.

Priority of Access Level

Higher access levels have automatic access. For example, if you select 
Internet with Profile, the Internet Subscriber is also able to see the field. 
However, the field is not displayed to a user with Internet without Profile 
access rights.

Below is a list of the Internet/Intranet access level.

Priority 
Level

Binary Reference 
for Crystal Reports

Details

1 
(Highest)

16 Intranet Admin - Set this security level 
to make this menu accessible to 
Administrators within the organization.

2 8 Intranet User - This is the Security level 
for a user within the organization.

3 4 Internet Subscriber - When selected, 
the security level is set to that of a 
subscriber.
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4 2 Internet with Profile - This menu 
selection will be accessible by internet 
users with a saved profile, i.e. only 
internet users with a profile will be able 
to see this menu.

5

(Lowest)

1 Internet without Profile - This menu 
selection will be accessible by internet 
users with no saved profile, i.e. all 
internet users will be able to see this 
menu.

Priority 
Level

Binary Reference 
for Crystal Reports

Details
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ePermit - Defining the Activity Setup

For each permit type, you need to create Activity Steps and then link the steps 
together to create an Activities Setup. An Activity Step represents a stage in 
the permit process; for example, application, review, inspection or certification. 
The Activities Setup represents the process. Each Activity Step can include 
one or several System Activities. For example, for the review step, you can 
include the plan, zoning, building and site reviews. Each system activity can 
generate a number of actions, including inspections, business rules, e-mails 
and interdepartmental notifications. Each activity step can also generate 
e-mails, interdepartmental notifications, the next activity step and a fee.

To open the Activities Setup form, from Govern’s main screen, select Tools > 
System Administration (Govadm32.exe) 

OR

Click Applications in the Side Navigation Bar to display the application, click 
System Administration.

In the System Administration:

1. Select Parameters > Land Management > Parameters. 

2. Next, highlight the Department and select Maintain > Definition of Type > 
Permits > Activity Steps.

Overview
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There are no additional ePermit parameters for the Activities Setup. This 
setup is the same as for the standard permit. There are, however, some 
differences in how the Activities Setup, System Activities, Fees, E-mails and 
User Notification messages are handled internally.

Activities Setup

For an ePermit application, a validation is performed on the Activities Setup, 
by following the default order of activity steps. The default order is defined 
according to the Default Answer defined for the Next Step Number For field:

It is recommended to review the Activities Setup for all the permit types to 
which you are providing Web access.

Note: In this section of the guide, the screen shots and descriptions refer to 
the Activities Setup for the Permit Types. The Activity Setup forms for 
the Offense and Workflow Types are the same, except that the Fee 
Method and Status fields are not included. Refer to the Permits & 
Inspections guide for further information.
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If, by following the default order, an endless loop is created; for example, if 
from Step 100, the default for the next step is 200, then 300, then 400, then 
back to 100, there can be no end to the activities. In this case, the ePermit 
application terminates, a message is displayed to the Web applicant and an 
email message is sent to the Webmaster.

In Govern for Windows, the default order is displayed on the Activities 
function. No validation is made. If there is an endless loop, the activity steps 
continue to be added until the user closes the function.
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The Activities Setup is otherwise executed for an ePermit application, exactly 
as it is for a standard permit application. 

System Activities

Each activity step includes one or several System Activities. With the following 
exceptions and notes, the activities are executed for the ePermit application 
exactly as they are for a standard permit application.

Multimedia Codes

If a multimedia code is required for an Activity that is initiated by the ePermit 
application, an empty record is created for that code. This entry needs to be 
completed in Govern, once the application is submitted.

New Permit, Offense or Workflow Generation

If a new permit, offense or workflow process is generated through an activity, 
associated with the ePermit application, the first activity step for the new 
process is not automatically initialized. It needs to be started manually. This 
rule also applies to the new permit, offense or workflow processes, generated 
through an activity associated with a standard permit.

Business Rules

If a business rule, associated with an activity initiated through the ePermit 
application, is not valid, the application cannot be submitted.

Similarly, in Govern, if a business rule associated with an activity is not valid, 
the permit cannot be saved.

Fees

For details on how fees are applied to the ePermit application, see ePermit - 
Defining Fees for the Application  on page 192.

Note: Only the business rules defined for the Activities that are linked to the 
Primary Permit Type, through the Activity Setup form, are executed.
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Interdepartmental User Notification and External Client 
E-mail messages

If an interdepartmental message or external e-mail is associated with an 
activity or activity step, generated by the ePermit application, it is sent from the 
user defined in the User ID for Web-generated System Activities field on 
either the Land Management or Permit Parameters form. See User ID for 
Web-Generated System Activities  on page 150 for details.

E-mail messages can be created and associated with an Activity or Activity 
Step through the Notify Client by E-mail form, in Govern Admin. These are 
sent through the server using the SMTP Parameters defined on the System 
Registry Maintenance form. For example, you can set up an e-mail to be 
automatically generated and sent to the contractor and building owner on 
completion of an activity called, Application Accepted. If the activity or activity 
step is initiated through the ePermit application, the e-mail is sent from the 
user defined by this parameter, using the e-mail address defined for the user 
on the User Maintenance form.

Similarly, user notification messages can be created and associated with an 
Activity or Activity Step through the Notify User form, in Govern Admin. If the 
activity or activity step is initiated through the ePermit application, the 
message is sent from the user defined by this parameter. The default 
department of the user is also included if one has been defined on the User 
Maintenance form. For example, you can send a message to notify the users, 
in a department, that a permit application has been accepted and to provide 
them with the information they need to complete the next activity step.

The message is sent to all the individuals and companies linked to the ePermit 
application. However, if the following fields are defined for the message, 
through Govern Admin, they are ignored if the activity is generated through the 
ePermit:

• Dynamically Modify User List
• Dynamically Modify Message
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Otherwise, the System Activities are generated for an ePermit exactly as they 
are for a standard permit application. This includes the generation of:

• Automatically scheduled inspections or hearings
• Unscheduled inspections
• Time cost codes
• Report generation
• Permit starting and expiration dates
• External client e-mails

Refer to the Permits & Inspections guide for further details on e-mail and user 
notification messages.
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ePermit - Defining Fees for the 
Application

Fees are defined on the Activities Setup form, in Govern Admin, and are 
applied to the ePermit, when the activity step is executed, in Govern or from 
the Web.

These fees are calculated and displayed on the Final Summary page of the 
ePermit application, beside the heading Total Estimated Fees:

This calculation is made by calculating the fees associated with the Default 
Activity Steps for the ePermit, according to the rules described in this section.

Overview

Note: Fee Displayed = Fee of Default Workflow + Fee of first activity 
only (if fee is configured)
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A Default Activity Step is a step entered in the Default Answer For parameter 
of the Activity Setup form, associated with the ePermit.

Applying an Application Fee to an ePermit

You can link a fee to the ePermit, to be paid when the application is made.

To set up this type of fee:

1. Launch the Activities Setup — Permit form, in Govern Admin.

2. Scroll to or create an activity for the acceptance of the application.

3. Enter the fee in the Fee Amount text box or select a Fee Method, from the 
Method drop-down list.

4. Select Initiation, from the Initiate at drop-down list.
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The amount is displayed on the Final Summary page beside the title Fee 
Charged at Application Creation. This fee needs to be paid immediately. 
Otherwise, the application cannot be submitted.

Rules for Applying Fees to an ePermit

All fees associated with the Primary Permit Type are charged. See Rules for 
Applying Fees According to Fee Type  on page 196. The fees associated with 
the Secondary Permit Type are charged, according to the Activity Step 
Number and the Type of Fee:

Rules for Applying Fees According to Step Number

A fee linked to a Secondary Permit Type is charged only if the Activity Step 
that it is linked to is assigned the same Step Number as an activity step 
associated with the primary permit type. Otherwise, the fees associated with a 
secondary permit type are not charged.  

Note: This rule is applicable only if the fee is to be charged at the Initiation of 
the activity.

Note: The Activity Steps do not need to be the same, they just need to be 
assigned the same Step Number.
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For example, if a fee is associated with Step Number 100 in the Activity 
Setup of the Secondary Permit Type and the Activity Setup of the Primary 
Permit Type also includes an activity step with a Step Number 100, the 
fee for the Secondary Permit Type is charged, even if the Activity Steps 
are different.

Condition
Primary 
Permit Type

Secondary 
Permit Type 
A

Secondary 
Permit Type 
B

Total Fee for 
Activity 
Step

Activity Step 
Number

100 100 200

Fee $40.00 $25.00 $30.00

Fee Charged $40.00 $25.00 Not charged $65.00
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Rules for Applying Fees According to Fee Type

Two types of fees can be defined on the Activity Setup — Permit form and 
linked to a permit type, Fixed Amount and Fee Methods. Critical to the eGov 
user are any fees that are set at the initialization of the first activity. 

Refer to the Fee Computation Setup section of the Permits & Inspections 
guide for further details on Fee Methods.
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ePermit - eRenewal process
One of the features of the eGovern – Public Self Service Portal is eRenewal. 
With eRenewal, Municipalities can offer the option for users to renew specified 
permit types through an online process. eRenewal can be configured for any 
Govern activity step that allows renewal.

Configuring eRenewal

The following example is based upon a preexisting Workflow that generates a 
Business License.

STEP 1 - Select a Renewal Process

To configure eRenewal, we will use a renewal process for a Business License. 
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When we Browse the activity steps, we see a renewal step (25) with an 
associated fee method, i.e. a Business License fee (BLFee).

At activity Step 25, the license renewal step, the Method is set to Business 
License Fee, and the Initiate at field is set to Completion Status 1. 
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STEP 2 - Set the Renewal Period

In the Permit Systems Activities screen, under the Page 2 tab, the Expiration 
group is configured. The License is set to expire in 1 year, and the Initiate at 
parameter is set to Completion Status 1.

STEP 3 - Set the Response

Next click the Page 4 tab; in the eRenewal group, select the Allow eRenewal 
option. At this point you will also need to specify the response that is sent to 
the activity so that the process will continue. In this case it will be the 
Completion of Status 1. Set the Response parameter to Completion Status1.
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STEP 4 - Verification in Activities Function

In Govern for Windows, the Business License is ready for renewal. We can 
launch the Activities function for verfication

Looking at the Activities function, we see that we are at step 25, Renew 
License.
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Initiating the eRenewal

When the activity step is ready for Renewal the eComponent is ready for 
input. The logged in user can select Online Services > eRenewal.

The eRenewal Application form is presented and we see the Business 
License renewal; the entry is selected (A)..
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When the item is selected, the renewal form is to be completed; the 
associated fees are indicated.

At the next step, relevant multimedia documents can be attached to the 
record.
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In the final step the eRenewal process is summarized and ready for 
settlement. Payment can be effected through ePayment.                                                                                                                                                                                                                                                                  

After settlement, when looking at the activities function in Govern for 
Windows, the completed activity step will be seen.
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eRenewal Confirmation

An additional notification of completion is sent to the user in the form of an 
email confirmation message.
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ePayment - Setting the Web Parameters

The ePayment tab is used for configuring and maintaining the default 
parameters for the ePayment data.

To access the form in GNA...

1. Select Setup > Web Configuration > Manage Web Sites...

2. In Web Sites form, click to select the ePayment tab (A)

Web Sites Manager Command Buttons

Menu Setup: Click Menu Setup to open the Web Site Menu editor and 
create and edit your site menus. See Defining the Web site Menus  on 
page 35 for details.

Web Skin Preview: Click WebSkin Preview to display a preview of your 
web skin in a window.

Overview

Note: Web ePayments parameters are in the Govern NetAdmin (GNA). See 
Web Site Manager  on page 64 for details of related parameters.
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New: Click New to create a new Web site.

Save: Click Save to save your new Web site, or any changes that have been 
made to an existing site.

Delete: Select an existing Web site from the Web Sites list on the left hand 
side, click Delete to delete the site.

Closing the Editor

To close the editor, click the Close Window button in the upper right hand 
corner of the form.

Note: When you click on New, the button changes to Cancel; this will allow 
you to cancel the creation of the current record. The Cancel button is 
present until the new record is saved.
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Web Sites Manager ePayments tab

The Web ePayment Parameters form is used for setting and maintaining the 
default parameters for the ePayment data.

Web Site Manager - ePayment tab Parameters

Live Mode: The MS Govern ePayment (A) sub-system can be used in two 
modes: Live Mode, and Test Mode (default mode). Test Mode allows you to 
perform simulations on the system with credit card providers in “test mode”.  
When the Live Mode option is selected, the sites are to be live on the internet. 
Select this option to run the Web site in a live environment.

User Confirmation Required: Select this option to display a confirmation 
of transaction prompt when an online transaction is initiated by a user. When 
not selected, transactions will be completed without a confirmation.

Minimum Payment Amount: Enter the minimum amount that can be 
accepted for an ePayment, in dollars and cents. If the user enters an amount 
that is less than the minimum payment value specified in this field, an error 
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message is displayed. The user will need to correct this amount in order to 
complete the ePayment transaction.

Cashier ID: Enter a prefix for the cashier ID; this ID is comprised of this 
prefix followed by the effective date.

Display X Previous Payor: In this parameter “X” represents the number of 
previous payers that will be displayed in the list.

Receipt Prefix: Enter the sequence that will be used as a receipt prefix. It 
consists of a maximum of three characters and is used as a prefix for receipt 
numbers (Table: USR_KEY_ RECEIPT)

Business End Day: Enter the 
end of the business day, in hours 
and minutes. This parameter is used 
for calculating interest and penalty 
charges. Charges on payments 
accepted after this time will be 
calculated as of the next business 
day. As an example, if you enter 
4:00 P.M., depending on the 
Interest Method selected, interest on payments received at 5:00 P.M. may be 
calculated as of the next business day. Interest on a payment received Friday 
evening is calculated from Monday morning or the next business day if the 
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Monday falls on a holiday. Otherwise, payments are processed and accounts 
are updated in real time. 

Modifying the “Business End Day” Parameter

The Business End Day parameter (A) can be modified as follows:

1. Click in the parameter to highlight the current value.

The numbers must correspond to the hours, minutes, and time of day, i.e. AM 
or PM. The format is as follows: HH:MM AB

...where HH is the hour of the day, MM is the minutes, and AB is the time of 
day, i.e. AM or PM  

Default Installment: Select the A/R installment for which payment is 
currently due: first, second, third, fourth or total (Table: VT_ SY_INSTALL). By 
default, the installment due is selected on the Web page, as in the following 
screen shot.

Note: It is important that this parameter is set because this value, when 
applicable, can affect the result of interest calculations; verify the 
Interest Method that you are using.

Note: Leave this field blank if you do not want the default installment to be 
selected on the Web page.

This field is required for Real Property Tax payments only.
Page 210 © 2012 MS Govern



ePayment - Setting the Web 
Parameters

FI
N

AL
 D

R
AF

T

Block RE Payment After: Specify the date after which all Real Estate (RE) 
payments will be blocked. This option might be used when you want to enforce 
the requirement that payments must be made by the end of a closing fiscal 
year.

Modifying the “Block RE payment After” Parameter

The Block RE payment After 
parameter (A) can be modified as 
follows:

1. Click in the parameter to 
highlight the date/month/year.

2. Type the DD/MM/YYYY 
required.

OR

1. Click the Calendar (A) button 
to display a calendar; select a 
date.

There are Left and Right Arrows on either side of the month that will allow you 
to scroll through the months of the year (1). To scroll through the years, place 
your cursor on the right side of the Month. Up and Down arrows will appear; 
click the arrows to increase or decrease the year (2).

Disable Dynamic Search Multiple Selection: Select this option to 
disable the multiple selection feature. 

Note: On the calendar, click Today to set the calendar to the current date.
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ACH tab

Automated Clearing House (ACH) is a secure payment transfer system that 
provides a centralized clearing facility for Electronic Fund Transfer (EFT) 
payments, occurring within the U.S. and Canada. You can use ACH for all 
your electronic payments; for example, to validate authorized debits from your 
clients’ accounts for recurring payments. Click the ACH tab (A), to set required 
parameters. 

ACH tab Parameters

Allow ACH: Select this option to enable ACH transactions.

ACH Batch Suffix: Enter a suffix for the deposit number for ACH payments. 
This is appended to the Effective Date of the ePayment.

Check Image Path: Enter the path to the directory where the example ACH 
check image is stored. 
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This is the default image displayed during the ePayment process when the 
user enters the Bank ID and Account Number. You can replace this default 
with another image. The above is an example of a standard image.

Convenience Fee group (ACH tab)

A convenience fee is charged for each credit card transaction made through 
the ePayment component, to cover the associated costs, such as, the 2.5% 
charged by the credit card company. 

To set up a convenience fee, you will need to set the following parameters.

Minimum: Specify a minimum convenience fee.

Maximum: Enter a maximum convenience fee.

Percentage: Enter the percentage of the payment to be charged for the 
Convenience Fee. A confirmation screen showing the calculated amount 
based on this percentage, is displayed to the payer before the transaction is 
completed.

Note: The Convenience Fee charge is a fee that is imposed by the city or 
municipality. Some external processors, e.g. Nelnet, will charge a 
convenience fee, but this charge is administered within Nelnet’s 
transactional domain and is outside of the Govern system.
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Credit Card / Debit Card / eCheck tab

This tab (A) contains the parameters that are required for configuring credit 
cards, debit cards, and eChecks.

Credit Card / Debit Card / eCheck tab Parameters

Govern is able to support a selection of Electronic Fund Transfer (EFT) 
providers / interfaces. Currently, the providers / interfaces available are the 
following:

• ICVerify

• Pay Connexion
• Moneris
• Nelnet (QuikPAY)
• PayPal
• Point and Pay
• US Moneris
• Your Pay

• Paymentus

Note: The ICVerify EFT is only valid for Govern for Windows, and should not 
be used in the eGov.

Note: To configure your Electronic Fund Transfer (EFT) vendor account, see 
the Manage parameter below.
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Vendor Account: Click on the parameter (A) to display the list of vendor 
accounts that are available. 

Manage: Click Manage (B) to display and manage the selected vendor 
accounts in the Vendor Account Management form. Depending on the vendor 
that is selected, the Account Management form (B) will display any required 
parameters.

Note: Refer to Appendix E - Electronic Fund Transfer (EFT) section of the 
Govern NetAdmin (GNA) guide for additional details about supported 
providers.

Note: To configure your Electronic Fund Transfer (EFT) vendor account, you 
will need to contact the vendor and obtain the information that will be 
entered in the Vendor Account Management form (C).
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Electronic Funds Transfer Process

The Electronic Funds Transfer (EFT) process is similar for each of the 
providers / interfaces. For example, PayPal offers the Payflow Pro product for 
processing Credit Card and Debit Card payments. Payflow Pro is a secure 
online gateway for sending billing information to banks. Banks, authorize, 
process, and manage payments that come from online requests. These online 
requests containing billing information for orders, are transmitted through the 
certified, secure connection that is provided by the Payflow Pro payment 
gateway.

The Govern system supports PayPal's Payflow Pro and other EFT provider 
transactions by providing forms that contain parameters that are supplied to 
the user by the EFT provider.

Steps for Setting up an EFT Provider

User requirements for EFT provider transactions are as follows:

1. A credit card account from the city or organizations business bank to be 
supplied to the EFT provider.
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2. An account created by the EFT provider.

3. If Governs’ eComponent is to be hosted on the city’s IIS server, a 
certificate from VeriSign, DigiCert, or any other Certificate Authority (CA) is 
required. If not, the city must be able to ‘sign’ the site for security and 
correctly use the HTTPS protocol.

All Govern required configuration parameters should be requested from the 
EFT provider when an account is opened.

The configuration parameters provided by the EFT Provider, e.g. PayPal, are 
to be entered in the Account form (C).

When configuring the EFT interface, use the Credit Card/Debit Card/eCheck 
tab (B) under the ePayment tab (A) of the Website Manager.

Note: This account is not to be confused with a standard web account like a 
PayPal account that is typically created online.

Note: No additional information is required, i.e. file layout information, header 
file specifications, etc.
© 2012 MS Govern Page 217



eGovern – Public Self 
Service Portal

FI
N

AL
 D

R
AF

T

Specify a Batch Suffix for Credit Card/Debit Card/eCheck

Usually there are multiple transactions that occur on a daily basis. When these 
transactions are processed it is often necessary to determine the origin of the 
transactions. This suffix is for the deposit number and is appended to the 
Effective Date of the ePayment. By specifying a Batch Suffix you are able to 
quickly determine, the Electronic Funds Transaction (EFT) transaction, and its 
origin. For instance a batch suffix can be used for quick identification of Web 
transactions. 

Batch Suffix Credit Card / Debit Card / eCheck: Enter a batch suffix for 
any of the required parameters, i.e. Credit Card, Debit Card, and / or eCheck.

Allow Credit Card: Select this option to allow credit card transactions.

Allow Debit Card: Click on this option to allow debit card type transactions.

Allow eCheck: Select this option to allow eCheck type transactions.

Convenience Fee

The convenience fee is used for specifying a supplementary charge for a 
transaction. This feature will allow you to specify a threshold amount, and or a 
percentage value of the full payment. In addition, if required, you are able to 
specify an alternate Automated Clearing House (ACH) account to divert the 
convenience fee charges to.

Convenience Fee group

Use Secondary Account Fee: Use the Use Secondary Account Fee 
option to specify a secondary ACH for handling convenience fee charges.

Minimum: Specify a minimum amount to charge for the convenience fee.

Note: Not all providers support Debit Cards and eChecks. Verify with your 
preferred supplier..
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Maximum: Enter a maximum amount that will be charged for the 
convenience fee when entered this amount will override any percentage 
amount that exceeds the entered value.

Percentage: Enter the percentage value that will be applied to the payment 
amount for the convenience fee when the minimum value is exceeded.

Specifying a Flat Rate for the Convenience Fee

When a Percentage value is not specified, i.e. set to zero (0), and a value is 
entered in the Minimum parameter, a flat rate will be charged for the 
convenience fee.

To specify a flat rate for the Convenience Fee...

1. Enter the amount that is to be your flat rate in the Minimum parameter.

2. Set the Maximum and the Percentage parameters to zero (0). 

Disabling the Convenience Fee option

Complete the following steps to ensure that the convenience fee option has 
been disabled. 

Note: A value must be entered in this parameter; if the option is not required, 
then a value of zero (0) must be enterd in the parameter.

Tip: A quick way to ensure that a flat rate is specified is to enter the same 
value in the Minimum and Maximum parameters.
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To disable the Convenience Fee option...

1. In the Convenience Fee group, click to select the Use Secondary Account 
Fee drop-down menu (1) and select the blank option from the drop down 
menu.

2. Set all parameters to zero (0), i.e. Minimum, Maximum, and Percentage.

3. Click Save.

Site Seal Script tab

The function of the Site Seal under the Site Seal script tab (A), is to inform 
visitors that your Web site is secure. In order for a site seal to work, you should 
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have purchased a secure certificate from a provider like Verisign. A script (B) 
that is similar to the following may be provided:

The provided script should then be copied and pasted into the text parameter 
under the Site Seal Script tab. This script is included in the page when it is 
generated. 

 Example: 
<!-The Certificator Site[c] Smart Icon tag. Do not edit. -->

<script type="text/javascript" src="https://
sealserver.thecertificator.com/seal.js?style=normal"></script>

<!-end Certificator Smart Icon tag -->

Note: Depending on your certificate provider, you will need to contact them 
for full configuration instructions.
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Payment Option tab

Use the Payment Option tab (A) to enforce which subsystems (B) require that 
a full payment be made when users are using the Web. 

Custom Error Messages

In the event of errors occuring during transactions or processing, a custom 
default error page is displayed by default. This setting is located in the 
Web.config file.

View the setting of this parameter...

1. With a text editor, locate and open the web.config file.
Page 222 © 2012 MS Govern



ePayment - Setting the Web 
Parameters

FI
N

AL
 D

R
AF

T

2. Locate the customErrors parameter; ensure that the switch is set to “On”.

<customErrors mode="On" defaultRedirect="~/CommonPages/ErrorPage.aspx"/>

To have error messages display ASP.NET exception stack traces, set the 
parameter to “Off”.

3. Locate the customErrors parameter; change the switch to “Off”

<customErrors mode="Off" defaultRedirect="~/CommonPages/ErrorPage.aspx"/>

Web Site Manager - eInspection tab

Select the eInspection tab to configure options for the Mobile inspection 
module.

Note:   Set customErrors mode="On" or " " to enable custom error 
messages, "Off" to disable.
Add <error> tags for each of the errors you want to handle.
"On" Always display custom (friendly) messages.
"Off" Always display detailed ASP.NET error information.
"RemoteOnly" Display custom (friendly) messages only to users not 
running on the local Web server. This setting is recommended for 
security purposes, so that you do not display application detail 
information to remote clients.
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Web Site Manager - eInspection tab Parameters

Allow Change Department: Select this option (1) to allow inspectors to be 
able to work outside of their department. When this option is not selected, 
inspectors can only work within their assigned departments.
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Web Site Manager - Report Tab

The parameters under the Report tab (A) are used to specify Crystal Reports 
that are used by the eGovern – Public Self Service Portal. 

Web Site Manager - Report tab Parameters

Crystal Reports group (Settings for SQL Databases)

Database Name: Specify the name of the Web Information database.

Server Name: Enter the name of the Web Information Database.

User ID: Enter the user ID that is used to access the database.

Password: This parameter should contain the password that is used to 
access the database.

Crystal Reports group (Settings for Oracle Databases)

Database Name: Leave this field empty.

Server Name: Enter the name of the Oracle Database instance.
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User ID: Enter the user ID that is used to access the database.

Password: This parameter should contain the password that is used to 
access the database.
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eRemittance
The Self-Reported Tax subsystem is designed to enable organizations to 
report the sales tax from local businesses that are classified as self reported 
tax. In keeping in line with this aforementioned Govern functionality, the 
eRemittance form offers user the convenience of making Self-Reported Tax 
(SRT) submissions online.

When accessing the eRemittance, users will note that it is launched without a 
search screen. This is because only the accounts linked to the eProfile are 
listed.

 

Note: The Self-Reported Tax forms that are created in Govern for Windows 
are not compatible with the eComponent Web pages, therefore those 
forms must be reproduced using the Self Reported Tax editor.
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Creating an eRemittance form

eRemittance forms are created with the Self Reported Tax editor in Govern 
NetAdmin (GNA). See Self Reported Tax Editor  on page 232 for details.

Filing an eRemittance Report

Depending on your menu structure, and how your eRemittance filer page is 
launched, after selecting the account, you can select the period to be filed.
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Period Number Displayed with Date

NEW! On the eRemittance form, now the Date, Due Date (B), and the 
corresponding Period (A) covered are displayed in the form. Previously, only 

the Date and Due Date were displayed.

1. Click Select to select the account and display the eRemittance form.

2. In the eRemittance form, complete the required parameters; click 
Continue. 

3. If a calculation is required for the form it will be performed.

4. After accepting the mandatory declaration, the Process button becomes 
active; click Process to submit the form.

eRemittance Workflow - Payment option

NEW! The eRemittance workflow has been modified to give users, after the 
submission phase, the option to settle any amounts owing. Option are to pay 
immediately, i.e. Pay Now, or pay at a later period, i.e Pay Later.

Note: For the example used here a calculation is performed and prior to 
submission, a mandatory declaration under penalty of perjury must be 
selected 
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After a submission, a summary screen is displayed. The payment option 
buttons are displayed.

If not required, this option can be disabled by an administrator through the 
Govern System Configuration Administrator (SCA) release 5.0.

To enable or disable the Pay Now or Pay Later option in the eRemittance 
workflow in the SCA...

1. Select Application Configurations > Web Configuration... > Manage Web 
Sites...
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2. In the Web Sites form, click to select the Self Reported Tax (A) tab

3. Click to select Show Pay Later to enable the option; deselect the option to 
disable it. 
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Self Reported Tax Editor

The Self Reported Tax form is used to design the layout of Self Reported Tax 
entry forms in the Self Reported Tax OpenForm. To assist in the design 
process, after each field has been positioned, a preview of the layout can be 
seen under the Preview tab.    .

Overview

Note: The preview is an approximation of the layout and not a true What You 
See Is What You Get (WYSIWYG) representation of the designed 
layout.
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To display the Self Reported Tax Editor...

1. In SCA select Setup > OpenForms Configuration > Self Reported Tax 
Editor...

2. Enter a year in the parameter on the left hand side.

3. Select a Department from the Department drop-down menu.

4. Under the Category drop-down menu, select a category.

5. A list of all the fields that are in the form for that year are displayed as a list 
under the Self Reported Tax Definition List on the left hand side (LHS).

6. Click on a parameter on the LHS to see the settings for it under the Setup 
tab.

7. Click on the Preview tab to see a preview of the layout. 

Self Reported Tax Editor Command Buttons

Save: Click Save to save any changes made to the form.

Self Reported Tax Editor Parameters

OpenForms Settings group

The following parameters are used to control the positioning of the parameters 
that are filled out on an SRT form.

Row / Column: The Row and Column parameters are used to specify the 
horizontal / vertical positions of the field.

WARNING: Always assign a Row and Column position value otherwise the 
values in these fields will not be computed. This can lead to 
errors in calculated values. This rule is regardless of whether the 
field is hidden or not.
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Column Span: Column Span allows you to specify the number of columns 
that the field will spread over.

Show label on top of the control: When this option is selected, the text 
label of the field will be presented on top of the field.

No label for this field: Select this option to display the field without any text 
label.

Is Hidden: Select the Is Hidden option to hide the row; see Adding Blank 
Spaces and Columns in a Layout  on page 238.

Tab Sequence: Enter a tab sequence number to control the order that the 
fields are cycled through when the user presses the Tab key. See Changing a 
Form Tab Sequence  on page 239.

Web Site Settings group

Users of the eComponents that provide Self Reporting Tax reporting 
functionality to their clients, can also control the presentation of these forms. 
These parameters will help to specify how the forms will appear through a web 
browser. Refer to the 

Note: The default for the appearance of labels is on the left hand side of the 
parameter.
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Row / Column: The Row and Column parameters are used to specify the 
horizontal / vertical positions of the field.

Column Span: Column Span allows you to specify the number of columns 
that the field will spread over.

Show label on top of the control: When this option is selected, the text 
label of the field will be presented on top of the field.

No label for this field: Select this option to display the field without any text 
label.

Required control on the web site page: There are instances when a 
field may be required to be completed prior to proceeding to the next page or 

WARNING: Always assign a Row and Column position value otherwise the 
values in these fields will not be computed. This can lead to 
errors in calculated values. This rule is regardless of whether the 
field is hidden or not.

Note: Column widths when specifying spans values are determined by the 
width of the largest object in each of the columns.
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section. This could be a Completed By field that acts as a signature, or a 
mandatory date.

Customizing Address fields with the SRT Editor

For an SRT report, part of the report will require the entry of the users address. 
An address can usually require a Street address, a secondary Apartment or 
Suite number and possibly a third field. Additional fields would be needed for 
the City, State, and Zip Code. These fields can be lined up in the same 
column, The street address parameter will have the label displayed on top of 
the field and the secondary apartment number or suite parameter can be 
displayed without a label. The Layout would look approximately like the 
following, note that the address fields span over 2 columns: 

Note: To reproduce the following example, you will need to have created an 
SRT category with the required address fields.
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To have your fields reproduce the above...

1. In the SCA select Setup > OpenForms Configuration > Self Reported Tax 
Editor.

2. In the editor, enter the year and select the Department and Category that 
contains the field that will be in the SRT form.

3. Click and select ADDRESS1 under the Self Reported Tax Definition List 
column.

4. For ADDRESS1 enter 1 and 1 in the Row and Column parameters; the 
column Column Span should be set to 2 (columns).

5. Configure ADDRESS2 as 2 and 1 for the Row and Column parameters, 
but select the No label for this field option; again set the Column Span 
to 2.

6. Repeat the last step for ADDRESS3, noting that the Row and Column 
values are 3 and 1; be sure to select the No label for this field option.

7. You can click the Preview tab to preview the layout.

8. Repeat the previous steps for the City and State fields, remembering to 
increment the numbers entered for the Row. 
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This Self Reported Tax (SRT) editor should be used by all administrators that 
prepare SRT forms required for filing periodic reports.

Adding Blank Spaces and Columns in a Layout

The Self Reported Tax Editor allows the insertion of blank lines and columns 
as a means of creating visual breaks to enhance a form layout.

To create a a blank line...

1. Open the Self Reported Tax editor.

2. In the OpenForms Settings group, specify a new row or column.

3. Click to select the Is Hidden option.

4. Click Copy all OF settings to Web (1), to ensure that the sequence is 
repeated in the eComponent Web form.

TIP: When modifying the layout, use the Preview tab to verify your layout. 
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Changing a Form Tab Sequence

Using the tab key the user is able to sequentially jump from field to field, 
depending upon the sequence that was set by the form designer. 

To change the tab sequence of a field...

1. In SCA open the Self Reported Tax editor.

2. In the OpenForms Settings group, enter the new sequence number in the 
Tab Sequence: field.

3. Click Copy all OF settings to Web, to ensure that the sequence is 
repeated in the eComponent Web form.

TIP: When changing the tab order, review the previously existing tab order. 
When completed, use the preview 
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 Batch ePayment Processing

To process Web ePayments, complete the following steps:

1. Post the Web ePayments to A/R, for credit card and ACH payments.

2. Generate an ACH file for the bank, in Govern Batch Processing, for ACH 
payments only.

Posting Web ePayments to A/R

To transfer your payment records from cash collection to the payment 
summary in A/R, run the Cash Collection (Payments) Posting process.

To access this process, from Govern’s main screen, select Tools > Batch 
Processing (Govbat32.exe) 

OR

Click  then select Account Receivable > Cash Collection Posting... (A)

Complete the following parameters and click Start (B) to launch the process.

Overview

Note: Once records are posted, they cannot be modified or deleted.
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Department: Select the department where the Web payments are saved.

Deposit Number: Select the deposit number or numbers for the process. 
This deposit number is comprised of the effective date the payment is 
processed, followed by the suffix, entered on the ePayments tab form in 
Govern NetAdmin (GNA). See  Specify a Batch Suffix for Credit Card/Debit 
Card/eCheck on page 87.

Cashier ID: Enter the Cashier ID for the payment. This is comprised of the 
effective date the payment is processed preceded by the prefix entered on the 
Web EPayments Parameters form in Govern Admin.

Date From / Date To: Enter the range of dates to use when selecting the 
payments to post.

Effective Date From / Effective Date To: Enter the dates in which the 
payments will be effective From and To.

G/L Reference: Enter the G/L reference to be stored in the G/L accounting 
file.

G/L Cash Account Override: Enter the G/L Cash Account number for the 
override.

Refer to the Batch Processing chapter of the Accounts / Receivable guide for 
details.

Generating an ACH File

Run the ACH Web Payment Extraction process to generate an ACH file 
containing your posted ACH payments, for the bank. You can also re-extract a 
previously-generated file.

To access this process, from Govern’s main screen, select Tools > Batch 
Processing (Govbat32.exe) 

OR

Note: If this field is left blank, all non-posted payments will be processed.

Note: You can leave all fields on this form blank in order to post all payments.
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Click  then select Account Receivable > Generate ACH Web Payment 
File... (A)

Complete the following parameters and click Start (B) to launch the process. 
A file containing the ePayments that have been posted but not previously 
extracted is generated. An ACH File ID is automatically assigned when you 
open the process. This is preceded by the current date.

The ACH File ID is an alphabetic character. A is assigned to the first extraction 
file generated for the day, B to the second and so on to Z; then, a numeric 
character is assigned: 0 to 9. A total of 36 files can be generated per day.

Output File Name: Enter a name for the generated file. By default, the file 
name is the current date followed by the ACH File ID.

Drive Path: Select the drive and directories where the file is to be saved.

Resulting File Name: The full path and file name of the output file are 
displayed in this field.

New File: Select this option to generate an original file.
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Exclude Payments Not Posted: This option is always selected, since the 
process extracts posted payments only. The option is displayed for 
informational purposes only.

Payment From / To Dates: Double-click in the date fields and select dates 
from the pop-up calendar to refine the file extraction. You can leave one field 
blank to include only the payments from or up to a specific date or leave both 
fields blank to include all payments.

Re-extract Existing File: Select this option to generate a copy of a 
previously-extracted ACH file.

ACH File ID: Enter the ACH File ID assigned to the original file. This 
parameter is defined above.

ACH Extraction Date: Enter the ACH Extraction Date assigned to the 
original file. The ACH Extraction Date refers the date that was current at the 
time the file was extracted.

When the process is complete, the ACH file will be generated at the location 
that was specified.
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Troubleshooting

“Sys is undefined” Error Page

Symptom: When trying to access the Website page, a Sys is undefined 
error page is displayed.

Solution: One possible solution for the Sys is not defined error page is to set 
the AppPool Managed Pipeline mode to Classic.

Open the IIS Manager

In Windows...

1. Click to select Start > Control Panel.

2. In the Control Panel, select Administrative Tools.

3. In the Administrative Tools start the IIS manager by selecting Internet 
Information Services (IIS) Manager.

4. In the Internet Information Services (IIS) Manager, locate the Application 
Pools (A).

5. Double-click on the application pool (B) to display the Edit Application Pool 
form.

6. Under the Managed pipeline mode parameter, select the Classic option 
from the drop down menu (C).
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7. Click OK.

8. Right click on the Application Pool and select Recycle.

Error running Reports on eGovern – Public Self 
Service Portal Web sites under 64-bit Windows

Symptom: The. DLL’s for eGovern – Public Self Service Portal that are used 
by the reports are written in 32 bit. When the eGovern – Public Self Service 
Portal is installed on a 64-bit platform, although the Web site will run, the 
reports will not function.

Solution: It is necessary to enable the 32-Bit Applications flag for the 
Application Pool in IIS.

In Windows...

1. Click to select Start > Control Panel.

2. In the Control Panel, select Administrative Tools.

3. In the Administrative Tools start the IIS manager by selecting Internet 
Information Services (IIS) Manager.

4. In the Internet Information Services (IIS) Manager, locate the Application 
Pools.

5. Double-click on the application pool to display existing Application Pools.
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6. Right-click on the Application Pool for the eGov Web site and select 
Advanced Settings from the menu (B).

7. In the Advanced Settings form, locate the Enable 32-Bit Applications 
flag (1) and click to set it to True (2).

8. Click OK to accept the change.

9. Right click on the Application Pool and select Recycle.
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Crystal Report Not Working

Symptom: Reports are not appearing or generating after search is 
requested.

Solution: When the Crystal Reports that are used for displaying search 
results as reports generate an error message, one possible solution is to 
perform a required preinstallation step. Refer to the Step 3 - Installation of 
Crystal Report Runtime on page 8 for details of actions to take.

License Not Valid Error when opening 
eProfile.error saved in Event Log

Symptom: After installing eGov and attempting to access the eProfile 
system, an error is thrown. The following errors can be seen in the error log 
file.

------- Exception Log Entry ------- 

General information

Additional information:

ExceptionManager.MachineName: WEBSERVER

ExceptionManager.Site Identification Key: 

ExceptionManager.Database Connection Key: GOVERN_PROD_CH-FIN-UB_SQL

ExceptionManager.Timestamp: 11/22/2011 11:13:14 AM

ExceptionManager.FullName: ToolsFramework, Version=4.0.0.0, Culture=neutral, 
PublicKeyToken=null

ExceptionManager.ApplicationDomainName: /LM/W3SVC/11/ROOT/WebUserInterface-1-
129664555935303906

ExceptionManager.Thread Identity: 

1) Exception Information:

*********************************************

Exception Type: GovernSoftware.ToolsFramework.Exceptions.GovernException
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Messages:

1- You are not allowed to use the eProfile system. Please check with the city.

2- Could not load eProfile login page.

MessageCount: 2

Message: Govern Exception

Data: System.Collections.ListDictionaryInternal

TargetSite: Void Page_Load(System.Object, System.EventArgs)

HelpLink: NULL

Source: App_Web_qm02nhia

Stack Trace information

*********************************************

   at GovernSoftware.WebUserInterface.WebProfile.WEB_WP_NA_Login.Page_Load(Object 
sender, EventArgs e)

   at System.Web.UI.Control.OnLoad(EventArgs e)

   at System.Web.UI.Control.LoadRecursive()

   at System.Web.UI.Control.LoadRecursive()

   at System.Web.UI.Control.LoadRecursive()

   at System.Web.UI.Control.LoadRecursive()

   at System.Web.UI.Page.ProcessRequestMain(Boolean includeStagesBeforeAsyncPoint, 
Boolean includeStagesAfterAsyncPoint)

*********************************************

END OF EXCEPTION

*********************************************
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Solution: Contact MS Govern Technical support to obtain a valid license to 
access the eProfile.

Server Error in ‘/WebUserInterface’ Application

Symptom: When trying to access the Website page, a Server Error in ‘/
WebUserInterface’ Application error page is displayed.

Solution: One possible solution for the above error page is to set the 
AppPool Managed Pipeline mode for the eGov to Classic.

1. Click to select Start > Control Panel.

2. In the Control Panel, select Administrative Tools.

3. In the Administrative Tools start the IIS manager by selecting Internet 
Information Services (IIS) Manager.

4. In the Internet Information Services (IIS) Manager, locate the Application 
Pools.

5. Double-click on the application pool (B) to display the Edit Application Pool 
form.

Note: After obtaining the appropriate licensing information, it will be 
necessary to create a new deployment with the MS Govern DeployEZ 
application. Refer to the DeployEZ 4.7 user guide for details. In 
addition, the Internet Information Service (IIS) will need to be restarted 
after installing the deployment applications.
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6. Under the Managed pipeline mode parameter, select the Classic option 
from the drop down menu (C).

7. Click OK.

8. Right click on the Application Pool and select Recycle.

Crystal Reports Processing Jobs Limit issues

System performance issues arising from multiple users requesting Crystal 
Reports may be caused by a Crystal Reports error related to Print Job 
limitations on a Web server. The PrintJobLimit key is by default set to a value 
of 75; the recommended number of requests for optimum performance. When 
eGovern Crystal Reports are requested by multiple users, reports may stop 
working. Changing the value in the registry key to -1 (maximum number of 
requests = unlimited), can avoid this problem but may affect system 
performance.

To modify the registry key...

1. In the Windows Start button, search for the Registry Editor utility 
(regedit.exe).

WARNING: Making modifications to the Windows registry should only be 
carried out by experienced users with system administrator level 
a. Extreme caution should be used when proceeding as errors 
can render your system inoperable.
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2. Look for HKEY_LOCAL_MACHINE > SOFTWARE > Business Objects > 
[Crystal Reports Version] > Report Application Server > InProcServer > 
PrintJobLimit.

3. Double click on the PrintJobLimit key to display the edit string.

4. Change the value of the string (A) to -1.

Issues Contacting Server by Server Name

Symptom: When a server is located in the “Network DMZ”, Govern may not 
be able to contact the server by the Server Name used in generating the 
connection key.

Solution: When this server cannot be contacted by its name, i.e. resolved, 
the IP address of the server should be substituted for the Database Server 
Name. 

Note: The above is a non-exhaustive resolution to the issue. Additional 
details and recommendations for designing reports may be found on 
the SAP website 
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For Example:

When attempting to connect to the following…

Database Server Name: KENOBI (IP address = 192.168.50.100)

Database Name: LANDTITLES

Database Type: SQL (SQL 2005)

Following Govern.NET standards of <DatabaseName>_<DatabaseServer-
Name>_<DatabaseType>, the Connection Key would be:

LANDTITLES_KENOBI_SQL

After attempting to connect using the above connection key, replace the Data-
baseServerName with the IP address of the server. The resulting Connection 
Key would be...

LANDTITLES_192.168.50.100_SQL

If the issue is related to the resolution of the of the server name, a substitution 
with the IP address should resolve the connection issue.

Note: The parameter names are separated with the underscore character “_”

Note: Should the IP Address of the Database Server change, it will need to 
be modified in the Connection Key.
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APPENDIX A: Glossary

Term Definition

Access Level A level of security. Within the eProfile, there are five levels of security 
for five types of users: Internet Without Profile: Users without an 
eProfile account; Internet With Profile: Users with an eProfile account; 
Internet Subscriber: Users with an up-to-date subscription plan; 
Intranet User and Intranet Administrators.

Anonymous User An unauthenticated user. Anonymous User or User Without Profile 
status can be assigned to some menu options and items in the 
eProfile. Certain restrictions apply.

Appeal A request to reexamine the result, final judgment or ruling of a lower 
court. You can create your own Appeal Types and activities and assign 
all the attributes available to the Permit Type.

Application Type See Permit Type.

Approval An authorization of the amount to be borrowed in order to pay for a 
property, following a financial assessment of the borrower. An approval 
type and process can be defined in Govern.

Automated Clearing House 
(ACH)

A system that provides electronic funds transfer (EFT) between banks, 
included with Govern’s ePayment solution, for paying bills and permit 
fees, over the Internet, directly and securely from a bank account.

Bond A written certificate, issued by a business or government organization 
defining a debt, the terms of payment and any other obligations. In 
Govern, bond types and activities; such as dates for payment and 
interest accumulation, can be created and maintained. You can create 
your own bond types and activities and assign all the attributes 
available to the Permit Type.

Complaint A formal statement filed against another person or entity, expressing 
dissatisfaction or a violation of rights. In Govern, complaint types and 
activities, such as a request to file a response or to appear in court, can 
be created and maintained. You can create your own appeal types and 
activities. and assign all the attributes available to the Workflow Type.

Decision A conclusion reached by a court of law or tribunal to resolve a dispute 
or argument. A decision process can be initiated through a System 
Activity. You can create your own decision types and activities and 
assign all the attributes available to the permit type.
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eComplaint An electronic complaint submitted over the Internet. Govern’s 
eComplaints solution is similar to the ePermits solution. It provides 
online access to citizens and tracking and maintenance features for 
Govern users.

eComplaint (Anonymous) Functionally the eComplaint Anonymous is the same as the 
eComplaint, with exception that no profile is required for submitting. 

eComponents An electronic component. Govern’s eGovern – Public Self Service 
Portal package includes the eProfile, ePayment and ePermit solutions. 

eGovernment Government information and services made available over the 
Internet.

E-mail An e-mail message can be associated with an activity or activity step 
and automatically generated at a specified point, such as the initiation 
or completion of the activity.

ePayments An electronic transaction made over the Internet. Govern’s ePayments 
solution includes ACH and credit card payment management.

ePermits An electronic permit initiated over the Internet. Govern’s ePermits 
solution provides online access for submitting both simple and complex 
permit applications that can include multiple permit types, multiple 
name types and multiple additional documents.

eProfile A set of data portraying a citizen or user. At this time, the eProfile 
includes name and address information, properties, UB accounts, 
ePermits, ePayments.

eProfile Account ID A unique combination of six to 30 characters that identifies a user. Only 
alphanumeric characters are accepted. 

eProfile Password A unique combination of up to 16 characters that identifies a user. The 
password is encrypted in the database and kept secret by the user. 
The minimum length, type of characters and security level are 
determined by the organization.

eRemittance An online variation on the Self Reported Tax submittal form. The online 
version of the form must be created with the Self Reported Tax Editor 
in Govern NetAdmin release 4.7 and greater.

eRenewal Activity steps that allow renewal can be configured to allow the user to 
perform this renewal action online. Settlement of any associated fees 
is carried out through the ePayment process.

Grievance A Complaint filed against a government organization; for example, to 
dispute a decision or ruling. Using the same forms as for a complaint, a 
grievance type and process can be created and maintained. 

Term Definition
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Hit A request logged by a Web server. Each time a user selects a property, 
in the eProfile, to make an inquiry, make a payment or access an 
eComponent, it is considered a hit. The user can make as many 
inquiries or access as many eComponents as required in the same hit, 
for the selected property. For example, a user can select a property, 
view the tax billing information, make a payment and apply for a permit 
in a single hit. However, if the user selects a different property to view 
the tax information on that property that is considered a second hit.

Key Type A classification for Land Management data. In Govern, there are three 
key types: Permit, Offense and Workflow. For the Web, the Permit Kind 
comprises Building, Electrical, General, Plumbing Permits, Approvals, 
Bonds, Decisions, Prosecutions and Appeals and the Workflow Kind 
comprises Complaint, Grievance and Request for Services and 
Workflow.

Menu Level A reference to the menu or submenu at which a menu option appears. 
The eProfile can include up to five menu levels, as defined by the 
organization. All options on the main menu bar are considered Top 
Level; options accessed from the Top Level options are second level 
options; options access from the second level are third level options 
and so on. For example in Web Portal > Tax Information > Payment 
History; Web Portal is a top level option, Tax Information a second and 
Payment History a third level option.

Mobile Inspector An application designed for the inspector who needs up-to-the-minute 
information, while working in the field, Govern’s Mobile Inspector 
solution provides online real-time wireless access to the Land 
Management subsystem.

Multimedia Codes and sub 
codes

A classification and subclassification providing options for linking 
various document types to a permit.

Offense An infraction of a law, rule or code. In Govern, you can create an 
Offense process, following a setup similar to the one defined for the 
permit type. You can create Offense types and assign activities to 
define and track the process. You can then associate name types, 
fees, inspection scheduling, multimedia codes, a new offense, permit 
or workflow process and link multiple properties as for a permit. In 
short, you can assign all the characteristics available to the permit type 
with the exception of fee methods.

An offense can be initiated through an activity associated with the 
ePermit application.

Term Definition
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Permit Type A user-defined classification under Permit Kind. For example, under 
the Building Permit Kind, you could have renovation, new construction, 
commercial or residential permit types. Additional columns and activity 
steps can be defined for the permit type.

Primary Permit Type The main permit type associated with the permit. All permit 
applications must include a Primary Permit Type. The activity steps 
and sequence numbers associated with the primary permit type are 
followed. All fees associated with the primary type are charged.

Prosecution The process of pursuing formal charges against an offender, in a court 
of law. In Govern, prosecution types and activities, such as the initial 
complaint and court dates, can be created and maintained. The 
prosecution type uses the same forms as the permit type. In Govern, 
Prosecutions fall under the Permit Type category. You can create your 
own prosecution types and activities and assign all the attributes 
available to the permit type.

Request for Services A formal statement and process to ask for services from an 
organization. Using the same forms as the Workflow type, request for 
services types and activities can be created and maintained.

Search Group A combination of two or more Search Styles that are launched, as a 
unit, in the order specified in the search sequence.

Search Object An item appearing on a Search page, such as a search criterion or 
label. To display search objects on a Search page, you need to link 
them to a Search Style.

Search Style A Search Style launches an SQL query and displays the Objects that 
appear on the Search page, including the search criteria and labels.

Secondary Permit Type A permit type that can be linked to the primary permit type on the 
permit application, since the property, requirements and other 
information are the same for both types. The activity steps and 
sequence numbers associated with the secondary permit type are not 
used. Fees are charged only if they are linked to an activity step that 
has the same number as an activity step in the primary type setup.

Subscription Plan An arrangement for providing access to the eProfile. Subscribers can 
be charged by hit, by subscription period or by profession. The 
organization can create four different types of subscription plans and 
an unlimited number of plans of each type.

Subscription Period A period of time during which a subscription is active. A variety of 
subscription periods can be selected, from one day to one year.

Term Definition
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Universal Naming Convention 
(UNC)

A standard for specifying the directories where servers, files and other 
resources are located on a network.

The UNC standard uses a double backslash to identify the computer 
and single backslash for the directory; for example, 
\\GovernServer\Govern\DotNet\version3.1\

The drive letters; such as c: and d: are not entered.

Workflow A series of activities that define a business process within an 
organization. Workflow activities can include tasks, procedures, the 
request for and input of documents and required tools as well as other 
processes. Created on Land Management forms, similar to those used 
for permits, you can associate name types, fees, inspection 
scheduling, multimedia codes, a new workflow, permit or offense 
process and link multiple properties as for a permit.

A workflow can be initiated through an activity associated with the 
ePermit application.

In Govern, the Workflow Type comprises Complaint, Grievance and 
Request for Services as well as Workflow.

Term Definition
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APPENDIX B:eComponent Item Kinds
When the option for eComponent is selected in the Item Kind parameter, the 
following options are available for selection under the Item Name parameter:

Note: eComponents that are described as “<CUSTOM>” are components 
that have been customized for specific clients.

eComponent Item Name Description

Access Rights This is an administrative screen used to set up 
user rights, or to reset them to default; this link 
will be reserved for those with Administrator 
credentials.

Account Information This option to link to the user modification compo-
nent. The user will be able to change their 
account details such as password, name and 
address, etc., if permitted.

Account Information (Admin) Select this option to access the administrator 
version of the Account Information. An adminis-
trator will be able to search for names and 
change account details.

eComplaint Use this option to configure the eComplaints 
component.

eComplaint (Anonymous) This option will configure the eComplaints (Anon-
ymous) component. Refer to Anonymous 
eComplaints on page 39

eGrievance When selected, this option will connect your 
menu to the eGrievance component.

ePayment Selecting this option will allow you to attach the 
online payment component.

ePermit This option is will set your menu to link to the 
ePermit component. See ePermit - Planning Your 
Setup in the 

eProperty Information <CUSTOM> For linking your menu to the custom 
property information component, select this 
option.
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eRemittance Use this option to link your menu to the eRemit-
tance component for Self-Reported Tax 
submissions. Refer to eRemittance on page 227.

eRenewal This option will link your menu to the eRenewal 
component that allows online renewal of certain 
permit types. Refer to ePermit - eRenewal 
process on page 197.

eRequest for Service This is the option that is used for the Request For 
Service (RFS) component.

GIS <CUSTOM> Select this option to use the GIS 
custom component.

Home Select this option to have the menu link to the 
designated home page.

JP Morgan Payment Inquiry <CUSTOM> Select this custom component when 
using the JP Morgan Payment Inquiry system.

MB Payment Select this custom component to use the Misc. 
Billing ad hoc payment component.

Modify User Select this admin option to link to the User Modi-
fication component. This allows you to be able to 
search for other user profiles. Not to be confused 
with Dynamic Searches.

Multimedia Documents When selected, this option allows the viewing of 
Multimedia documents in the database through 
the Reports.

Properties This links to the component that will add or 
removes properties to accounts.

Properties (Admin) This is the Administrative version of the Proper-
ties components. This allows administrators to 
display current users and their linked properties.

Sign Out Use this option to link to the “log off” component.

Subscriber Definition Select this option to link to the administrative tool 
that is used to maintain subscribers. You are able 
to display subscribers, see associated plans, and 
whether they are active.

eComponent Item Name Description
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Subscriber Plan Definition When selected, this component will link the menu 
item to the subscriber plan definition module. This 
component is used to design the subscriber 
plans.

Subscription Balance This option will link to the component that is used 
to renew subscription plans.

Subscription Approval <CUSTOM> Select this option to have your menu 
link to the subscription approval component. This 
custom component will hold newly created 
accounts and display them on a list that the 
administrator can then Approve or Reject the 
user.

UB Accounts This option will link the component to accessing 
UB Accounts.

UB Accounts (Admin) This links to the Administrative properties compo-
nents for UB Accounts.

eComponent Item Name Description
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APPENDIX C:Interactive Crystal Reports
The following lists the basics on how to integrate interactive Crystal Reports in 
the ePortal and the eProfile websites.

 

Note: The perform the following examples, a fully licensed version of Crystal 
Reports 2008 is required.

Note: Client computers that intend to run Crystal Reports will need to install 
the Crystal Reports 2008 runtime on each clicnt computer. Refer to the 
Crystal Report Runtime section of the DeployEZTM Installer Guide for 
installation details.
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Parameter Fields

If you integrate these parameter fields to your report, the Govern NET solution 
will automatically fill them with values before opening the report. These 
parameters have been color coded to better illustrate them within examples 
below.

"SESSIONID[required]: Before opening the report, the report manager will 
fill this parameter with the current session id, this will be used to redirect to 
another report or web page and will prevent loosing all current session 
information.

"WEBSITEADDRESS [required]: Before opening the report, the report 
manager will fill this parameter with the current web site address, this will be 
used to redirect to another report or web page.

"WEBREPORTDIRECTORYPATH [required]: Before opening the report, 
the report manager will fill this parameter with the value in the web.config entry  
"GovernSoftware.WebReportDirectoryPath". This value will be used to locate 
the report directory root.

"LANGUAGE [optional]: If this parameter is included, we will fill it with the 
current culture language used by the user. You will then be able to use this 
value to display the label in the proper language.

"ACCESS_RIGHT [optional]: If this parameter is included, it will be filled 
with the access level code of the current user, i.e. internet user without login, 
internet user with login, intranet admin, etc. This could be useful to show/hide 
different sections of a report based upon user security level.

Formulas

Formulas should be added to the report, they are not required, but they will 
simplify the implementation and the maintenance of the report.

"WebSessionID [fixed]: This formula always contains the same value. It's 
used to detect if the reports know the session id.

Definition: 

if Length ({?SessionID}) > 0 then 

    '/(S(' + {?SessionID} + '))' else 
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"WebSiteAddress [fixed]: This formula always contains the same value. It 
is used to build the current web site address with the session id.

Definition: 

{?WEBSITEADDRESS} + {@WebSessionID} 

"WebPaymentURL [fixed]: This formula always contains the same value, 
the URL of the ePayment page.

Definition: 

{@WebSiteAddress} + '/ar/
web_ar_payment.aspx?target=ar_info_basic&DirectCall-
ToAr=1'

"WebReportViewer[ fixed]: This formula always contains the same value, 
the URL of the report viewer page:

Definition: 

{@WebSiteAddress} + '/Report/
Web_Report_CrystalViewer.aspx'

"WebMultimediaViewer: [ fixed]: This formula always contains the same 
value, the URL of the multimedia viewer page:

Definition: 

{@WebSiteAddress} + '/Multimedia/
Web_Multimedia_Viewer.aspx '

Formulas for Retrieving Late Charge Information

NEW! The following are formulas that can be used when modifying Crystal 
Reports. When each formula is used, it will populate the AR_SUMMARY table.

GOVERN_PP_INTEREST: When this parameter is entered by the user, it 
will locate a PP_ID parameter in the report and generate the late charge 
information in the AR_SUMMARY table for all the PP records related to that 
PP_ID.
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GOVERN_PP_INTEREST_BY_P_ID: When this parameter is provided, 
this formula will look for a P_ID parameter in the report and generate the late 
charge information in the AR_SUMMARY table for all PP records related to 
that P_ID.

GOVERN_PP_INTEREST_BY_NA_ID: Using this formula will search for 
an NA_ID parameter in the report and generate the late charge information in 
the AR_SUMMARY table for all PP records that are related to the NA_ID.

Users will need to modify their report to use one of the above formulas to 
retrieve the Late Charge information from the AR_SUMMARY table. This can 
be done by creating a sub report. To display the content of the AR_SUMMARY 
table in reports, users should then use the following parameters in said 
reports:

• LATE_CHARGES
• CHARGE_DATE
• BALANCE_AS_OF_DATE
• DAILY_INTEREST

Links

Currently, there are three (3) types of  links that are supported in the Crystal 
Reports:

• Links to other Crystal Reports
• Links to the ePayment page
• Links to the Multimedia page

Linking to another Crystal Reports

There are  two values that need to be set, the Report Name and the Reports 
Parameters. The report name is marked in yellow . You can append as many 
parameters as your reports needs but the first one must be entered like the 
green entry, and the others like the red entry.

Example:

{@WebReportViewer} 
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+ '?REPORTNAME=' + {?WebReportDirectoryPath} + 
'GOV_WEB_TX.rpt'

+ '&ReportParameter=YEAR_ID='+{?YEAR_ID}

+ ';ACCESS_RIGHT=' + {?ACCESS_RIGHT} 

+ ';LANGUAGE=' + {?LANGUAGE}

+ ';P_ID=' + {?P_ID} 

+ ';CURRENT_YEAR_ID='+{?YEAR_ID}

"ePayment: You have to set two values, the key value and the previous 
page. The Key value support P_ID, AR_ID and UB_ID, it should be entered 
like the yellow entry. The previous page is a link to the current report and is 
defined like a link to another Crystal Report, with the only difference marked in 
green. The %26 is the URL code for the special character "&" that is used to 
separate parameter in the URL.

Example:

{@WebPaymentURL}

+ '&p_id=' + totext({?P_ID}) 

+ '&PreviousPage=' 

+ {@WebReportViewer}

+ '?REPORTNAME=' + {?WebReportDirectoryPath} + 
'GOV_WEB_MENUREPORT.rpt' 

+ '%26ReportParameter=ACCESS_RIGHT=' + {?ACCESS_RIGHT} 

+ ';LANGUAGE=' + {?LANGUAGE} 

+ ';P_ID=' + {?P_ID} 

+ ';YEAR_ID=' + {?YEAR_ID}

"MultimediaViewer: You have to set two values, the info id value and the 
previous page. The info_id value is the unique identifier of the multimedia 
document, it should be entered like the yellow entry. The previous page is a 
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link to the current report and is defined like a link to another Crystal Report, 
with the only difference marked in green. The %26 is the URL code for the 
special character "&" that is used to separate parameter in the URL.

Example:

{@WebMultimediaViewer}

+ '?info_id=' + totext({PC_DEPT_INFO.INFO_ID})

+ '&PreviousPage='

+ {@WebReportViewer}

+ '?REPORTNAME=' + {?WebReportDirectoryPath} + 
'GOV_WEB_MENUREPORT.rpt' 

+ '%26ReportParameter=ACCESS_RIGHT=' + {?ACCESS_RIGHT} 

+ ';LANGUAGE=' + {?LANGUAGE} 

+ ';P_ID=' + {?P_ID} 

+ ';YEAR_ID=' + {?YEAR_ID}

Transfer of variable to Crystal Reports

Users should note that the WebProfileCurrentNa_Id variable is 
transferred to Crystal Reports when a user is logged on with an eProfile. This 
variable is the Name ID (NA_ID) of the current user that is logged on.

Customize a Report with Help Content

NEW! Developers that would like to include help content with their customized 
reports, can do so with the help of the GNA Resource editor. When the report 
is generated, the help entry that is linked to the report will be accessible 
through the help icon beside the report.
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Configuring the Crystal Report with Help Content 

The process of configuring the Crystal Report with Help content is a three (3) 
step process. The required steps are...

• STEP 1 - Create the Report and note the name.
• STEP 2 - Open and create an entry in the Resource file.
• STEP 3 - Populate the key with your help content.

STEP 1 - Create the Report

To create and or modify a Crystal Report refer to the Interactive Crystal 
Reports on page 263 for details. Note the name of the report that you have 
created, the Resource file entry will use the name of the Report without the file 
extension. For example if the report name is WEB_PROP_REPORT.rpt, then 
the name that will have to be created in the resource file entry is 
WEB_PROP_REPORT.

STEP 2 - Create an entry in the Resource file

1. Open Govern’s New Administrator (GNA); select Editors > Editors > 
Resource File Editor...

2. In the Resource File editor, select File > Open...

3. Locate the Help content resource file called 
GovernNetHelp.en.resources; load the file into the editor.

4. Drill down to the WP module node; expand it to view the Functions that 
correspond to each report.

Note: The following steps will require the use of the GNA Resource File 
Editor. Refer to Govern’s New Administrator Release 5.0 user guide 
for details about using the Resource File Editor.

Note: The path to the resource file is within the deployments folder
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Creating Resource Entries

There are two approaches that can be used to 
create an entry. A user can either create a new 
entry, or duplicate an existing entry that may 
be similar and then modify the name and 
content.

Create a New Resource Entry

To create a new entry...

1. Hover the mouse pointer over the WP 
Module name in the column on the left 
hand side and right click.

2. In the floating menu select Add Entry. 

3. In the Resource File Editor, in the Function 
field, enter the name of the Crystal Report, 
all in uppercase letters excluding the .RPT file extensions.

4. In the Label field, enter HELP_1 or an appropriately short name.

5. Under the English String area, enter the help content. It is necessary to 
enter content for the second language parameter as well; if no translation 
is available placeholder text like “Help translation” can be used.

Note: Text that is entered in the English String area can be formatted in 
HTML and use an embedded Cascading Style Sheet (.CSS)
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Alternatively...

Duplicate an Existing Resource Entry

To duplicate an existing entry...

6. Hover the mouse pointer of an entry that you would like to duplicate and 
right click. 

7. In the floating menu select Clone Entry.

8. A dialog box will appear stating, “Please save the file and reopen it.“ will 
be displayed; click OK. 

9. Select File > Save.

10. Close, then re-open the resource file.

11. Re-open the file; under the WP module, you will now see a new file called 
“COPY OF Copied_Filename”

12. It will now be necessary to rename the cloned file; hover the mouse pointer 
over the name and right click. 

13. Select the Rename Function... option.

14. In the Rename a Node dialog, rename the function to that of the report, all 
in uppercase letters excluding the .RPT file extension.

15. In the Label field, enter HELP_1 or an appropriately short name.

STEP 3 - Populate the key with your help content.

1. Under the English String area, cut and paste the help content from a text 
editor. 

2. Save the additions to the key by selecting File > Save.
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Text that is entered in the English String area can be formatted in HTML and 
use an embedded Cascading Style Sheet (.CSS)

When a report is displayed as a result of a request by the system, a search is 
made for an entry under the name of the report. If there is an entry, a Help link 
is displayed in the upper right hand side of the interface. The saved help 
content can be invoked with a click on the Help link in the upper right hand 
side of the interface. The content, as with the standard system help, is 
displayed in a separate window from the Report.

Auto Launching a Report

In Govern’s New Administrator (GNA) Release 5.0, when configuring a menu 
to display a report, the report can be automatically launched. This feature is 
achieved by only specifying the Requested Key parameter in the Dynamic 
Search group.  

Note: It is necessary to enter content for the second language parameter as 
well; if no translation is available, placeholder text like “Help 
translation” can be used.

Note: This feature is only valid when a user is logged in with an eProfile.
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To create a menu to Auto Launch a report...

1. In GNA click Setup > Web Configuration... > Manage Web Sites...

2. In the Web Sites editor, click Menu Setup.

3. Under the Menu list, create a new menu, or select a pre-existing menu.

4. In the Item group specify Report as the Item Kind; specify a path to the 
report.

5. Specify the Requested Key for the search in the eSearch group; do not 
specify a Dynamic Search Style or Group. 

6. Configure any additional parameters.

7. Click Save to save the menu.

In eGov, when the menu is selected, the ePortal will launch the report directly 
using the Name ID (NA_ID) of the eProfile.
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APPENDIX D:Creating a Secure Access 
Page

When hosting a Web site, it may be necessary to provide secure access to 
certain pages within your site. The eGov offers pages that can be accessed 
without the security of an eProfile, as well as pages that users require a 
username and password to access, i.e. a profile to access. The Application 
Pool that the eGov is running within, has security settings that will be applied 
to all Web pages within the eGov. This means that all users will have the same 
level of access to all pages. This may not be desirable, as there may be pages 
that will required controlled access. As an example, the pages that display 
multimedia documents may require additional security due to the sensitivity of 
documents that they may contain. A method is therefore required to secure 
certain pages.

The following will describe steps to create access for a set user to a specific 
page. For our example we want to create secure access to the Multimedia 
pages due to the fact that sensitive documents are kept there. The Multimedia 
page that will be targeted is located in the following directory:

 \\Myserver\inetpub\wwwroot\MSGovern\WebUserInterface\Multimedia\

Note: The following section contains information that requires the creation 
and modification of system registry keys. Ensure that a full back up of 
the registry is made prior to making any modifications. The following 
steps should only be made by a System Administrator or users with 
Administrator level access and indepth knowledge of the functioning of 
the system registry.
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The name of the page is: Web_Multimedia_Viewer.aspx

STEP 1 - Modify the Web.config file

The first thing needed is to locate the web.config file, and using a text editor 
locate the <configuration> section within the file.

Original web.config:

<configuration>

  <location path="PageToImpersonate.aspx">

    <system.web>

      <identity impersonate="true"

                userName="MyUser"

                password="MyPassword"/>

    </system.web>

  </location>

</configuration>

Modification to web.config:

Below are the modifications that will need to be made in the section.

<configuration>

  <location path="Web_Multimedia_Viewer.aspx">

    <system.web>

      <identity impersonate="true"

userName="registry:HKLM\SOFTWARE\MSGOVERN\WebUserInterface\Multime-
diaIdentity\identity\ASPNET_SETREG,userName"

password="registry:HKLM\SOFTWARE\MSGOVERN\WebUserInterface\Multime-
diaIdentity\identity\ASPNET_SETREG,password"/>
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    </system.web>

  </location>

</configuration>

STEP 2 - Use the ASPNET_setreg.exe utility

Although by design, ASP.NET will reject any HTTP request to resources with 
the .config extension, e.g. web.config, sensitive configuration information is 
being saved in the web.config. It is best practices to ensure that the sensitive 
sections of the web.config file is encrypted for security reasons. Once 
encrypted, the settings are safe. In addition, when the settings are being 
accessed, ASP.NET will automatically decrypt the sections required.

ASPNET_Setreg.exe is a command-line program that is used to encrypt 
sections of your web.config file. The installation package can be obtain from 
the Microsoft Website at http://support.microsoft.com/kb/329290.

To encrypt your username and password in the <configuration> section...

1. Install aspnet_setreg.exe under c:\Tools or similar directory

2. Type the following command:

Run CMD c:\Tools>aspnet_setreg.exe -k:SOFTWARE\MSGOVERN\WebUser-
Interface\MultimediaIdentity\identity -u:"yourdomainname\username" -
p:"password"

STEP 3 - Update the Permissions in the Registry

To ensure that the Registry gives permission to the registry keys for the 
ASP.NET Account, it will be necessaqry to use the regedit.exe registry editor.

From the desktop...

1. Click Start > Run

2. In the Run dialog box, type regedt32; click OK.

3. From the top of the registry tree, “drill down” as follows:
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HKEY_LOCAL_MACHINE > SOFTWARE > MSGOVERN > WebUserInter-
face > subkey.

4. Right click on the subkey and select Permissions.

5. In the Permissions form, give access rights to ASP.NET users and the 
NetworkService (IIS 6.0); replace permissions for all children.

6. Click OK to save.

7. Select File > Exit.

8. Perform an IISReset.
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APPENDIX E:  HTML Tags
The following are lists of common HTML tags that can be used in the WebSkin 
Editor 

HTML Document Structure

A standard HTML document will have the 
following structure. 

<HTML>

<HEAD>

<TITLE>

This Title Appears in 
the Browser Title Bar

</TITLE>

</HEAD>

<BODY>

Information for the body section. 
This information

is usually seen in the browser window.

</BODY>

</HTML>

<HEAD> Section

The <HEAD> section is the recommended location for JavaScript, and 
Cascading Styles Sheets (CSS). Elements that are often contained in the 
<HEAD> section are:

• Title - The title that appears in the title bar of the browser is set between 
the <TITLE></TITLE> tags.

• Link - The link element is used to define an external resource such as the 
external CSS file containing formatting styles. The following is a sample 
using the Link element to link to an external CSS file.
<link rel="stylesheet" type="text/css" 
href="CSS_Filename.css" />
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• Meta - The meta element is used to define document author, purpose, 
keywords, etc.
<meta name="keywords" content="HTML, web design" />

The “Head” section of the document is where you place the title of the page. 
The title that appears in the title bar of the web browser is placed between the 
“<TITLE></TITLE>” tags. 

<BODY> Section

The <BODY> section of your document is used for all content that is to be 
displayed in the browser. Following are some tags that are used in the 
<BODY> sections

Formatting Tags

Creating Hyperlinks, Anchors, and Links

The HTML Anchor link <a> is used to define links within your document.

<a href="URL to file">Text to be linked</a> 

Tag Name Tag Used

Heading1 <H1></H1>

Heading2 <H2></H2>

Heading3 <H3></H3>

Heading4 <H4></H4>

Heading5 <H5></H5>

Heading6 <H6></H6>

Bold <B></B>

Italic <I></I>

Paragraph <p></p>

Font <font face=”Arial” color=”#FFFFFF” size=”5”>
- The font name must appear as it does in 
your fonts folder
- Colors are defined using Octal
© 2012 MS Govern Page 279



eGovern – Public Self 
Service Portal

FI
N

AL
 D

R
AF

T

HREF defines the link address, so for example a line of text that would link to 
the MS Govern Web site would look like the following:

<a href=“http://www.msgovern.com/”>Click here to go to our site...</a>. When 
the above hyperlink is defined, Click here to go to our site will appear 
underlined and will be a link to www.msgovern.com

Creating an E-mail Link

The e-mail link is a standard hyperlink using the anchor link with a slightly 
different syntax. For example:

This is a mail link...

<a href="mailto:someone@company.com?subject=Per-
mit%20Request">Contact Us</a>

the above e-mail link, will display Contact Us as a hyperlink that when 
selected, will launch the installed e-mail client with a new message window. 
The message will be addressed to “someone@company.com”, and “Permit 
request” will appear in the Subject field.

Relative Links

When creating hyperlinks, depending on the length of the domain name, and 
the number of subdirectories that the file being referenced is located in, the 
URL’s can become very long. In such situations, users that are familiar with 
the use of Relative Links will use them as a means of shortening the URL. 

For example, a file called web_image01.jpg is being referred to from a page 
with a URL of :

http://www.metrocity.com/webpages/html/services.html 

The URL for the image is:

http://www.metrocity.com/webpages/html/images/
web_images01.jpg 

Note: When you want to enter text in the Subject field, spaces between 
words should be entered as “%20” which is the URL encoding for a 
space character.
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To shorten the URL, a relative URL can be use to replace the longer path:

images/web_images01.jpg

Using Relative Links with the ePortal Application

The use of relative links, although supported, is not recommended. The Web 
Portal Application uses Active Server Pages (ASP), information to generate 
the page may be obtained from varoius locations. These locations can 
change, and as a result the links can be broken. It is therefore recommended 
that you use absolute URL’s, i.e. the full path for hyperlinks and references.

Tables in HTML

HTML tables allow you to arrange text, images, links, etc. into rows and 
columns of cells that are in a table. The principal tags that are used are the 
following:

Tags

Tag Name Tag Used Explanation

Main Table Structure <TABLE></TABLE> Creates table; properties 
are defined within.

Table Row <TR></TR> Defines each row

Table Data <TD></TD> Defines each cell of the 
table.

Table Header <TH></TH> Used to specify table 
headers; can be used for 
Rows, Columns, or both.
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Elements

Table elements are used to define other elements that specify content, and 
formatting 

Tag Name Name & Attribute Explanation

Border BORDER
ex. <TABLE BORDER=2>

Specifies thickness of 
cell border

Cell spacing CELLSPACING
ex. <TABLE 
CELLSPACING=4>

Sets space between 
table cells

Cell padding CELLPADDING
ex. <TABLE 
CELLPADDING=4>

Defines the space 
between content of the 
cell and the cell wall.

Column Span COLSPAN
ex. <TR><TH 
COLSPAN=2>Test Text</
TH>

OR
 <TR><TD 
COLSPAN=3>Test Text</
TD>

Lets the cell span over 
multiple columns

Row Span ROWSPAN

ex. <TR><TH 
ROWSPAN=2>Test Text</
TH>

OR

 <TR><TD 
COLSPAN=3>Test Text</
TD>

Lets the cell span over 
multiple rows
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Cascading Style Sheets (CSS)

The topic of Cascading Style Sheets (CSS) is one that is complex and its full 
exploration is beyond the scope of this document. What is presented here is 
an overview containing examples that can be used as a starting point.

Style sheets are used to define how HTML elements are displayed in a 
browser. Using a Cascading Style Sheet (CSS) allows you to create a single 
file that will contain the formatting information for your pages. When changes 
need to be made to the appearance, they are made in the CSS document; any 
documents that reference the CSS document are automatically updated.

A CSS can be defined in a single external document or on a page by page 
basis when embedded in the <HEAD> section of the document.

Background Color BGCOLOR

ex. <TABLE 
BGCOLOR=”Pink”></
TABLE>

ex. <TR BGCOLOR=”Yel-
low”></TABLE>

ex. <TD BGCOLOR=#AAF-
FAA></TABLE>

Sets the background 
color of a single cell, row, 
or table.

NOTE: Colors can be 
specified by name within 
quotes, e.g. “Red”, or in 
hexadecimal format, e.g. 
#FF0000. When usng 
hexadecimal format, no 
quotation marks are 
required.

Tag Name Name & Attribute Explanation
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EXAMPLE:

The above style sheet is placed in the <HEAD> section of the document. The 
<STYLE> tag is used to define the CSS. Styles have been specified for the 
<H3>, and <P> tags. The default <P> tag can be overriden when you specify a 
CSS CLASS. 

The CSS class can be used as in the above example, when you want all text 
with the <P> tag to appear as courier, but sometimes you would like them to 
appear as sans-serif. This is done by adding an “extension” to the standard 
CSS code, “P.sansserif”, and specify the extension as a class in HTML in the 
<BODY> section of the document, “<P class=”sansserif”> </P”. When you 
want the default paragraph with courier, you use <P> Text Example </P> and 
whenyou want the sans-serif font, use <P class=”sansserif”> Text Example </
P>.”

Note: CSS Code in classes will override default CSS code, e.g. P.sansserif 
will override P

Note: Key to success with CSS is paying close attention to spelling. In 
addition, like HTML, CSS are not case sensitive, but font families, 
URLs to images, and other direct references may be.
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A source of information is the World Wide Web Consortium home page at 
http://www.w3.org/. This is an excellent resource for topics related to HTML, 
CSS, and JavaScript.
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About Primary and Secondary Permit Types 158
About WebHelp 141
Accept Building / Unit Links 150, 156
Accept Secondary Permit Types 150, 152, 162
Access Rights 139
Accessing

Govern .NET Web Configuration Tools 47
Account

Creating an 143
Account Creation

Create an Account Using Property Location Ad-
dress 145

Create Using Users Parcel ID (P_ID) 145
Create using Users ST Account 145
Not a property owner and no account 146
options 145
Property Owner without Account 145
Use Account Associated with Existing Name 

145
Account Information 139
ACH Extraction Date 244
ACH File

Generating an 242
ACH File ID 244
Activities Setup 187
add fields (columns) 182
Administration 139
Allow Modification 183
Anonymous Complaint 39
Applying Application Fee to ePermit 193
Applying for a Permit 138
Applying HTML Tags 108
Auto Launching a Report 272
Autologin for Multiple eGov Sites 23

B

Background Color 118
Background picture 119
Batch ePayment Processing 241
Batch Generated Username

Rules for 44
Border Color 115
Border Width 115

Business Rules 189

C

Cell Spacing / Cell Padding 115
Cell Width / Cell Height 118
Configuring a Menu

for the Anonymous Complaint 39
for the eRemittance 41

Configuring eRenewal 197
Configuring the Crystal Report with Help Content 
269
Configuring Your Menus 127
Convenience Fee 88, 218

Disabling the 89, 219
Create

a WebSkin 123
Creating

a New Web Site 123
a WebSkin 110

Creating a Web site menu 36
Creating Accounts

First Time Users 143
Creating an Account 143
Creating an E-mail Link 280
Creating an eRemittance form 228
Creating Hyperlinks, Anchors, and Links 279
Creating Resource Entries 270
Creating User Accounts 43
Crystal Report

Auto Launching 272
Configuring with Help Content 269

Crystal Reports
Multiple user issues 251
Processing Jobs Limit issues 251

Crystal Reports group Settings for Oracle Databas-
es 225
Crystal Reports group Settings for SQL Databases 
225
Customize a Report with Help Content 268
Customizing Address fields with the SRT Editor 236

D

Database Server
Recommended xiv

Default Web Page Title 113
Define ePermit Parameters for the Organization 
161
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Defining ePermit Parameters for Department 164
Defining ePermit Permit Type Parameters 166
Defining Fees for the ePermit Application 192
Defining Name Types 175
Defining the Activity Setup 186
Defining the eProfile Menus 35
Deleting

a Web Site 126
a Web Skin 121

Department to be used on the Web 162
Disabling the Convenience Fee option 89, 219
Documents Upload 99
Drive 243
Dynamic Search Screen Interface 181

E

eComplaint Anonymous
Limitations 40

eComponents 149
eComponents and JavaScript 106
Editing

a Web Site 126
a Web Skin 120

Editors
Self Reported Tax 232

EFT Provider
Process 86, 216
Steps for Setting up 86, 216

Electronic Funds Transfer Process 86, 216
Email Error Conditions 70
E-mail Errors Format 71
E-mail messages 190
eProfile Menus

Defining the 35
eProfile Menus — An Overview 136
eProfile Prerequisites xii
eRemittance

Configuring a Menu 41
eRemittance form

Creating a 228
eRenewal

Configuring 197
Initiating 201
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Errors Sent by email

Format 71
Event Log 101

Exclude Payments Not Posted 244
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Fees 189
Filing a Complaint or Grievance or Submitting a Re-
quest for Services 138
First Time Users Creating Accounts 143
Format

Errors Sent by email 71
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G/L 242
General eComponent Permit Type Parameters 169
Generating an ACH File 242
Glossary 255
Govern Web Configuration Tools 47
GovernNetConfig

Link to group 98
Group 176

H

Head Section 115
Header, Left, Right and Footer Sections 117
Help Content for Reports 268
Home Menu 137
HTML and the WebSkin 107
HTML Document Structure 278
HTML Primer 107
HTML Tags

Applying 108

I

IIS
Resource File Locking 142

Initiating eRenewal 201
Interdepartmental and E-mail messages 151

J

JavaScript and the eComponents 106

L

Land Management Parameters 148, 155
Layout Type 112
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Limitations of the eComplaint Anonymous 40
Link Primary Permit Types to ePermit 158
Link Secondary Permit Types to ePermit 154
Link to GovernNetConfig group 98

M

Mail group 68
Making an Online Payment 137
Manage Properties 139
Manage Users 139
Manage Utility Billing Accounts 140
Manage Your Properties 138
Manage Your Utility Billing Accounts 138
Menu

Configuring Your 127
MS Govern Section 119
Multimedia Codes 175, 189

N

Name Types 174
Navigating Webskin Manager tabs 111
New File 243
New Permit, Offense or Workflow Generation 189

O

Online Services Menu 137
OpenForms Settings group 233
Oracle Databases

Crystal Reports group Settings 225
Output File Name 243

P

Payment From / To Dates 244
Payment Option tab 91, 222
Permit Activity Setup 148
Permit Kinds 181
Permit Parameters 148, 155
Permit Parameters Command Buttons 165
Permit Type Maintenance 148, 155
Planning Your ePermit Setup 149
Planning your ePermit Setup 148
Posting Web ePayments to A/R 241
Pre-installation activities... 5
Prerequisites xi

eComplaint xii
eGrievance xii

ePayments xii
ePermit xii
eProfile xii
eRemittance xii
eRenewal xii
eRequest for Services xii

Property Types 173

R

Re-extract Existing File 244
Reports

Customize with Help Content 268
Help Content for 268

Required control on the web site page 235
Resetting Internet Information Services (IIS) 132
Resource File Locking and IIS 142
Resulting File Name 243
Rules

Applying Fees According to Fee Type 196
Applying Fees According to Step Number 194
Applying Fees to an ePermit 194

Rules for Applying Fees based on Fee Type 196
Rules for Batch Generated Usernames and Pass-
words 44

S

Search Configuration 47, 64
Search Styles and Groups 176
Self Reported tab

Web Site Manager Parameters 92
Self Reported Tax Editor 232

Command Buttons 233
Parameters 233

Self Reported Tax tab
Web Site Manager 91

Server Configuration 5
Server Recommended Hardware xiv
Server, Client and Network Requirements xiv
Set the "How can we identify you" parameter 75
Setting the Default Identification 75
Settings for Oracle Databases

Crystal Reports group 225
Settings for SQL Databases

Crystal Reports group 225
Setup Procedure 155
Sign Out Menu 140
Site Seal Script 90, 220
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Crystal Reports group Settings 225

Steps for Setting up an EFT Provider 86, 216
Style 176
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System Requirements xi
System Requirements xi, xiv

T

Table Back Color 115
Table Layout 115
Table Width 115
Tables in HTML 281
Troubleshooting 245

U

Update Access Level 183
Update Your Profile 138
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Web Interface 136
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Deleting a Web Site 126
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92
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Creating a 110
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